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Introduction

Few people read introductions to reference books, so I'll make this very
brief. I just want to tell you which versions of QuickBooks this book
works for, what’s in the reference, what it assumes about your existing skills,
and about the conventions used in the reference.

About This Book

A\

MBER
6“'
&

QuickBooks comes in several different flavors, including QuickBooks

Basic, QuickBooks Pro, and QuickBooks Premier. This reference talks about
QuickBooks 2005 Pro, which is a superset of QuickBooks Basic and a subset
of QuickBooks Premium.

However, don’t freak out if you're using the simpler version of QuickBooks,
QuickBooks Basic, or the more fully featured version of QuickBooks,
QuickBooks Premier. And don’t freak out if you're using some version

of QuickBooks that’s very similar to QuickBooks 2005, such as QuickBooks
2003, QuickBooks 2004, or QuickBooks 2006. All the versions of QuickBooks
work in roughly the same way. Note, too, that specialty versions of
QuickBooks like QuickBooks Accountants Edition and QuickBooks
Contractors version also work almost identically to QuickBooks Pro.

If you see some whistle or bell that you really want to use but that isn’t
available in your version of QuickBooks, you’ll know that you should
upgrade to the Pro or Premier version of QuickBooks.

Although this reference is about QuickBooks Pro 2005, it also works just fine
for the 2001, 2002, and probably 2006 versions of QuickBooks because
QuickBooks is a very mature product at this point. The changes from one
year to the next are modest. This means that if you're using QuickBooks
2003, stuff may look a little different if you closely compare the images in
this book to what you see on your screen, but the information in this refer-
ence will still apply to your situation.

The bottom line? Yes, QuickBooks comes in several flavors. Yes, Intuit pub-

lishes new editions of these products every year. But you can use this book
for any recent version of QuickBooks Basic, QuickBooks Pro, or QuickBooks
Premier.
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How to Use This Book

How to Use This Book

This reference combines eight short books, including a book about account-
ing, one about setting up the QuickBooks system, one for bookkeepers using
QuickBooks, one for accountants and managers using QuickBooks, a book
about small business financial management, a book about business planning,
a book about taking care of a QuickBooks accounting system, and a book of
appendixes of further useful information.

I’'m not going to go into more detail here about what’s available in the book.
If you have a specific question about what’s covered or where some topic
is covered, refer to the Table of Contents in the front of this reference.
Remember also that the book provides an index for jumping to the page

or pages with the information you need.

While I'm on the subject of what’s in this book and how to find information,
let me make four tangential points:

4+ You would never read this book from cover to cover unless you’re some-
one with an obsessive-compulsive personality (like me) and many hours
to devote to your reading. But that’s okay. This reference isn’t meant to
be read from cover to cover like some Harry Potter page-turner. Instead,
chapters within the eight books are organized into largely self-contained
descriptions of how you do the things that you need to do. You just read
the paragraph, page, or chapter that provides the information you want.

4+ I have not discussed in any detail how to use the QuickBooks Premier
features for business planning. The wizard-based approach that
QuickBooks Premier provides for business planning is not, in my humble
opinion, the right way to do this. Instead, I discuss in detail alternative,
superior approaches to business planning and budgeting (using spread-
sheets) in Book VI. (Just so you know: The approach I describe and rec-
ommend here is the same one that any business school teaches its
students.)

4+ At a few points in the book, you'll find me saying things like, “Well,
really don’t think you should use this part of the product.” I just want to
explain here, up front, where I'm coming from on this. First, know that I
think QuickBooks is an outstanding product. But not every feature and
every command is good. I've already mentioned that the new business
planning tools aren’t ones that I can recommend. And payroll, very
frankly, is another pain-in-the-butt feature that most businesses should
avoid. (I do briefly discuss payroll in Book III, Chapter 5.) So, if I think
that a particular feature is one that you shouldn’t use, [ don’t use page
space (or much page space) describing the feature. I want to rather use
that page space to describe other stuff that I believe is going to be valu-
able to you and other readers.
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4+ Ishould also mention one final thing: Accounting software programs
require you to do a certain amount of preparation before you can use
them to get real work done. If you haven’t started to use QuickBooks
yet, | recommend that you skim through Book I and then read Book Il to
find out what you need to do first.

Hey. There’s something else I should tell you. I have fiddled a bit with the
Windows display property settings. For example, I've noodled around with
the font settings and most of the colors. The benefit is that the pictures in
this book are easy to read. And that’s good. But the cost of all this is that my
pictures look a little bit different than what you see on your screen. In a few
places, command buttons get “cut off” on the right side of image, for exam-
ple. That’s not perfect, of course. But in the end, the publisher has found
that people are really happier with increased readability. Anyway, I just
thought I should mention this here, up front, in case you had any questions
about it.

Foolish Assumptions
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&

I'm making only three assumptions about your QuickBooks and accounting
skills:

4 You have a PC with Microsoft Windows 95 or later, or Windows NT 4.0 or
higher. (I took pictures of the QuickBooks windows and dialog boxes
using Windows XP, in case you're interested.)

4+ You know a little bit about how to work with your computer.

4+ You have or will buy a copy of QuickBooks, QuickBooks Pro, or
QuickBooks Premier for each computer on which you want to run the
program.

In other words, [ don’t assume that you're a computer genius or an M.B.A.
or super-experienced in the arcane rules of accounting. [ assume that
QuickBooks and accounting are new subjects to you. But I also assume that
you want to learn the subjects because you need to for your job or your
business.

Personally, [ use QuickBooks Pro, so this book includes some features
unique to the Pro and Premier versions. If you're trying to decide which ver-
sion to buy, [ should tell you that QuickBooks Pro and Premier include net-
working capabilities (which I describe in Book VII, Chapters 1 and 2) and the
ability to create estimates and bids (which I describe in Book IlI, Chapter 1).
The standard version of QuickBooks doesn’t include these features.
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How This Book Is Organized

By the way, if you're just starting out with Microsoft Windows, peruse
Chapter 1 of the Windows User’s Guide or one of the Windows For Dummies
books on your flavor of Windows, such as Windows XP For Dummies, by
Andy Rathbone (Wiley Publishing, Inc.).

How This Book Is Organized

This book is organized into eight individual “books.” Some of these books
give you the skinny on how to powerfully and effectively perform routine
tasks with QuickBooks; others focus on general accounting, business plan-
ning, or other aspects of managing your operation. All of them, however,
deliver the kind of information that savvy business owners need.

Book I: An Accounting Primer

For you non-accountants, Book I covers the basics of general accounting. If
you don’t know a debit from a credit, this is the place to start.

Book II: Getting Ready to Use QuickBooks

Book II lays the groundwork for using QuickBooks effectively: setting up the
program, loading files, and customizing QuickBooks for your purposes.

Book I11: Bookkeeping Chores

Book Il shows you how to take on those work-a-day tasks in QuickBooks:
invoicing customers, paying vendors, and tracking inventory, just to name
a few.

Book 1V: Accounting Chores

If you really want to get in touch with your inner accountant, this is the part
for you. In Book IV, I take on activity-based costing, preparing a budget, and
job costing.

Book U: Financial Management

In Book V, I dig into advanced financial management strategies: ratio analy-
sis, EVA, and capital budgeting.

Book UVl: Business Plans

Ever wonder what Wal-Mart does so right, while K-Mart continues to floun-
der? Turn to Book VI to find out how to write a business plan that can help
you find your niche.
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Book UVII: Care and Maintenance

Book VII shows you how to do the things that will keep you working happily
and productively in QuickBooks for years to come: setting up a network, pro-
tecting your data, and troubleshooting.

Book VIII: Appendixes

QuickBooks is a great program, but it can’t do it all. You may find that a
spreadsheet program is just the tool you need to supplement QuickBooks.
For that reason, in Book VIII, I provide a quick primer on Excel. I also offer an
appendix detailing several great online government resources, as well as a
glossary of (nearly) every business or accounting term you would ever want
to know.

Stuff at My Web site

Oh, here’s something I should probably mention. This book has a little bit of
companion Web site content that can be found at www.stephenlnelson.com.
In a handful of places, I'll provide URLs that you can use to download Excel
workbooks discussed in several chapters of this book.

Conventions Used in This Book

To make the best use of your time and energy, you should know about the
conventions I use in this book.

When [ want you to type something such as Jennifer, it’s in bold letters.

By the way, except for passwords, you don’t have to worry about the case of
the stuff you type in QuickBooks. If I tell you to type Jennifer, you can type
JENNIFER. Or you can follow poet e. e. cummings’ lead and type jennifer.

Whenever I tell you to choose a command from a menu, [ say something like,
Choose Lists=>Items, which simply means to first choose the Lists menu and
then choose Items. The => separates one part of the command from the next
part.

You can choose menus and commands and select dialog box elements with
the mouse. Just click the thing that you want to select.

While I'm on the subject of conventions, let me also mention something
about QuickBooks conventions because it turns out there’s not really any
good place to point this out. QuickBooks doesn’t use document windows the
same way that other Windows programs do. Instead, it locks the active
window into place and then displays a list of windows in its Navigator pane,
which is like another little window. To move to a listed window, you click it.
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You can tell QuickBooks to use windows like every other program does,

\P
) however, by choosing View=>Multiple Windows. You can even remove the
Navigator pane by choosing Viewr>Open Window List. (You can also move
the other locked pane that lists windows and is called the Shortcuts List by
choosing Viewr>Shortcuts List.)
Special Icons
Like many computer books, this book uses icons, or little pictures, to flag
) things that don’t quite fit into the flow of things:
Whee, here’s a shortcut or pointer to make your life easier!
SMBER
égx‘
This icon is just a friendly reminder to do something.
QMING/

‘Ik7

TEC/, ",

And this icon is a friendly reminder not to do something . . . or else.

This icon points out nerdy technical material that you may want to skip
(or read, if you're feeling particularly bright).
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Chapter 1: Principles
of Accounting

In This Chapter

v~ Figuring out the purpose of accounting
+ Reviewing the common financial statements
+ Understanding the philosophy of accounting

v Discovering income tax accounting and reporting

A ny discussion of how to use QuickBooks to better manage your busi-
ness begins with a discussion of the basics of accounting. For this
reason, in this chapter and the next two chapters, | attempt to provide the
same information that you may receive in an introductory college account-
ing course. Of course, I tailor the entire discussion to QuickBooks and the
small business environment. What you’ll read about here and in the next
chapters of this book pretty much describes how accounting works in a
small business setting using QuickBooks.

If you have had some experience with accounting, if you know how to read
an income statement and balance sheet, or if you know how to construct a
journal entry, you don’t need to read the discussion provided by this chap-
ter or the next. However, if you're new to accounting and business book-
keeping, take the time to carefully read this chapter. The chapter starts by
giving a high-level overview of the purpose of accounting. Then, I review the
common financial statements that any accounting system worth its salt pro-
duces. [ also discuss some of the important principles of accounting and the
philosophy of accounting. Finally, I talk a little bit about income tax law and
tax accounting.

Purpose of Accounting

In the movie Creator, Peter O’'Toole plays an eccentric professor. At one point,
O’Toole’s character attempts to talk a young student into working as an
unpaid research assistant. When the student protests, noting that he needs
15 credit hours, O’Toole creates a special 15-credit independent study named
“Introduction to the Big Picture.” In the next section, | describe the “big pic-
ture” of accounting, which is really the appropriate place to begin a discus-
sion of accounting. At its very core, accounting makes perfect, logical sense.
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Purpose of Accounting

The big picture

The most important thing that you need to understand about accounting is
that accounting provides financial information to stakeholders. Stakeholders
are the people who do business with or interact with a firm; they include
managers, employees, investors, banks, vendors, government authorities,
and agencies who may tax a firm. Each of these stakeholders and their infor-
mation requirements deserve a bit more discussion. Why? Because the infor-
mation needs of these stakeholders determine what an accounting system
needs to do.

Managers, investors, and entrepreneurs

The first category of stakeholders is the managers, investors, and entrepre-
neurs. This group needs financial information to determine whether a busi-
ness is making money. This group also wants any information that gives
insight into whether a business is growing or contracting, and how healthy
or sick it is. In order to fulfill its obligations and duties, this group often
needs detailed information. For example, a manager or entrepreneur may
want to know which customers are particularly profitable — or unprofitable.
An active investor may want to know which product lines are growing or
contracting.

A related set of information requirements concerns asset and liability record
keeping. An asset is something that the firm owns, such as cash, inventory,
or equipment. A liability is some debt or obligation that the firm owes, such
as bank loans and accounts payable.

Obviously, someone at a firm — perhaps a manager, bookkeeper, or
accountant — needs to have very detailed records of the amount of cash
that the firm has in its bank accounts, the inventory that the firm has in its
warehouse or on its shelves, and the equipment that the firm owns and uses
in its operations.

If you look over the preceding two paragraphs, nothing I've said is particu-
larly surprising regarding the financial information requirements needed by
a firm’s management. It makes sense, right? Someone who works in a busi-
ness, manages a business, or actively invests in a business needs good gen-
eral information about the financial affairs of the firm and, in many cases,
very detailed information about important assets (such as cash) and liabili-
ties (such as bank loans).

External creditors

A second category of stakeholders includes outside firms that loan money to
a business and credit reporting agencies that supply information to these
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lenders. For example, banks want to know about the financial affairs and
financial condition of a firm before lending money. The accounting system
needs to produce the financial information that a bank requires in order to
consider a loan request.

What information do lenders want? Lenders want to know that a business is
profitable and enjoys a positive cash flow. Profits and positive cash flows
allow a business to easily repay debt. In a worst case scenario, a bank or
other lender also wants to see assets that can be liquidated to pay a loan —
and also other debts that may represent a claim on the firm’s assets.

Vendors also typically require financial information from a firm. A vendor
often loans a firm money by extending trade credit. What’s noteworthy about
this is that vendors sometimes require special accounting. For example, one
of the categories of vendors that a company such as Wiley Publishing, Inc.
deals with is authors. In order to pay an author the royalty that he or she is
entitled to, Wiley needs to put in a fair amount of work to calculate royalty-
per-unit amounts and then report and remit these amounts to authors.

Other firms sometimes have similar financial reporting requirements for ven-
dors. Franchisees (such as the man or woman who owns and operates the
local McDonald’s) pay a franchise fee based on revenues. Retailers may need
to perform special accounting and reporting in order to enjoy rebates and
incentives from the manufacturers of the products that they sell.

Government agencies

Predictable stakeholders requiring financial information from a business are
the federal and state government agencies with jurisdiction over the firm.
For example, every business in the United States needs to report on its rev-
enues, expenses, and profits so that the firm can correctly calculate income
tax due to the federal government and then pay that tax.

Firms with employees must also report to the federal and state government
on wages paid to those employees — and pay payroll taxes based on met-
rics, such as number of employees, wages paid to employees, and unemploy-
ment benefits claimed by past employees.

Providing this sort of financial information to government agencies represents
a key duty of a firm’s accounting system.

BMSI"CSS form qenemtlon

In addition to the financial reporting described in the preceding paragraphs,
accounting systems typically perform one other key task for businesses: pro-
ducing business forms. For example, an accounting system almost always

Book |
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produces the checks needed to pay vendors. In addition, an accounting
system also prepares the invoices and payroll checks. More sophisticated
accounting systems, such as those used by large firms, prepare many other
business forms, including purchase orders, monthly customer statements,
credit memos to customers, sales receipts, and so forth.

Every accounting function that | have described so far is performed ably
by each of the versions of QuickBooks: QuickBooks, QuickBooks Pro, and
QuickBooks Premier.

Reviewing the Common Financial Statements

With the background information just provided, I'm ready to talk about some
of the common financial statements or accounting reports that an account-
ing system like QuickBooks produces. If you understand which reports you
want your accounting system to produce, you should find it much easier to
collect the raw data necessary to prepare these reports.

In the following paragraphs, I describe the three principal financial statements:
the income statement, the balance sheet, and the statement of cash flows. |
also briefly describe a fourth, catch-all category of accounting reports.

Don’t worry — I'll go through this material slowly. You need to understand
what financial statements and accounting systems are supposed to provide
and what data these financial statements supply.

The income statement

Perhaps the most important financial statement that an accounting system
produces is the income statement. The income statement is also known as a
profit and loss statement. An income statement summarizes a firm’s rev-
enues and expenses for a particular period of time. Revenues represent
amounts that a business earns by providing goods and services to its cus-
tomers. Expenses represent amounts that a firm spends providing those
goods and services. If a business can provide goods or services to cus-
tomers for revenues that exceed its expenses, the firm earns a profit. If
expenses exceed revenues, obviously, the firm suffers a loss.

To show you how this all works — and it’s really pretty simple — take a look at
Tables 1-1 and 1-2. Table 1-1 summarizes the sales that an imaginary business
enjoys. Table 1-2 summarizes the expenses that the same business incurs for
the same period of time. These two tables provide all the information neces-
sary to construct an income statement.
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Table 1-1 A Sales Journal i
Chapter 1

Joe $1,000

Bob 500

Frank 1,000 z S

Abdul 2,000 g .g

Yoshio 2,750 =3

Marie 2,250 s

Jeremy 1,000

Chang 2,500

Total sales $13,000

Table 1-2 An Expenses Journal

Purchases of dogs and buns $3,000

Rent 1,000

Wages 4,000

Supplies 1,000

Total supplies $9,000

Using the information from Tables 1-1 and 1-2, you can construct the simple
income statement shown in Table 1-3. Because understanding the details of
this income statement is key to your understanding of how accounting works
and what accounting tries to do, | want to go into some detail discussing this
income statement.

Table 1-3 Simple Income Statement
Sales revenue $13,000

Less: Cost of goods sold 3,000

Gross margin $10,000
Operating expenses

Rent $1,000

Wages 4,000

Supplies 1,000

Total operating expenses 6,000

Operating profit $4,000
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The first thing to note about the income statement shown in Table 1-3 is the
sales revenue figure of $13,000. This sales revenue figure shows the sales gen-
erated for a particular period of time. The $13,000 figure shown in Table 1-3
comes directly from the Sales Journal shown in Table 1-1.

One important thing to recognize about accounting for sales revenue is that
revenue gets counted when goods or services are provided, and not when

a customer pays for the goods or services. If you look at the list of sales
shown in Table 1-1, for example, Joe (the first customer listed) may have
paid $1,000 in cash, but Bob, Frank, and Abdul (the second, third, and fourth
customers) may have paid for their purchases with a credit card. Yoshio,
Marie, and Jeremy (the fifth, sixth, and seventh customers listed) may not
have even paid for their purchases at the time the goods or services were
provided. These customers may have simply promised to pay for the pur-
chases at some later date. However, this timing of the payment for goods or
services doesn’t matter. Accountants have figured out that you count rev-
enue when goods or services are provided. Information about when cus-
tomers pay for those goods or services, if you want that information, can
come from lists of customer payments. Cost of goods sold and gross margins
are two other values that you commonly see on income statements. Before

[ discuss cost of goods sold and gross margins, however, let me add a little
more detail to this example. Suppose, for example, that the financial informa-
tion shown in Tables 1-1, 1-2, and 1-3 shows the financial results from your
business: the hot dog stand that you operate for one day at the major sport-
ing event in the city where you live. Table 1-1 describes sales to customers
(now hungry customers). Table 1-2 summarizes the one-day expenses of
operating your super-duper hot dog stand.

In this case, the actual items that you sell — hot dogs and buns — are sepa-
rately shown on the income statement as cost of goods sold. By separately
showing the cost of the goods sold, the income statement can show what is
called a gross margin. The gross margin is the amount of revenue left over
after paying for the cost of goods. In Table 1-3, the cost of goods sold shows
$3,000 for purchases of dogs and buns. The difference between the $13,000
of sales revenue and the $3,000 of cost of goods sold equals $10,000, which is
the gross margin.

Knowing how to calculate gross margin allows you to estimate firm break-
even points and also to perform profit, volume, and cost analyses. All of
these techniques are extremely useful for thinking about the financial affairs
of your business. In fact, Book VI, Chapter 1 describes how you can perform
these sorts of analyses.

The operating expenses portion of the simple income statement shown in
Table 1-3 repeats the other information listed in the Expenses Journal. The
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$1,000 of rent, the $4,000 of wages, and the $1,000 of supplies get totaled.
These operating expenses are then subtracted from the gross.

Do you see, then, what an income statement does? An income statement
reports on the revenues that a firm has generated. It shows the cost of goods
sold and calculates the gross margin. It identifies and shows operating
expenses, and finally, shows the profits of the business.

One other important point: Income statements summarize revenues,
expenses, and profits for a particular period of time. Some managers and
entrepreneurs, for example, may want to prepare income statements on a
daily basis. Public companies are required to prepare income statements
on a quarterly and annual basis. And taxing authorities, such as the Internal
Revenue Service, require preparation both quarterly and annually.

Technically speaking, the quarterly statements required by the Internal
Revenue Service don’t need to report revenue. The Internal Revenue Service
only requires quarterly statements of wages paid to employees. Only the
annual income statements required by the Internal Revenue Service report
both revenue and expenses. These are the income statements produced to
prepare an annual income tax return.

Balance sheet

The second most important financial statement that an accounting system
produces is a balance sheet. A balance sheet reports on a business’s assets,
liabilities, and owner contributions of capital at a particular point in time.

4+ The assets shown on a balance sheet are those items that are owned by
the business, which have value, and for which money was paid.

4+ The liabilities shown on a balance sheet are those amounts that a busi-
ness owes to other people, businesses, and government agencies.

4+ The owner’s contributions of capital are the amounts that owners, part-
ners, or shareholders have paid into the business in the form of invest-
ment or have reinvested in the business by leaving profits inside the
company.

As long as you understand what assets and liabilities are, a balance sheet is
easy to understand and interpret. Table 1-4, for example, shows a simple bal-
ance sheet. Pretend that this balance sheet shows the condition of the hot
dog stand at the beginning of the day, before any hot dogs have been sold.
The first portion of the balance sheet shows and totals the two assets of the
hot dog stand business: the $1,000 of cash that may be in the cash register in
a box under the counter, and the $3,000 of hot dogs and buns that you've
purchased in order to sell during the day.

Book |
Chapter 1
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Table 1-4 A Simple Balance Sheet
Assets
Cash $1,000
Inventory 3,000
Total assets $4,000
Liabilities
Accounts payable $2,000
Loan payable 1,000
Owner's equity

S. Nelson, capital 1,000
Total liabilities and owner’s equity $4,000

Balance sheets can use several other categories to report assets: accounts
receivable (these are amounts that customers owe), investments, fixtures,
equipment, and long-term investments. In the case of a small owner-operated
business, not all of these asset categories show up. But if you look at the bal-
ance sheet of a very large business — say one of the 100 largest businesses in
the United States — you will see these sorts of other categories.

The liabilities section of the balance sheet shows the amounts that the firm
owes to other people and businesses. For example, the balance sheet in
Table 1-4 shows $2,000 of accounts payable and a $1,000 loan payable.
Presumably, the $2,000 of accounts payable is the money that you owe to
the vendors who have supplied your hot dogs and buns. The $1,000 loan
payable represents some loan you've taken out — perhaps from some well-
meaning and naive relative.

The owner’s equity section shows the amount that the owner, the partners, or
shareholders have contributed to the business in the form of original funds
invested or profits reinvested. [ should make one important point about the
balance sheet shown in Table 1-4: This balance sheet shows how owner’s
equity looks when the business is a sole proprietorship. In the case of a sole
proprietor, only one line is reported in the owner’s equity section of the bal-
ance sheet. This line combines all contributions made by the proprietor —
both amounts originally invested and amounts reinvested.

I talk a bit more about owner’s equity accounting later in this chapter because
the owner’s equity sections look different for partnerships and corporations.
Before I get into that, however, let me make two important observations about
the balance sheet shown in Table 1-4. A balance sheet needs to balance. This
means that the total assets must equal the total of the liabilities and owner’s
equity. In the balance sheet shown in Table 1-4, for example, total assets
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shows as $4,000. Total liabilities and owner’s equity also shows as $4,000.
This equality is no coincidence. If an accounting system works right and the
accountants and bookkeepers entering information into this system do their
jobs right, the balance sheet balances.

Another observation worth making is that a balance sheet provides a snap-
shot of a business’s financial condition at a particular point in time. For
example, I mention in the introductory remarks related to Table 1-4 that the
balance sheet in this table shows the financial condition of the hot dog stand
business immediately before beginning the day’s business activities. You can
prepare a balance sheet for any point in time. It is key that you understand
that a balance sheet is prepared for a particular point in time.

By convention, businesses prepare balance sheets to show the financial con-
dition at the end of the period of time for which an income statement is pre-
pared. For example, a business typically prepares an income statement on
an annual basis. In this orthodox situation, a firm also prepares a balance
sheet at the very end of the year.

At this point, I return to something that I alluded to previously in the
chapter — the fact that the owner’s equity section of a balance sheet looks
different for different types of businesses.

Table 1-5 shows how the owner’s equity section of a balance sheet looks for

a partnership. In Table 1-5, [ show how the owner’s equity section of the hot
dog stand business may appear if, instead of having a sole proprietor named
S. Nelson running the hot dog stand, the business is actually owned and oper-
ated by three partners named Tom, Dick, and Harry. In this case, the part-
ners’ equity section shows the amounts originally invested and any amounts
reinvested by the partners. As is the case with sole proprietorships, each
partner’s contributions and reinvested profits appear on a single line.

Table 1-5 Owner's Equity for a Partnership
Partners’ equity

Tom, capital $500

Dick, capital 250

Harry, capital 250

Total partner capital $1,000

Go ahead and take a look at Table 1-6. It shows how the owner’s equity sec-
tion looks for a corporation.

Book |
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Table 1-6 Owner’s Equity for a Corporation
Shareholders’ equity

Capital stock, 100 shs at $1 par $100

Contributed capital in excess of par 400

Retained earnings 500

Total shareholder’s equity $1,000

This next part is a little bit weird. For a corporation, the amounts that show in
the owner’s equity or shareholder’s equity section actually fall into two major
categories: refained earnings and contributed capital. Retained earnings repre-
sent profits that the shareholders have left in the business. Contributed capi-
tal is the money originally contributed by the shareholders to the corporation.

The retained earnings thing makes sense, right? That’s just the money — the
profits — that investors have reinvested in the business.

The contributed capital thing is more complicated. Here’s how it works: If you
buy a share of stock in some new corporation — for say, $5 — typically some
portion of that price per share is for par value. Now don’t ask me to justify par
value. It really stems from business practices that were common a century or
more ago. Just trust that typically, if you pay some amount — again, say $5 —
for a share, some portion of the amount that you pay — maybe 10 cents a
share or $1 a share — is for par value.

In the owner’s equity section of a corporation’s balance sheet, capital that’s
contributed by original investors is broken down into the amounts paid for
this mysterious par value and the amounts paid in excess of this par value.
For example, in Table 1-6, you can see that $100 of shareholder’s equity or
owner’s equity represents amounts paid for par value. Another $400 of the
amounts contributed by the original investors represents amounts paid in
excess of par value. The total shareholder’s equity, or total corporate owner’s
equity, equals the sum of the capital stock par value, the contributed capital
and excess of par value, and any retained earnings. So in Table 1-6, the total
shareholder’s equity equals $1,000.

Statement of cash flows

Now I come to the one tricky financial statement: the statement of cash flows.

Before I begin, I have one comment to make about the statement of cash

flows: As an accountant, I've worked with many bright managers and busi-
ness people. No matter how much handholding and explanation I or other
accountants provide, some of these smart people never quite get some of
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the numbers on the statement of cash flows. In fact, many of the students
who major in accounting never (in my opinion, at least) quite get how a
statement of cash flows really works.

For this reason, don’t spend foo much time spinning your wheels on this
statement or trying to understand what it does. QuickBooks does supply a
statement of cash flows, but you don’t need to use this statement. In fact,
QuickBooks will produce cash basis income statements, which get you
almost the same information — and in a more easy-to-understand format.

[ think the best way to explain what a statement of cash flows does is to ask
you to look again at the balance sheet shown in Table 1-4. This is the balance
sheet for the imaginary hot dog stand at the beginning of the day.

Now take a look at Table 1-7, which shows the balance sheet at the end of
the day, after operations for the hot dog stand have ended. Notice that at the
start of the day, cash equals $1,000, and at the end of the day, cash equals
$5,000. The statement of cash flows explains why cash changes from the one
number to the other number over a period of time. In other words, a state-
ment of cash flows explains how cash goes from $1,000 at the start of the
day to $5,000 at the end of the day.

Table 1-7 Another Simple Balance Sheet
Assets

Cash $5,000
Inventory 0
Total assets $5,000
Liabilities

Accounts payable $0
Loan payable 0
Owner's equity

S. Nelson, capital 5,000
Total liabilities and owner's equity $5,000

Table 1-8, not coincidentally, shows a statement of cash flows that explains
how cash flowed for your imaginary hot dog stand business. You need to
understand this statement, presumably, if you're reading this book. [ am
going to start at the bottom of the statement and work up.
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Table 1-8 A Simple Statement of Cash Flows
Operating activities

Netincome $4,000
Decrease in accounts payable (2,000)
Adjustment: decrease in inventory 3,000
Net cash provided by operating activities $5,000
Financing activities

Decrease in notes payable (1,000
Net cash provided (used) by financing activities (1,000)
Increase in cash 4,000
Cash balance at start of period 1,000
Cash balance at end of period $5,000

By convention, accountants show negative numbers inside parentheses. These
parentheses more clearly flag negative values than a simple minus sign.

The last three lines of the statement of cash flows are all easily understand-
able. The cash balance at the end of the period, $5,000, shows what cash the
business holds at the end of the day. The cash balance at the start of the
period, $1,000, shows the cash that the business holds at the beginning of
the day. Both the cash balance at the start of the period and the cash bal-
ance at the end of the period tie to the cash balance values reported on the
two balance sheets. (Look at Table 1-4 and Table 1-7 to corroborate this
assertion.) Clearly, if you start the period with $1,000 and end the period
with $5,000, cash has increased by $4,000. That’s an arithmetic certainty. No
question there, right?

The financing activities of the statement of cash flows shows how firm bor-
rowing and firm debt repayment affect the firm cash flow. If the hot dog stand
business uses its profits to repay the $1,000 loan payable — and, in this case,
this is what happened — this $1,000 cash outflow shows up in the financing
activities portion of the statement of cash flows as a negative $1,000.

The top portion of the statement of cash flows is often the trickiest to under-
stand. Note, however, that I've talked about everything else in this statement.
So, with a strong push, you'll fight your way through to an understanding of
what is going on here.

The operating activities portion of the statement of cash flows essentially
shows the cash that comes from the profit. If you look at Table 1-8, for exam-
ple, you see that the first line in the operating activities portion of the state-
ment of cash flows is net income for $4,000. This is the net income amount
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reported on the income statement for the period. However, the net income
or operating profit reported on the business’s income statement isn’t neces-
sarily the same thing as cash income or cash profit. A variety of factors need
to be adjusted in order to convert this net income amount to what’s essen-
tially a cash operating profit amount.

For example, in the case of the hot dog stand business, if you use some of
the profits to pay off all of the accounts payable, this payoff uses up some of
your cash profit. This is exactly what Table 1-8 shows. You can see that the
decrease in the accounts payable from $2,000 to $0 over the day required,
quite logically, $2,000 of the net income. Another way to think about this is
that essentially, you used up $2,000 of your cash profits to pay off accounts
payable. Remember that the accounts payable is the amount that you owed
your vendors for hot dogs and buns.

Another adjustment is required for the decrease in inventory. The decrease
in inventory from the start of the period to the end of the period produces
cash. Basically, you're liquidating inventory. Another way to think about this
is that although this inventory — the hot dogs and buns in our example —
shows up as an expense for the day’s income statement, it isn’t purchased
during the day. It doesn’t consume cash during the day; it was purchased at
some point in the past.

When you combine the net income, the accounts payable adjustment, and
the inventory adjustment, you get the net cash provided by the operating

activities. In Table 1-8, these three amounts combine to $5,000 of cash pro-
vided by the operations.

After you understand the details of the financing and operating activities
areas of the statement of cash flows, the statement makes sense. Net cash
provided by the operating activities equals $5,000. Financing activities
reduce cash by $1,000. This means that cash actually increased over the
period by $4,000, which explains why cash starts the period at $1,000 and
ends the period at $5,000.

Other accounting statements

Thinking back to the discussion at the very start of the chapter, you can
probably come up with some examples of several other popular or useful
accounting reports. And, not surprising, a good accounting system such as
QuickBooks produces most of these reports. For example, one very common
report or financial statement that you’ll want to see is a list of the amounts
that your customers owe you. It’s a good idea, for example, to prepare and
review such reports on a regular basis to make sure that you don’t have cus-
tomers turning into collection problems.
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Table 1-9 shows how the simplest sort of accounts receivable report may
look: Each customer is named along with the amount owed.

Table 1-9 An Accounts Receivable Report at End of Day
Customer Amount

W. Churchill $45.12

G. Patton 34.32

B. Montgomery 12.34

H. Petain 65.87

C. de Gaulle 4321

Total receivables $200.86

Table 1-10 shows another common accounting report — an inventory report
that the hot dog stand may have at the start of the day. An inventory report
like the one shown in Table 1-10 would probably name the various items
held for resale, the quantity held, and the amount or value of the inventory
item. A report such as this is useful to make sure that you have the appropri-
ate quantities of inventory in stock. (Think of how useful such a report
would be if you really were planning to sell thousands of hot dogs at major
sporting events in your hometown.)

Table 1-10 An Inventory Report at Start of Day
Item Quantity Amount
Kielbasa 2000 $900.00
Bratwurst 2000 1,000.00

Plain buns 2000 500.00
Sesame buns 2000 600.00

Total inventory $3,000.00

Putting it all together

By now, you should understand what an accounting system does. When you
boil everything down to its essence, it’s straightforward, isn’t it? Really, an
accounting system just provides you with the financial information that you
need to run your business.

Let me add a tangential but important point. QuickBooks supplies all this
accounting information. For the most part, preparing these sorts of financial
statements in QuickBooks is pretty darn easy. But you have to learn a bit more.
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You'll find it helpful to learn about accounting and bookkeeping. However, | Book |
will go over that information in the coming chapters. Also, note that the big Chapter 1
picture stuff covered in this chapter is the most important knowledge that

you need. If you understand the ideas described in this chapter, the battle is

more than half won.

Curious about different business forms?

Curious about the differences among a sole
proprietorship, a partnership, and a corpora-
tion? A sole proprietorship is formed automati-
cally in most states and in most industries when
an individual decides to go into business. In
many jurisdictions, the sole proprietor needs to
acquire or apply for a business license from the
state or local city government. Other than that
modest hurdle, sole proprietorship requires no
other special prerequisites.

A partnership is formed automatically when
two or more people enter into a joint business
or investment activity for the purpose of making
a profit. As is the case with a sole proprietor-
ship, partnerships typically need to acquire a
business license from the state and perhaps
the federal government. Partnership formation
doesn’t necessarily require any additional
paperwork or legal maneuvering. However, if
you do enter into a partnership, most attorneys
(probably all attorneys) will tell you that you do
so at a certain amount of risk if you don’t have
an attorney draw up a partnership agreement
that outlines the duties and rights and respon-
sibilities of the partners. However, it is impor-
tant to note that you can actually form a
partnership simply by collaborating in business
with someone. The law books are full of stories
of people, for example, who have inadvertently
created partnerships merely by collaborating
on some project, sharing office space, or work-
ing together in some activity.

In comparison, most states allow several other
business forms, including corporations, limited
liability companies, and limited liability partner-
ships. These other business forms require
considerably more work to set up, the assis-
tance of a good attorney, and payment of at
least several hundred — and possibly several
thousand — dollars in legal and licensing fees.
The unique feature of most of these other busi-
ness forms, however, is that the corporation or
limited liability company or limited liability part-
nership becomes a separate legal entity. In
many cases, this separate legal entity protects
investors from creditors who have a claim on
the assets of the business. In comparison, in a
sole proprietorship or a partnership, the sole
proprietor and the partners are liable for the
debts and obligations of the proprietorship or
the partnership.

If you have questions about the correct busi-
ness form in which to operate, talk with a good
local attorney. He or she can assist you in
choosing the appropriate business form and in
considering both the legal and tax aspects of
choosing a particular form. As a general rule,
more sophisticated business forms such as
corporations, limited liability companies, or lim-
ited liability partnerships deliver significant
legal and tax benefits to investors and man-
agers. Unfortunately, these more sophisticated
business forms also require considerably more
legal and accounting fiddle-faddling.
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The philosophy of accounting

Maybe the phrase “philosophy of accounting” is too strong, but accounting
does rest on a rather small set of fundamental assumptions and principles.
People often refer to these fundamentals as generally accepted accounting
principles.

[ want to quickly summarize what these principles are. I find — and I bet you
find the same thing — that understanding the principles gives context and
makes accounting practices more understandable. With this in mind, let me
go through the half dozen or so key accounting principles and assumptions.

Revenue principle

The revenue principle, which is also known as the realization principle, states
that revenue is earned when the sale is made. The sale is made, typically,
when goods or services are provided. A key component of the revenue prin-
ciple, when it comes to the sale of goods, is that revenue is earned when
legal ownership of the goods passes from seller to buyer.

On the same token, note that revenue isn’t earned when you collect cash for
something. It turns out, perhaps counterintuitively, that counting revenue
when cash is collected doesn’t give the business owner a good idea of what
sales really are. Some customers may pay deposits early, before actually
receiving the goods or services. Often customers want to use trade credit,
paying a firm at some point in the future for goods or services. Because cash
flows can fluctuate wildly — even something like a delay in the mail can
affect cash flow — you don’t want to use cash collection from customers as
a measure of sales. Besides that, you can easily track cash collections from
customers. So why not have the extra information about when sales actually
occur?

Expense principle

The expense principle states that an expense occurs when the business uses
goods or receives services. In other words, the expense principle is the flip
side of the revenue principle. As is the case with the revenue principle, if
you receive some goods, simply receiving the goods means that you have
incurred the expense of the goods. Similarly, if you received some service —
services from your lawyer, for example — you have incurred the expense. It
doesn’t matter that your lawyer takes a few days or a few weeks to send you
the bill. You incur an expense when goods or services are received.

Matching principle

The matching principle is related to the revenue and the expense principles.
The matching principle states that when you recognize revenue, you should
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match related expenses with the revenue. The best example of when the
matching principle comes into play concerns the case of businesses that
resell inventory. In our hot dog stand example, you should count the expense
of a hot dog and the expense of a bun on the day when you sell that hot dog
and that bun. Don’t count the expense when you buy the buns and the dogs.
Count the expense when you sell them. In other words, match the expense of
the item with the revenue of the item.

Accrual-based accounting, which is a term you have probably heard, is what
you get when you apply the revenue principle, the expense principle, and
the matching principle. In a nutshell, accrual-based accounting means that
you record revenue when a sale is made and record expenses when goods
are used or services are received.

Cost principle

The cost principle states that amounts in your accounting system should be
quantified, or measured, by using historical cost. For example, if you have a
business and the business owns a building, that building, according to the
cost principle, shows up on your balance sheet at its historical cost. You
don’t adjust the values in an accounting system for changes in a fair market
value. You use the original historical costs.

I should admit that the cost principle is occasionally violated in a couple of
ways. The cost principle is adjusted through the application of depreciation,
which [ discuss in the next chapter. Also, sometimes fair market values are
used to value assets, but only when assets are worth less than they cost.

Objectivity principle

The objectivity principle states that accounting measurements and account-
ing reports should use objective, factual, and verifiable data. In other words,
accountants, accounting systems, and accounting reports should rely on as
little subjectivity as possible.

An accountant will always want to use some data that’s objective (even if it’s
bad) rather than use subjective data (even if the subjective data is arguably
better). The idea is that objectivity becomes a protection against the corrupt-
ing influence that subjectivity can introduce into a firm’s accounting records.

Continuity assumption

The continuity assumption — accountants call it an assumption rather than a
principle for reasons unbeknownst to me — states that accounting systems
assume that a business will continue to operate. The importance of the con-
tinuity assumption becomes most clear if you consider the ramifications of
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assuming that a business won’t continue. If a business won’t continue, it
becomes very unclear how one should value assets if the assets have no
resale value. This sounds like gobbledygook, but think about the implicit
continuity assumption built into the balance sheet for the hot dog stand at
the beginning of the day. (This is the hot dog stand balance sheet that shows
up in Table 1-4.)

Implicit in that balance sheet is the assumption that the $3,000 worth of hot
dogs and hot dog buns has some value because they can be sold. If a busi-
ness won’t continue operations, no assurance exists that any of the inven-
tory can be sold. If the inventory can’t be sold, what does that say about the
owner’s equity value shown in the balance sheet?

You can see, | hope, the sorts of accounting problems that one gets into if
one can’t assume the business will continue to operate.

Unit-of-measure assumption

The unit-of-measure assumption assumes that a business’s domestic currency
is the appropriate unit of measure for the business to use in its accounting. In
other words, the unit-of-measure assumption states that it’s okay for U.S. busi-
nesses to use U.S. dollars in their accounting. And it’s okay for U.K. businesses
to use pounds sterling as the unit of measure in their accounting system. The
unit-of-measure assumption also states, implicitly, that even though inflation
and occasionally deflation changes the purchasing power of the unit of meas-
ure used in the accounting system, that’s still okay. Sure, inflation and defla-
tion foul up some of the numbers in a firm’s financial statements. But the
unit-of-measure assumption says that’s usually okay — especially in light of
the fact that no better alternatives exist.

Separate entity assumption

The separate entity assumption states that a business entity, like a sole pro-
prietorship, is a separate entity, a separate thing from its business owner.
And the separate entity assumption says that a partnership is a separate
thing from the partners who own part of the business. The separate entity
assumption, therefore, enables one to prepare financial statements just for
the sole proprietorship or just for the partnership. As a result, the separate
entity assumption also relies on a business being separate and distinct and
definable as compared to its business owners.

These are the basic accounting principles that underlie business accounting.
Implicit in the earlier discussions in this chapter, and the discussions in the
coming chapters of this book, and those of the other books in this all-in-one
desk reference, are these principles and assumptions. It is no exaggeration
to say that they permeate almost everything about business accounting.
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A Few Words about Tax Accounting Book

Chapter 1

I'm not going to talk much about tax accounting or tax preparation in this
book. However, one of the key reasons that you do accounting and use a pro-
gram such as QuickBooks is to make your tax accounting easier. That’s obvi-
ous. So a fair question is this: How does what I've said so far relate to income
tax return preparation?
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This is a tough question to answer. Tax laws don’t map to generally accepted
accounting principles. Generally accepted accounting principles are not the
same thing as income tax law.

However, if you use good basic accounting practices as you operate
QuickBooks, you get financial information that can usually be used to easily
prepare your tax returns, especially if you get some help from your CPA.

If you want, you can also use income tax rules to fine-tune your accounting
and bookkeeping. This practice, which is technically known as an other com-
prehensive basis of accounting (OCBOA), is generally considered an appropri-
ate way to perform accounting for small and medium enterprises.

If you have more specific questions about the right way to prepare a finan-
cial statement using generally accepted accounting principles, and for use
in preparing an income tax return, consult your CPA or your tax advisor.
Applying generally accepted accounting principles or tax laws in specific
situations requires an understanding of the specific circumstances and the
industry in which a firm operates. Given the one-way nature of the commu-
nication in this book — me chattering away at you — [ can’t provide that
sort of detailed commentary here. Sorry, buddy. . . .
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Chapter 2: Double-Entry
Bookkeeping

In This Chapter

v+ Checking out the fiddle-faddle method of accounting
v Grasping how double-entry bookkeeping works

v Looking at an (almost) real-life example

v~ Figuring out how QuickBooks helps

Fle preceding chapter describes why businesses create financial state-
ments and how these financial statements can be used. If you've read
Book I, Chapter 1, or if you've spent much time managing a business, you
probably know what you need to know about financial statements. In truth,
financial statements are pretty straightforward. An income statement, for
example, shows a firm’s revenues, expenses, and profits. A balance sheet
itemizes a firm’s assets, liabilities, and owner’s equity. So far, so good.

Unfortunately, preparing traditional financial statements is more complicated
and tedious. The work of preparing financial statements — called accounting

or bookkeeping — either requires a whole bunch of fiddle-faddling with num-

bers or learning how to use double-entry bookkeeping.

In this chapter, I start by describing the fiddle-faddle method. This is not
because I think you should use that method. In fact, [ assume that you even-
tually want to use QuickBooks for your accounting and, by extension, for
double-entry bookkeeping. However, by understanding the fiddle-faddle
method, you’ll see clearly why double-entry bookkeeping is so much better.

After I describe the fiddle-faddle method, I am going to walk you through the
steps to using and understanding double-entry bookkeeping. After you see
all the anguish and grief that the fiddle-faddle method causes, you’ll have no
trouble appreciating why double-entry bookkeeping works so much better.
And you’ll also hopefully commit to the 30 or 40 minutes necessary to learn
the basics of double-entry bookkeeping.
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The Fiddle-Faddle Method of Accounting

Most small businesses — or at least those small businesses where the
owners aren’t already trained in accounting — have used the fiddle-faddle
method. For example, take a peek at the financial statements shown in
Tables 2-1 and 2-2. If you've read or reviewed Book [, Chapter 1, you may rec-
ognize these financial statements as those that stem from the imaginary hot
dog stand business. Table 2-1 shows the income statement for the one day a
year that the imaginary hot dog stand business operates. Table 2-2 shows
the balance sheet at the start of the first day of operation.

Table 2-1 A Simple Income Statement for the Hot Dog Stand
Sales revenue $13,000
Less: Cost of goods sold 3,000
Gross margin $10,000
Operating expenses

Rent $1,000
Wages 4,000
Supplies 1,000
Total operating expenses 6,000
Operating profit $4,000
Table 2-2 A Simple Balance Sheet for the Hot Dog Stand
Assets

Cash $1,000
Inventory 3,000
Total assets $4,000
Liabilities

Accounts payable $2,000
Loan payable 1,000
Owner's equity

S. Nelson, capital 1,000
Total liabilities and owner's equity $4,000

With the fiddle-faddle method of accounting, you individually calculate each
number shown in the financial statement. For example, the sales revenue
figure shown in Table 2-1 equals $13,000. The fiddle-faddle method of
accounting requires you to somehow come up with this sales revenue
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number manually. You may be able to come up with this number by remem-
bering each of the sales that you made over the day. Or, if you prepare
invoices or sales receipts, you may be able to come up with this number by
adding all of the individual sales. If you have a cash register, you may also be
able to come up with this number by looking at the cash register tape.

Other revenue and expense numbers get calculated in the same crude
manner. For example, the $1,000 of rent expense gets calculated by either
remembering what amount you paid for rent, or by looking in your check-
book register and finding the check that you wrote for rent.

The balance sheet values get produced in roughly the same way. You can
deduce the cash balance of $1,000, for example, by looking at the checkbook
or, in a worst case scenario, the bank statement. You can deduce the inven-
tory balance of $3,000 by adding the individual inventory item values. You
can calculate the liability and owner’s equity amounts in similar fashion.

Some of the values shown in an income statement or on a balance sheet get
plugged — meaning that they’re calculated using other numbers from the
financial statement. For example, you don’t look up the profit amount in any
particular place; instead, you calculate profit by subtracting expenses from
revenue. You can also, of course, calculate balance sheet values, such as
total assets, owner’s equity, and total liability of owner’s equity.

Okay, [ admit it: The fiddle-faddle method of accounting works reasonably
well for a very small business as long as you have a good checkbook. So, for
a very small business, you may be able to get away with this crude, piece-
meal approach to accounting.

But unfortunately, the fiddle-faddle method suffers from three horrible weak-
nesses for a firm that doesn’t have super-simple finances:

4+ It’s not systematic enough to be automated. Now, admittedly, you may
not care that the fiddle-faddle approach isn’t systematic enough for
automation. But this point is an important one. A systematic approach
like double-entry bookkeeping can be automated, as happens with
QuickBooks. This automation means that the task of preparing financial
statements requires — oh, I don’t know — maybe five mouse clicks.
Because the fiddle-faddle approach can’t be automated, every time you
want to produce financial statements, you or some poor co-worker
needs to go to an enormous amount of work to collect the numbers and
all of the raw data necessary to produce information like that shown in
Table 2-1 and Table 2-2. In reality, of course, with more complicated
financial statements, someone goes to much, much more work.
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4+ It’s very easy to lose details. This sounds abstract, but let me give you
a good, concrete example. If you look at Table 2-1, you see that the hot
dog stand business incurs only three operating expenses: rent, wages,
and supplies. If you know the operating expense categories that the
business incurs, it is fairly easy to look through the check register and
find the check or checks that pay rent, for example. You can use a simi-
lar approach with the wages expense. Also, you can use a similar
approach with the supplies expense. However, what if you also have
an advertising expense category or a business license expense, or
some other easy-to-forget category? If you forget a category, you miss
expenses. For example, if you forgot that you spent money advertising
and, thereby, forgot to tally your advertising expenses, that whole cate-
gory of operating expense gets omitted from your income statement.

4+ It doesn’t allow rigorous error checking. This business about error
checking seems, perhaps, nit-picky. However, error checking is impor-
tant with accounting and bookkeeping systems. With all of the numbers
and transactions floating around, errors easily creep into the system. I
discuss more about error checking later in this chapter, but let me give
you an example of the sort of error checking an accounting system can
(and should) perform. Take a look at the example of the sales transac-
tion. If you sell an item for $1,000, you can actually check that amount by
comparing it to your record of what the customer paid. This makes
sense, right? If you sell me an item for $1,000, you actually should be
able to compare that $1,000 sale to the amount of cash that [ pay you. A
$1,000 sale to me should correspond to a $1,000 cash payment from me.
The fiddle-faddle method can’t make these comparisons. However,
double-entry bookkeeping can.

You see where I'm at now, right? I've admitted that you can construct financial
statements using the fiddle-faddle method. But [ hope I've also convinced you
that the fiddle-faddle method suffers from some really debilitating weaknesses.
I'm talking about something as important as how you best manage the finan-
cial affairs of your business. These weaknesses indicate that you need to use

a better tool. Specifically, you need to use double-entry bookkeeping, which I
discuss next.

How Double-Entry Bookkeeping Works

After you conclude that the fiddle-faddle method is for the birds, you're ready
to absorb the necessary accounting theory and learn the bookkeeping tricks
required to employ double-entry bookkeeping. Essentially, you need to do two
things in order to work with double-entry bookkeeping. First, you need to
understand the accounting model. And second, you need to learn the mechan-
ics of debits and credits. Neither of these things is difficult to deal with. If you
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flip ahead a few pages, you can see that [ am only going to spend a few pages
talking about this material. How difficult can anything be that is described in
just a few pages? Not very, right?

The accounting model

Here’s the first thing you need to understand and internalize in order to use
double-entry bookkeeping: Modern accounting uses an accounting model
that says assets equal liabilities plus owner’s equity. The following formula
expresses this in a more conventional, algebraic form:

Assets = liabilities + owner's equity

If you think about this for a moment and flip back to Table 2-2, you see that
this formula summarizes the organization of a business’s balance sheet.
Conceptually, the formula says that a business owns stuff and that the
money or the funds for that stuff come either from creditors (such as the
bank or some vendor) or the owners (either in the form of original con-
tributed capital or perhaps in reinvested profits). If you understand the bal-
ance sheet shown in Table 2-2 and discussed here, you understand the first
core principle needed to use double-entry bookkeeping. This isn’t that tough
so far, is it?

Here’s the second thing that you need to understand about the basic account-
ing model: Revenues increase owner’s equity and expenses decrease owner’s
equity. Think about that for a minute. That makes intuitive sense. If you
receive $1,000 in cash from a customer, you have $1,000 more in the business.
If you write a $1,000 check to pay a bill, you have $1,000 less in the business.

Another way to say the same thing is that profits clearly add to the owner’s
equity. Profits get reinvested in the business and boost owner’s equity.
Profits are calculated as the difference between revenues and expenses. If
revenues exceed expenses, profits exist.

Let me review where I am so far in this discussion about the basic account-
ing model. The basic model says that assets equal liabilities plus owner’s
equity. In other words, the total assets of a firm equal the total of its liabili-
ties and owner’s equity. Furthermore, revenue increases the owner’s equity
and expenses decrease the owner’s equity.

At this point, you don’t have to intuitively get the logic of the accounting
model and the way that revenues and expenses plug into the owner’s equity
of the model. If you do “get it” that’s great, but not necessary. However, you
do need to memorize or remember the manner in which the basic model
works through at least the next few paragraphs.
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§,‘\\;,\‘J\B'-:Iir This may seem like a redundant point, but note that a balance sheet is con-
& structed by using information about a firm’s assets, liabilities, and owner’s
equity. Similarly, note that a firm’s income statement is constructed by using
information about its revenues and its expenses. Remember that all this dis-
cussion, all this tediousness, is really about how you collect the information
necessary to produce an income statement and a balance sheet.

Now I come to perhaps the most important point that you need to under-
stand in order to “get” double-entry bookkeeping. Every transaction and
every economic event that occurs in the life of a firm produces two effects:
An increase in some account shown on the balance sheet or on the income
statement, and a decrease in some account shown on the balance sheet or
income statement. When something happens, economically speaking, that
something affects at least two types of information shown in the financial
statement. In the next few paragraphs, I give you some examples so you can
really understand this.

Suppose that in your business, you sell $1,000 of an item for $1,000 in cash.
In the case of this transaction or economic event, two things occur from the
perspective of your financial statements:

4+ Your cash increases by $1,000.

4+ Your sales revenue increases by $1,000.

Another way to say this same thing is that your $1,000 cash sale affects both
your balance sheet (because cash increases) and your income statement
(because sales revenue is earned).

See the duality? And you were thinking this might be too complicated for
you just a paragraph ago, weren’t you?

Here’s another common example: Suppose that you buy $1,000 of inventory
for cash. In this case, you decrease your cash balance by $1,000, but you
increase your inventory balance by $1,000. Note that in this case, both
effects of the transaction appear in sort of the same area of your financial
statement — the list of assets. Nevertheless, this transaction also affects two
accounts.

P When I use the word account, I simply mean some value that appears on
your income statement or on your balance sheet. If you look at Tables 2-1
and 2-2, for example, any value that appears on those financial statements
that isn’t simply a calculation represents an account. In essence, an account
tracks some group of assets, liabilities, owner’s equity, contributions, rev-
enues, or expenses. [ talk more about accounts in the next section when I get
to the actual mechanics of double-entry bookkeeping.

Here’s another example that shows this duality of effects in an economic
event: Suppose that you spent $1,000 in cash on advertising. In this case, this
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economic event reduces cash by $1,000 and increases the advertising expense
amount by $1,000. This economic event affects both the assets portion of the
balance sheet and the operating expenses portion of the income statement.

And now — believe it or not — you're ready to see how the mechanics of
double-entry bookkeeping work.

Talking mechanics

Roughly 500 years ago, an Italian monk named Pacioli devised a systematic
approach to keeping track of the increases and decreases in account bal-
ances. He said that increases in asset and expense accounts should be called
debits, whereas decreases in asset and expense accounts should be called
credits. He also said that increases in liabilities, owner’s equity, and revenue
accounts should be called credits, while decreases in liabilities, owner’s
equity, and revenue accounts should be called debits.

Table 2-3 summarizes the information that I just shared. Unfortunately —
and you can’t get around this — you need to memorize this table or dog-ear
the page so you can easily refer to it.

Table 2-3 You Must Remember This
Account Debit Credit
Assets Increase Decrease
Expenses Increase Decrease
Liabilities Decrease Increase
Owner's equity Decrease Increase
Revenues Decrease Increase

Using Pacioli’s debits and credits system, any transaction can be described
as a set of balancing debits and credits. Not only does this system work as
financial shorthand, but it also provides error checking. To get a better idea
of how this works, look at some simple examples.

Take the case of a $1,000 cash sale, for example. Using Pacioli’s system, or by
using double-entry bookkeeping, you can record this transaction as shown
here:

Cash $1,000 debit
Sales revenue $1,000 credit
See how that works? The $1,000 cash sale appears as both a debit to cash

(which means an increase in cash) and a $1,000 credit to sales (which means a
$1,000 increase in sales revenue). Debits equal credits, and that’s no accident.
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The accounting model and Pacioli’s assignment of debits and credits mean
that any correctly recorded transaction balances. For a correctly recorded
transaction, the transaction’s debits equal the transaction’s credits.

Although you can show transactions as I've just shown the $1,000 cash sale,
you and I may just as well use the more orthodox nomenclature. By conven-
tion, accountants and bookkeepers show transactions, or what accountants
and bookkeepers call journal entries, like this one shown in Table 2-4:

Table 2-4 Journal Entry 1: Recording the Cash Sale
Account Debit Credit

Cash 1,000

Sales revenue 1,000

See how that works? Each account that’s affected by a transaction appears
on a separate line. Debits appear in the left column. Credits appear in the
right column.

You actually already understand how this account business works. You have
a checkbook. You use it to keep track of both the balance in your checking
account and the transactions that change the checking account balance. The
rules of double-entry bookkeeping essentially say that you are going to use a
similar record-keeping system not only for your cash account, but for every
other account you need to prepare your financial statements, too.

Here are a couple of other examples of how this transaction recording works.
In the first part of this discussion of how double-entry bookkeeping works, |
describe two other transactions: the purchase of $1,000 of inventory for cash,
and spending $1,000 in cash on advertising. Table 2-5 shows how the purchase
of $1,000 of inventory for cash appears. Table 2-6 shows how spending $1,000
of cash on advertising appears.

Table 2-5 Journal Entry 2: Recording the Inventory Purchase
Account Debit Credit

Inventory 1,000

Cash 1,000

Table 2-6 Journal Entry 3: Recording the Advertising Expense
Account Debit Credit

Advertising 1,000

Cash 1,000
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That darn bank

When | learned about double-entry bookkeep-
ing, | stumbled over the terms debit and credit.
The way | had heard the terms used before
didn’t agree with the way that double-entry
bookkeeping seemed to describe them. This
conflict caused a certain amount of confusion
for me. Because | don't want you to suffer from
the same fate, let me quickly describe my initial
confusion.

If you look at Table 2-3, you see that an increase
in an assetaccountis a debitand a decrease in
an asset account is a credit. This means that
in the case of your cash account, increases to
cash are debits and decreases to cash are
credits.

However, you've undoubtedly talked at some
time to the bank and heard them refer to cred-
iting your bank account — which meant they
increased the account balance. And they per-
haps talked about debiting your account —
which meant they decreased the account

balance. So, what's up with that? Am | wrong,
and is the bank right?

Actually, both the bank and | are right. And
here’s why. The bank is talking about debiting
and crediting— not a cash account, and not an
asset account — but a liability account. To
them, the money that you've placed in the bank
is not cash (an asset) but a liability (money that
they owe youl). If you look at Table 2-3, you see
that increases in a liability are credit amounts
and decreases in a liability are debit amounts.
Therefore, from the bank’s perspective, when
they increase the balance in your account, that
increase is a credit.

Your assets may represent another firm'’s liabil-
ities. Your liabilities will represent another firm's
assets. Therefore, whenever you hear some
other business talking about crediting or debit-
ing your account, what you would do is exactly
the opposite. If they credit, you debit. If they
debit, you credit.

By tallying the debits and credits to an account, you can calculate the account
balance. For example, suppose that before Journal Entries 1, 2, and 3, the cash

balance equals $2,000. Journal Entry 1 increases cash by $1,000 (this is the
debit). Journal Entries 2 and 3 decrease cash by $1,000 each (these are the
$2,000 credits). If you combine all of these entries, you get the new account
balance. The following formula shows the calculation:

Beginning balance of cash

Plus cash debit from Journal Entry 1
Minus cash credit from Journal Entry 2

Minus cash credit from Journal Entry 3

Ending cash balance

$2,000
$1,000
-$1,000
-$1.000
$1,000

Do you see how that works? You start with $2,000 as the cash account bal-

ance. The first cash debit of $1,000 increases the cash balance to $3,000, and
then the cash credit of $1,000 in Journal Entry 2 decreases the cash balance
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to $2,000. Then, finally, the cash credit of $1,000 in Journal Entry 3 decreases
the cash balance to $1,000.

You can calculate the account balance for any account by taking the starting
account balance and then adding the debits and credits that have occurred
since then. By hand, this arithmetic is a little unwieldy. Your computer (with
the help of QuickBooks) does this math easily.

Almost a Real-Life Example

\\3

To cement the concepts that I've talked about in the preceding paragraphs
of this chapter, I want to quickly step through the journal entries, or book-
keeping transactions, that you would record in the case of the hot dog stand
business discussed in the preceding chapter. To start, you need to know that
the balance sheet shown in Table 2-2 is the balance sheet at the start of the
day. This means that the account balances in all of the accounts appear as
shown in Table 2-7. This list of account balances is actually called a trial bal-
ance. It shows the debit or credit balance for each account.

[ am assuming that no year-to-date revenues or expenses exist yet with the hot
dog stand business. In other words, the operation is just at a starting period.

Table 2-7 A Trial Balance at the Start of Day
Account Debit Credit

Cash 1,000

Inventory 3,000
Accounts payable 2,000

Loan payable 1,000

S. Nelson, capital - 1,000

Totals 4,000 4,000

You may want to take a quick peek at Table 2-1. It summarizes the business
activities of the hot dog stand. The journal entries that follow show how the
information necessary for this statement would be recorded.

Rent expense

Suppose that the first transaction that you need to record is a $1,000 check
written to pay rent. In this case, the journal entry appears as shown in
Table 2-8. In this example, $1,000 is debited to rent expense, and $1,000 is
credited to cash.
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Table 2-8 Journal Entry 4: Recording the Rent Expense
Account Debit Credit

Rent 1,000

Cash 1,000

Wages expense

If you need to record $4,000 of wages expense, you use the journal entry
shown in Table 2-9. This journal entry debits wages expense for $4,000 and
credits cash for $4,000. In other words, you use $4,000 of cash to pay wages
for the hot dog stand business.

Table 2-9 Journal Entry 5: Recording the Wages Expense
Account Debit Credit

Wages expense 4,000

Cash 4,000
Supplies expense

To record $1,000 of supplies expense paid for by writing a check, you record
the journal entry shown in Table 2-10. This transaction debits supplies
expense for $1,000 and credits cash for $1,000.

Table 2-10 Journal Entry 6: Recording the Supplies Expense
Account Debit Credit

Supplies 1,000

Cash 1,000

Note that for each of the preceding transactions, debits equal credits. As long
as debits equal credits, you know that the transaction is in balance. This bal-
ance is one of the ways that double-entry bookkeeping prevents errors.

Recording sales revenue

Suppose that you sell $13,000 worth of hot dogs. To record this transaction in

a journal entry, you debit cash for $13,000 and credit sales revenue for $13,000,
as is shown in Table 2-11. I should tell you, however, that in the case of the hot
dog stand selling hot dogs for a dollar or two a piece, you wouldn’t actually be
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able to use a single journal entry to record sales revenue amounts. If you were
selling hot dogs at a dollar a dog, you may actually have 13,000 one-dollar
transactions. Each of these transactions would debit cash for a dollar and
credit sales revenue for a dollar.

Table 2-11 Journal Entry 7: Recording the Sales Revenue
Account Debit Credit

Cash 13,000

Sales revenue 13,000

Recording cost of goods sold

You need to record the expense of the hot dogs and buns that you sell. You
also need to record the fact that if you do use up your inventory of hot dogs
and buns, your inventory balance has decreased. Table 2-12 shows how you
record this. Cost of goods sold gets debited for $3,000, and inventory gets
credited for $3,000.

Table 2-12 Journal Entry 8: Recording the Cost of Goods Sold
Account Debit Credit

Cost of goods sold 3,000

Inventory 3,000

If you're confused about this cost of goods sold transaction — and it repre-
sents the first transaction that doesn’t use cash — flip back to Book I,
Chapter 1, where I describe the two accounting principles. In short, though,
these two principles go like this:

4+ Expense principle: This principle says that an expense gets counted
when the item gets sold. This means that the inventory isn’t counted as
cost of goods sold or as an expense when it is purchased. Rather, the
expense of the hot dog and bun that you sell gets counted when the item
is actually sold to somebody.

4+ Matching principle: This principle says that expenses or cost of a sale
get matched with the revenue of the sale. This means that you need to
recognize the cost of goods sold at the same time that you recognize
the sale. Typically, in fact, someone can combine Journal Entry 7 and
Journal Entry 8.

Another way to think about the information recorded in Journal Entry 8 is
this — rather than “spending” cash to provide customers with hot dogs and
buns, you spend inventory.
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Recording the payoff of accounts payable

Suppose that one of the things you do at the end of the day is write a check to
pay off the accounts payable. The accounts payable are the amounts that you
owe vendors — probably the suppliers from whom you purchased the hot
dogs and buns. To record the payoff of accounts payable, you debit accounts
payable for $2,000 and credit cash for $2,000, as shown in Table 2-13.

Table 2-13 Journal Entry 9: Recording the Payoff of Accounts Payable

Account Debit Credit
Accounts payable 2,000
Cash 2,000

Recording the payoff of a loan

Suppose also that you use cash profits from the day to pay off the $1,000
loan that the balance sheet shows (see Table 2-2). To record this transaction,
you debit loan payable for $1,000 and credit cash for $1,000, as shown in
Table 2-14.

Table 2-14 Journal Entry 10: Recording the Payoff of the Loan
Account Debit Credit

Loan payable 1,000

Cash 1,000

Calculating account balance

You may already be able to guess this: If you know an account’s starting bal-
ance and have a way to add up the debits and the credits to the account, you
can easily calculate the ending account balance.

For example, take the case of the cash account balance of the hot dog stand
business. If you look at the balance sheet shown in Table 2-2, you see that
the beginning balance for cash is $1,000. You can easily construct a little
schedule of how the account balance changes — this is called a T-account —
that calculates the ending balance. In fact, Table 2-15 does just this. If you
look closely at Table 2-15, you see that the cash beginning balance is $1,000.
Then, on the following lines of the T-account, you see the effects of Journal
Entries 4, 5, 6, 7, 9, and 10. Some of these journal entries credit cash. Some of
them debit cash. You can calculate the ending cash balance by combining
the debit and credit amounts.
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Table 2-15 A T-Account of the Cash Account
Debit Credit

Beg. balance 1,000

J.E.#4 1,000

J.E.#5 4,000

J.E. #6 1,000

J.E.#1 13,000

J.E.#9 2,000

J.E.#10 - 1,000

End balance 5,000

The information shown in Table 2-15 should make sense to you. But just

in case you're still trying to memorize what debits and credits mean, I'm
going to give you a bit more detail. To calculate the ending balance shown
in Table 2-15, you add up the debits, add up the credits, and combine the
two sums. The net amount in the case of the cash account equals the $5,000
debit. If you recall from the preceding paragraphs, a debit balance in an
asset account, such as cash, represents a positive amount. A $5,000 debit
balance in the cash account, therefore, indicates that you have $5,000 of
cash in the account.

Cash is usually the trickiest account to analyze using a T-account because so
many journal entries affect cash. In many cases, however, a T-account analy-
sis of an account balance is much more straightforward. For example, if you
look at Table 2-16, you see a T-account analysis of the inventory account.
This T-account analysis shows that the beginning inventory account balance
equals $3,000. However, when Journal Entry 8 credits inventory for $3,000 —
this is the journal entry that records the cost of goods sold — the inventory
balance is wiped out.

Table 2-16 A T-Account of the Inventory Account
Debit Credit

Beg. balance 3,000

J.E. #8 . 3,000

End balance $0

Paying off the accounts payable and loan payable accounts is similarly
straightforward. Table 2-17 shows the T-account analysis of the accounts
payable account. Table 2-18 shows the T-account analysis of the loan payable
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account. In both cases, the T-account analysis shows that the liability
accounts start with a credit beginning balance. (Remember that a liability
account would have a credit balance if the firm really owed money.) Then,
when the payments are recorded to pay off the accounts payable and loan
payable in Journal Entries 9 and 10, the liability account is debited. The end
result, in the case of both accounts, is that the liability account balance is
reduced to zero.

Table 2-17 A T-Account of Accounts Payable
Debit Credit

Beg. balance 2,000

J.E.#9 2,000

End balance 0

Table 2-18 A T-Account of the Loan Payable Account
Debit Credit

Beg. balance 1,000

J.E.#10 1,000

End balance 0

I'm not going to show T-account analyses of the other accounts that the pre-
ceding journal entries used. In every other case, the only debit or credit to
the account comes from the journal entry. This means that the journal entry
amount is the account balance. For example, only one journal entry affects
the sales revenue account — Journal Entry 7, which credits sales revenue for
$13,000. Because there is no beginning balance in the sales revenue account,
that $13,000 credit equals the sales revenue account balance. The expense
accounts work the same way.

Using T-account analysis results

If you or your accounting program constructs T-accounts for each balance
sheet and income statement account, you can easily calculate account bal-
ances at a particular point in time by using the T-account analysis results.
Table 2-19 shows a trial balance at the end of the day for the hot dog stand
business. Each of these account balances can be calculated by using T-account
analysis.
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Table 2-19 A Trial Balance at End of the Day
Account Debit Credit
Cash 5,000

Inventory 0

Accounts payable 0
Loan payable 0
S. Nelson, capital 1,000
Sales revenue 13,000
Cost of goods sold 3,000

Rent 1,000

Wages expense 4,000

Supplies 1,000 _
Totals 14,000 14,000

For example, the first line shown in the trial balance in Table 2-19 is the
cash account with the debit balance of $5,000. This debit account balance
comes from the T-account analysis shown in Table 2-15. The account bal-
ances for inventory, accounts payable, and loan payable also come from the
T-account analyses shown previously in this chapter (Table 2-16, Table 2-17,
and Table 2-18).

As I noted in the preceding section, you don’t need to perform T-account
analyses for the other accounts shown in the trial balance provided in
Table 2-19. These other accounts showed a single debit or credit.

One final and perhaps already obvious point needs to be made: The informa-
tion provided in Table 2-19 is the information necessary to construct an
income statement for the day, and a balance sheet as of the end of the day.
For example, if you take sales revenue, cost of goods sold, rent, wages
expense, and supplies expense from the trial balance, you have all the infor-
mation that you need to construct an income statement for the day. In fact,
the information shown in Table 2-19 is the information used to construct the
income statement shown in Table 2-1.

Similarly, the asset, liability, and owner’s equity balance information shown
in the trial balance provided in Table 2-19 supplies the information neces-
sary to construct a balance sheet as of the end of the day.

The end of the day balance sheet won’t actually “balance” unless you also
include the profits of the day. These profits, either called retained earnings or
lumped into the owner’s capital account, equal $4,000. You can see what this
end-of-day balance sheet looks like by turning back to Book I, Chapter 1. In
that chapter, Table 1-7 shows the end-of-day balance sheet for the hot dog
stand business.
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A Few Words about How QuickBooks Works Boak|

Chapter 2

Before I end this chapter, [ want to make just a few comments about how
QuickBooks helps you. First of all — and this may be the most important

point — QuickBooks makes most of these journal entries for you. For exam- t-g'“ g
ple, in Journal Entry 6, I show you how to record a $1,000 check written to = %
pay supplies. However, you would never have to make this journal entry in § m
QuickBooks yourself. When you use QuickBooks to record a $1,000 check é.%

that pays Acme Supplies for some paper products that you purchased,
QuickBooks automatically debits supplies expense (as long as you indicate
that the check is for supplies) and then credits cash.

Similarly, in the case of Journal Entry 7 and Journal Entry 8, when you pro-
duce an invoice that records a sale, QuickBooks would make these journal
entries for you. For example, if you sold $13,000 of hot dogs and buns, and
those hot dogs and buns actually cost you $3,000, QuickBooks debits cash
for $13,000, credits sales revenue for $13,000, debits cost of goods sold for
$3,000, and credits inventory for $3,000. In other words, for most of your
routine transactions, QuickBooks handles the journal entries for you behind
the scenes.

This doesn’t mean, however, that you can always avoid working with journal
entries. Any transaction that can’t be handled through a standard QuickBooks
form — such as the invoice form or the write checks form — needs to be
recorded by using a journal entry. For example, if you purchase some fixed
asset by writing a check, the purchase of the fixed asset gets recorded auto-
matically by QuickBooks. However, the depreciation that will be used to
expense the asset over its estimated economic life — something I talk a bit
about in the next chapter — needs to get recorded with journal entries that
you construct yourself and enter a different way.

One other really important point: I noted in the preceding paragraphs that
the trial balance information shown in Table 2-19 provides the raw data that
you need to prepare your financial statement. | don’t want to leave you with
a misunderstanding, however. You don’t actually have to take this sort of
raw data and prepare your financial statements. Predictably, QuickBooks
easily, quickly, and without effort builds your financial statements by using
this trial balance information.

Just to put these comments together, then, QuickBooks automatically cre-
ates most journal entries for you, builds a trial balance by using journal
entry information, and — when asked — produces financial statements.
Most of the work of double-entry bookkeeping, then, goes on behind the
scenes. You don’t need to worry about many journal entries on a day-to-day
basis. And if you don’t want to ever see a trial balance, you don’t have to. In
fact, if you just use QuickBooks to produce invoices and to write checks that
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pay the bills, almost all of the information that you need to prepare your
financial statements gets collected automatically. So that’s really neat.

However, not all of the information that is necessary for producing good accu-
rate financial statements gets collected automatically. You will encounter a
handful of important cases that need to be handled on a special basis through
journal entries that either you or your CPA construct and enter.

In the next chapter, I describe some of the most common special cases.
However, it is likely that you’ll encounter other special cases. With the infor-
mation in this chapter, you may be able to figure out these journal entries
yourself. Or, you may need to pay someone else to help you figure them out.
Or, as a sometimes reasonable resort, you may just need to skip the extra
precision and accuracy that you can achieve by recording these other jour-
nal entries.



Chapter 3: Special Accounting
Problems

In This Chapter

v Sorting out accounts receivable and accounts payable
1 Keeping track of inventory

v+ Figuring out fixed assets

v Finding out about asset write-downs

1+ Recognizing liability

v Closing out revenue and expense accounts

Elen if you understand the principles of accounting (which I describe in
Book I, Chapter 1) and the basics of double-entry bookkeeping (which I
describe in Book I, Chapter 2), you still may not have all the information that
you need to keep good records. For example, tracking the amounts that cus-
tomers owe you and the amounts that you owe vendors can be a bit tricky.
Inventory can also present challenging record-keeping problems, a fact that’s
not surprising to you retailers. And things like fixed assets — oh, don’t even
get me started.

For these reasons, this chapter describes the most common complexities
that business owners confront. You don’t need to be an accountant or an
experienced bookkeeper to understand the material in this chapter. However,
you do need to proceed carefully, take your time, and think a bit about how
the material I describe here applies to your specific business situation.

Working with Accounts Receivable

If you read Book I, Chapter 1, you already know that accounting principles
state that sales revenue needs to be recognized when a sale is made. And that
the sale is made when a business provides goods or services to a customer.

In other words — and this is really an important point — sales revenue doesn’t
get recorded when you receive payment from a customer. Sales revenue gets
recorded when a customer has a legal obligation to pay you because you have
(or your business has) provided the customer with the goods or services.
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Recording a sale

This requirement to record sales revenue at the time that goods or services
are provided means that accounting for sales revenue is slightly more com-

plicated than you may have first guessed. The first transaction, for example,
the transaction that records a sale, looks as shown in Table 3-1.

Table 3-1 Journal Entry 1: Recording a Credit Sale
Account Debit Credit
Accounts receivable 1,000

Sales revenue 1,000

Journal Entry 1 shows how a $1,000 sale may be recorded. The journal entry
shows a $1,000 debit to accounts receivable and a $1,000 credit to sales rev-
enue. To record a $1,000 sale — a credit sale — the journal entry needs to
show both the $1,000 increase in accounts receivable and the $1,000 increase
in sales revenue.

Recording a payment

When the business receives payment from the customer for the $1,000
receivable, the business needs to record a journal entry like that shown in

Table 3-2.

Table 3-2 Journal Entry 2: Recording the Customer Payment
Account Debit Credit

Cash 1,000

Accounts receivable 1,000

Journal Entry 2 shows a $1,000 debit to cash, which is the $1,000 increase in
the cash account that occurs because the customer has just paid you $1,000.
Journal Entry 2 also shows a $1,000 credit to accounts receivable. This credit
to the accounts receivable asset account reduces the accounts receivable
balance.

At the point when you record both Journal Entry 1 and Journal Entry 2, the
net effect is a $1,000 debit to cash, showing that the cash has increased by
$1,000, and a $1,000 credit to sales revenue, showing that sales revenue has
increased by $1,000. The $1,000 debit to accounts receivable and the $1,000
credit to accounts receivable net to zero.
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If you think about this accounts receivable business a bit, you should realize
that it makes sense. Although the accounts receivable account includes a
$1,000 receivable balance, this just means that the customer owes you $1,000.
But when the customer finally pays off the $1,000 bill, you need to zero out
that receivable.

QuickBooks, by the way, automatically records Journal Entry 1 and Journal
Entry 2 for you. Journal Entry 1 gets recorded whenever you issue or create

a customer invoice. Therefore, you don’t actually need to worry about the
debits and credits shown in Journal Entry 1 except for one special occasion:
When you set up QuickBooks and QuickBooks items (items are things that get
included on the invoices), you do specify which account should be credited to
track sales revenue. This means that you may not need to worry much about
the mechanics of Journal Entry 1. However, you will on occasion still need to
understand how this journal entry works — only so that you can set up
QuickBooks correctly.

Book II, Chapter 1 describes the mechanics of setting up QuickBooks.

Journal Entry 2 also gets recorded automatically by QuickBooks. QuickBooks
records Journal Entry 2 for you whenever you record a cash payment from a
customer. You don’t need to worry, then, about the debits and credits neces-
sary for recording customer payments. However, I find that it’s helpful to
understand how this journal entry works and how QuickBooks records this
customer payment transaction.

Estimating bad debt expense

One other important journal entry to understand is shown in Table 3-3.

Table 3-3  Journal Entry 3: Recording an Allowance for Uncollectible Accounts

Account Debit Credit
Bad debt expense 100
Allowance for uncollectible A/R 100

Journal Entry 3 records an estimate of the uncollectible portion of accounts
receivable. Businesses that don’t want to keep accrual-based accounting state-
ments may not need to worry about Journal Entry 3. If you think about it,
though, some of the money you bill customers may be uncollectible, unfortu-
nately. Yet Journal Entry 1 records every dollar that you bill your customers
as revenue. Therefore, you need a way to offset, or reduce, some of the sales
revenue by the amount that ultimately turns out to be uncollectible.
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Journal Entry 3 shows a common way of doing this. Journal Entry 3 debits
bad debt expense — which is an expense account that you may use to record
uncollectible customer receivables. Journal Entry 3 also credits another
account shown as allowance for uncollectible A/R. This allowance account is
called a contra-asset account, which basically reduces the balance reported
on the balance sheet of an asset account. In the case of the allowance for
uncollectible A/R accounts, for example, this $100 credit would reduce the
accounts receivable balance shown on the balance sheet by $100.

Where the bad debt expense shown in Journal Entry 3 appears varies from
business to business. Some businesses may report the bad debt expense
with the other sales revenue, thereby allowing the income statement to
show net sales revenue. Other businesses may report bad debt expense with
the other operating expenses. You should report bad debt expense wherever
it makes most sense in terms of managing your business.

QuickBooks doesn’t automatically record the transaction in Journal Entry 3.
You record estimates of bad debt expense yourself by using the QuickBooks
Make Journal Entries command.

Removing uncollectible accounts receivable

If you do set up an allowance for uncollectible accounts, you also need to peri-
odically remove the uncollectible accounts from both the accounts receivable
balance and the allowance for uncollectible accounts. You don’t want to do
this while any chance exists for you to collect on the accounts. But at some
point, obviously, you may as well clean out the bad receivables from your
records. It makes no sense, for example, to have uncollectible receivables from
17 years ago still appearing on your balance sheet. Table 3-4 illustrates how to
clean out bad receivables.

Table 3-4 Journal Entry 4: Writing Off an Uncollectible Receivable
Account Debit Credit

Allowance for uncollectible 100

Accounts receivable 100

This journal entry debits the allowance from the uncollectible A/R account
for $100. The journal entry also credits the accounts receivable account for
$100. In combination, these two entries zero out the allowance for the uncol-
lectible A/R account and remove the uncollectible amount from the accounts
receivable account.
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Writing off an actual, specific uncollectible receivable for invoice should be
done on a case-by-case basis. This is what Journal Entry 4 shows.

None of these entries is particularly tricky as long as you understand the
logic — something [ have hopefully illuminated for you in this discussion.

If you do have trouble with these journal entries or with recording the eco-
nomic events that they attempt to summarize, you may want to consult your
CPA. Most likely, you would record these same transactions (of course, with
different customers and amounts) many, many times over the year. If you
can get a bit of help or a template that shows you how to record these trans-
actions, you should thereafter be able to record them yourself without any
outside help.

In order to write off an uncollectible account receivable, you record a credit
memo and then apply the credit memo to the uncollectible account. The
item shown on your credit memo should cause the allowance for uncol-
lectible accounts to be debited.

Recording Accounts Payable Transactions

Within QuickBooks, you have the option of either working with or without
an accounts payable account. If you want to, you can record expenses when
you write checks. This means that in order to have a complete list of all your
expenses, you must have recorded checks that pay all your expenses. This
approach works fine — and, in fact, is the approach that I have always used
in my businesses.

QuickBooks also supports a more precise approach of recording expenses.
You can set up an accounts payable account (by answering a few questions
during the QuickBooks setup process), which is just an account that tracks
the amounts that you owe your vendors and other suppliers.

Recording a bill

When you use an accounts payable account, you enter the bills that you
receive from vendors when you receive them.

Table 3-5 shows the way this transaction is recorded. Journal Entry 5 auto-
matically debits office supplies expense for $1,000 and credits accounts
payable for $1,000. This is the journal entry that would be recorded by
QuickBooks if you purchased $1,000 of office supplies and then entered that
bill into the QuickBooks system.
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Table 3-5 Journal Entry 5: Recording a Credit Purchase
Account Debit Credit

Office supplies 1,000

Accounts payable 1,000

Paying a bill

When you later pay that bill, QuickBooks records Journal Entry 6, shown in
Table 3-6. In Journal Entry 6, QuickBooks debits accounts payable for $1,000
and credits cash for $1,000. The net effect on accounts payable combining
both the purchase and the payment is zero. That makes sense, right? The
approach shown in Journal Entries 5 and 6 counts the amount that you owe
some vendor or supplier as a liability, accounts payable, only while you owe

the money.
Table 3-6 Journal Entry 6: Recording the Payment to Vendor
Account Debit Credit
Accounts payable 1,000
Cash 1,000

When you record Journal Entry 5 in QuickBooks, you do need to supply the
name of the account that gets debited. QuickBooks obviously knows which
account to credit — the accounts payable account. However, QuickBooks
also needs to know the expense or asset account to debit.

QuickBooks does need to know which cash account to credit when you pay
an accounts payable amount. You identify this when you write the check to
pay the bill.

Some other accounts payable pointers

Let me make a couple of additional points about Journal Entries 5 and 6:

4+ The accounts payable method is more accurate. The accounts payable
method, which is what Journal Entries 5 and 6 show, is the best way to
record your bills. The accounts payable method means that you record
expenses when the expenses actually occur. As you may have already
figured out, the accounts payable method is really the mirror image of
the accounts receivable approach described in the early paragraphs of
this chapter. The big benefit of the accounts payable method, as you
may intuit, is that it keeps track of the amounts that you owe vendors
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and suppliers, and it recognizes expenses as they occur rather than
when you pay them (which may be some time later).

4+ Not every debit is for an expense. Journal Entry 5 shows the debit
going to an office supplies expense account. Many of the accounts
payable that you record will be amounts owed for expenses. However,
not every accounts payable transaction stems from incurring some
expense. You may also need to record the purchase of an asset — such
as a piece of equipment. In this case, the debit goes not to an expense
account but to an asset account. Other than this minor change, however,
the transaction works in the same way. [ describe how fixed asset
accounting works later in this chapter in the “Accounting for Fixed
Assets” section.

Can you guess how an expense or fixed asset purchase gets recorded if you
don’t use an accounts payable account? In the case where you paid $1,000
for office supplies, QuickBooks debits office supplies expense for $1,000 and
credits cash for $1,000 when you write a $1,000 check. As part of writing the
check, you identify which expense account to debit.

If you are purchasing a $1,000 piece of equipment, the journal entry looks and
works roughly in the same way. When you record the purchase, QuickBooks
debits the asset account for $1,000 and credits cash for $1,000. Again, this
transaction gets recorded when you write the check to pay for the asset.

Inventory Accounting

Thankfully, most of the inventory accounting that goes on in a business gets
handled automatically by QuickBooks. For example, when you purchase an
inventory item by writing a check or recording an accounts payable bill,
QuickBooks automatically adjusts your inventory accounts both for the
dollar value of the inventory and the quantity of the items. When you sell
an inventory item to a customer, QuickBooks again automatically adjusts
the dollar value of your inventory and adjusts the quantity accounts of the
items you sell.

Basically, all this means that QuickBooks maintains a perpetual inventory
system — an inventory system that lets you know at any time what quantity
of items you have in inventory and what value your inventory amounts to.
(In the past, smaller firms often needed to use a periodic inventory system,
which meant that business owners never really knew with any precision the
dollar value of their inventory, or the quantity counts for the inventory items
that they held.)
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Although everything in the preceding paragraph represents good news,
several inventory-related headaches do require a bit of accounting magic.
Specifically, if your firm carries inventory, you need to know how to deal with
obsolete inventory, disposal of obsolete inventory, and inventory shrinkage.
[ discuss all three accounting gambits in the following paragraphs.

Dealing with obsolete inventory

Obsolete inventory refers to items that you've purchased for sale but turn
out not to be saleable. Perhaps customers no longer want it. Perhaps you
have too much of the inventory item and will never be able to sell everything
that you hold.

In either case, you need to record the fact that your inventory value is actu-
ally less than what you purchased it for. And you want to record the fact
that, really, the money you spent on the obsolete item is an expense. For
example, suppose that you purchased some $100 item that you now realize
is obsolete. How do you record this obsolescence? Table 3-7 shows the con-
ventional approach.

Table 3-7 Journal Entry 7: Recording an Allowance for Obsolete Inventory

Account Debit Credit
Inventory obsolescence 100
Allowance for obsolete inventory 100

As Journal Entry 7 shows, to record the obsolescence of a $100 inventory
item, you first debit an expense account called something like “inventory
obsolescence” for $100. Then, you credit a contra-asset account named
something like “allowance for obsolete inventory” for $100. As I mention in
the discussion of accounts receivable, a contra-asset account gets reported
on the balance sheet immediately beneath the asset account to which it
relates. The contra-asset account, with its negative credit balance, reduces
the net reported value of the asset account. For example, if the inventory
account balance was $3,100 and you had an allowance for an obsolete inven-
tory contra-asset account of $100, the net inventory balance shows as
$3,000. In other words, the contra-asset account gets subtracted from the
related asset account.

QuickBooks makes you record Journal Entry 7 yourself using the Make
Journal Entries command.
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When you ultimately do dispose of obsolete inventory, you record a journal
entry like the one shown in Table 3-8. This journal entry debits the contra-
asset account for $100 and credits inventory for $100. In other words, this
journal entry removes the value of the obsolete inventory both from the
allowance for obsolete inventory account and from the inventory account
itself. You record this journal entry when you actually physically dispose of
the inventory. This may be, for example, when you pay the junk man to haul
away the inventory, or when you toss the inventory out into the large
Dumpster behind your office or factory.

Table 3-8 Journal Entry 8: Recording Disposal of Inventory
Account Debit Credit

Allowance for obsolete inventory 100

Inventory 100

In general, one of the things you should do every year for tax accounting rea-
sons is deal with your obsolete inventory. The tax rules generally state that
you can’t write off obsolete inventory unless you actually dispose of it for
income purposes. You can, however, typically write down inventory to its
liquidation value. Such a write-down works the same way as a write-down for
obsolete inventory. A write-down can be a little tricky if you have never done
it before, however, so you may want to confer with your tax advisor.

One more really important point about recording disposal of obsolete inven-
tory: Within QuickBooks, you record inventory disposal by adjusting the phys-
ical item count of the inventory items. I describe how adjusting the physical
inventory accounts works in Book IIl, Chapter 3. So even though [ won’t go
down that path here, you should know that you don’t actually enter a journal
entry like the one shown in Journal Entry 8. You adjust the inventory accounts
for the obsolete inventory. This adjustment would automatically reduce the
inventory account balance. When QuickBooks asks you which account to
debit, you specify the allowance for obsolete inventory account.

Dealing with inventory shrinkage

The other chronic inventory headache that many business owners and busi-
ness managers have to deal with is inventory shrinkage. It’s very likely,
sometimes for the most innocent reasons, that your inventory records over-
state the quantity counts of items. When this happens, you need to adjust
your records. Essentially, you want to reduce both the dollar value of your
inventory and the quantity counts of your inventory items.
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Why not just credit the asset account?

If you are really getting into this double-entry
bookkeeping, you may wonder why you don’t
just credit the inventory account in the case of
something like obsolete inventory. Wouldn't that
save you time and trouble? Well, yes and no.

Simply crediting the inventory account does
make sense. Such an approach saves you the
task of having to set up a goofy contra-asset
account. However, accountants have con-
cluded over the centuries that it makes sense
to keep a record of your obsolete inventory as
long as you own it. There are a bunch of differ-
ent reasons for this, but one reason is that you
want to know what inventory you need to get
rid of or dispose of.

It's not necessary to set up some sort of sepa-
rate system for keeping track of obsolete inven-
tory. By using the contra-asset account, you

can continue to store information about your
inventory in the accounting system without
making the balance sheet information and
income statement information incorrect.

This logic applies to other contra-asset accounts,
too. For example, previously in this chapter, |
describe how to set up a contra-asset account for
uncollectible accounts receivable. The business
about wanting to have some record of your uncol-
lectible accounts receivable — perhaps so you
know you don't want to deal with those cus-
tomers again — means that you may as well keep
this information in the accounting system. A
contra-asset account allows you to do so and at
the same time not have the presence of uncol-
lectible receivables overstate your accounts
receivable balance.

Table 3-9 shows the journal entry that QuickBooks makes for you to record
this event. This journal entry debits an appropriate expense account — in
Journal Entry 9, I call the expense account shrinkage expense — for $100. A
journal entry also needs to credit the inventory account for $100.

Table 3-9 Journal Entry 9: Recording Inventory Shrinkage
Account Debit Credit
Shrinkage expense 100

Inventory 100

Within QuickBooks, as [ mentioned, you don’t actually record a formal jour-
nal entry like the one shown here. You use something called a physical count
worksheet to adjust the quantities of your inventory item counts to whatever
they actually are. When you make this adjustment, QuickBooks automati-
cally credits the inventory account balance and adjusts the quantity counts.
QuickBooks also requires you to supply the expense account that it should
debit for the shrinkage.
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In the old days (by the “old days,” | mean a few decades ago), businesses com-
pared their accounting records to the physical counts of inventory items only
once a year. In fact, the annual inventory physical count was a painful ritual
that many distributors and retailers went through. These days, I think, most
businesses have found that it works much better to stage physical inventory
counts throughout the year. This approach, called cycle counting, means that
you're probably comparing your accounting records with physical counts for
your most valuable items several times a year. For your moderately valuable
items, you’re probably comparing your inventory accounting records with
physical counts once or twice a year. With your least valuable inventory items,
you probably only irregularly compare inventory records with physical
counts, and you may accept a degree of imprecision. For example, rather than
counting screws in some bin, you may weigh the bin and then make an esti-
mate of the screw count. In any case, you want some system that allows you to
compare your accounting records to your physical counts. Inventory shrink-
age and inventory obsolescence represent real costs of doing business that
won't get recorded in your accounting records in any other way.

Accounting for Fixed Assets

Fixed assets refers to those items that you can’t immediately count as

an expense when purchased. Fixed assets include such things as vehicles,
furniture, equipment, and so forth. Fixed assets are tricky for two reasons:
Typically, you must depreciate fixed assets (more on that in a bit), and you
need to record the disposal of the fixed asset at some point in the future —
for either a gain or for a loss.

Purchasing a fixved asset

Accounting for the purchase of a fixed asset is pretty straightforward.
Table 3-10 shows how a fixed asset purchase typically looks:

Table 3-10 Journal Entry 10: Recording Fixed Asset Purchase
Account Debit Credit

Delivery truck 12,000

Cash 12,000

If you purchase a $12,000 delivery truck with cash, for example, the journal
entry that you use to record this purchase debits delivery truck for $12,000
and credits cash for $12,000.
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Within QuickBooks, this journal entry actually gets made when you write the
check to pay for the purchase. The one thing that you absolutely must do is
set up a fixed asset account for the specific asset. In other words, you don’t
want to debit a general catch-all fixed asset account. If you buy a delivery
truck, you need to set up a fixed asset account for that specific delivery
truck. If you buy a computer system, you need to set up a fixed asset
account for that particular computer system. In fact, the general rule is that
any fixed asset that you would buy individually or dispose of later individu-
ally needs its own asset account. The reason for this is that if you don’t have
individual fixed asset accounts, later on, the job of calculating gains and
losses on the disposal of the fixed asset turns into a Herculean task.

Dealing with depreciation

Depreciation is an accounting gimmick to recognize the expense of using a
fixed asset over a period of time. Although you may not be all that familiar
with the mechanics of depreciation, you probably do understand the logic.
For the sake of illustration, suppose that you bought a $12,000 delivery
truck. Suppose also that because you know how to do your own repair work
and take excellent care of your vehicles, you will be able to use this truck for
ten years. Further suppose that at the end of the ten years, the truck will
probably have a $2,000 salvage value (your best guess). Depreciation says
that if you buy something for $12,000 and that you can later sell it for $2,000,
that decrease in value needs to be apportioned to expense. In this case, the
$10,000 decrease in value needs to be counted as expense over ten years.
That expense is called depreciation.

Accountants and tax accounting laws use a variety of methods to apportion
the cost of using an asset over the years in which it’s used. A common
method is called straight-line depreciation. Straight-line depreciation divides
the decrease in value by the number of years that an asset is used. An asset
that decreases $10,000 over ten years, for example, produces $1,000 a year
of depreciation expense.

To record depreciation, you use a journal entry like the one shown in
Table 3-11.

Table 3-11 Journal Entry 11: Recording Fixed Asset Depreciation
Account Debit Credit
Depreciation expense 1,000

Acc. dep. — Delivery truck 1,000
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Choosing a depreciation method

Straight-line depreciation, which I've illustrated
here, makes for a good example in a book. It's
easy to understand and to illustrate. However,
most accountants and business owners use
more complicated depreciation methods for a
variety of reasons. One of the most important
reasons is that tax accounting laws generally
allow for depreciation methods that accelerate
tax deductions.

You need to figure out the annual depreciation
according to one of these tax-based deprecia-
tion methods with your tax advisor's help.
Different rules apply to different types of
assets. The rules that you use for a particular
asset depend on when you originally purchase
the asset. | recommend that you use and record
within QuickBooks the asset depreciation that
you use for your tax accounting. Depreciation
is complicated enough as it is. You don't want
to be using one method of depreciation within

QuickBooks for your own internal financial
management and then another method for your
tax returns.

While | am on the subject of depreciation, |
should also mention that many small firms have
the option of using something called a Section
179 election. (Section 179 is a chunk of law in
the Internal Revenue Code.) A Section 179 elec-
tion allows many businesses to immediately
depreciate 100% of the cost of many of their
fixed assets at the time of purchase. Despite
the fact that a Section 179 election means that
you can immediately write off the purchase of,
for example, a $24,000 vehicle at the time of
purchase, you still want to treat fixed assets
expensed via a Section 179 election the way |
describe here. The difference is that you'll
immediately show the asset as fully depreci-
ated — which means depreciated down to its
salvage value or down to zero.

Journal Entry 11 debits an expense account called “depreciation expense”
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for $1,000. Journal Entry 11 also credits a contra-asset account called “accu-
mulated depreciation — delivery truck” for $1,000. (By convention, because
the phrase “accumulated depreciation” is so long, accountants and book-
keepers usually abbreviate it as “acc. dep.”) Note also that you need to have
specific individual accumulated depreciation contra-asset accounts for each
specific individual fixed asset account. You don’t want to lump all of your
accumulated depreciation together into a single catch-all account. That way
lies madness and ruin.

Disposing of a fixed asset

The final wrinkle of fixed asset accounting concerns disposal of a fixed asset
for a gain or for a loss. When you ultimately sell a fixed asset or trade it in or
discard it because it’s now junk, you need to record any gain or loss on the
disposal of the asset. You also need to remove the fixed asset from your
accounting records.
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To show you how this works, consider again the example of the $12,000
delivery truck. Suppose that you've owned and operated this truck for two
years. Over that time, you've depreciated $2,000 of the truck’s original pur-
chase price. Further suppose that you are going to sell the truck for $11,000
in cash. Table 3-12 shows the journal entry that you would need to make in
order to record this disposal.

Table 3-12 Journal Entry 12: Recording Fixed Asset Sale for Gain
Account Debit Credit

Delivery truck 12,000

Cash 11,000

Acc. dep. — Delivery truck 2,000

Gain on sale 1,000

The first component of Journal Entry 12 shows the $12,000 credit of the
delivery truck asset. This makes sense, right? You need to remove the deliv-
ery truck from your fixed asset amounts, which you do by crediting the
account for the same amount that you originally debited the account when
you purchased the asset.

The next component of the journal entry shows the $11,000 debit to cash.
This component, again, is pretty straightforward. It shows the cash that you
receive by selling the asset.

The third component of the journal entry backs out the accumulated depre-

ciation. If you depreciated the truck $1,000 a year for two years, the accumu-
lated depreciation contra-asset account for the truck should equal $2,000. To
remove this accumulated depreciation from your balance sheet, you need to
debit the accumulated depreciation account for $2,000.

The final piece of the disposal journal entry is a plug, a calculated amount.
You know the amount and whether that amount is a debit or credit by look-
ing at the other accounts affected. For example, in the case of Journal Entry
12, you know that a $1,000 credit is necessary to balance the journal entry.
Debits must equal credits.

A credit is a gain. A credit is essentially revenue, as you may remember from
the discussion on double-entry bookkeeping in Book I, Chapter 2.

If the plug was a debit amount, the disposal would produce a loss. This
makes sense; a loss is like an expense and expenses are debits.



Recognizing Liabilities o1

If you are confused about the gain component of Journal Entry 12, let me
make this observation. Over the two years of use, the business depreciated
the truck by $2,000. In other words, the business, through the depreciation
expense, said that the truck lost $2,000 of value. If, however, the $12,000
delivery truck is sold two years later for $11,000, the loss in value doesn’t
equal $2,000. The loss in value equals $1,000. The $1,000 gain, essentially,

recaptures the unnecessary, extra depreciation that was incorrectly charged.

You can enter both Journal Entries 11 and 12 as journal entries within
QuickBooks using the Make Journal Entries command.

Recognizing Liabilities

Liabilities are amounts that a business owes to other parties. For example, if
a business owes a bank money because of a loan, that’s a liability. If a busi-
ness owes an employee wages or benefits, that’s a liability. If a business
owes the federal, state, or local government taxes, those are liabilities.

Borrowing money

Liabilities, fortunately, aren’t that tricky to record after you’ve seen how the
journal entries look. Table 3-13, for example, shows how you record money
borrowed on a loan. In the case of a $10,000 loan, for example, you would
debit cash for $10,000 and credit a loan payable liability account for $10,000.

Table 3-13 Journal Entry 13: Borrowing Money via a Loan
Account Debit Credit

Cash 10,000

Loan payable 10,000

Sometimes, you may purchase an asset with a loan. Suppose, for example,
that you purchased $10,000 of furniture by using a note payable or a loan.
Even though there is no immediate cash affect to this entry, you still need to
record the transaction. Table 3-14 shows how you record this transaction. A
furniture account gets debited for $10,000 and a loan payable account gets
credited for $10,000.

Table 3-14 Journal Entry 14: Buying an Asset with a Loan
Account Debit Credit
Furniture 10,000

Loan payable 10,000
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You can record Journal Entry 13 directly into your checkbook when you
record the $10,000 cash deposit. You can also record Journal Entry 13, as
well as Journal Entry 14, by using the Make Journal Entries command that
QuickBooks provides. Journal Entry 14, by the way, can only be recorded by
using the Make Journal Entries command.

Making a loan payment

To record the payment on a loan, you or QuickBooks enters a journal entry
like the one shown in Table 3-15. For example, suppose that in connection
with the loan shown in Journal Entry 13, you need to pay $2,200. Suppose
that this amount is for $1,200 of loan interest and $1,000 of principal. In this
case, you debit loan payable for $1,000, debit loan interest expense for
$1,200, and credit cash for $2,200.

Table 3-15 Journal Entry 15: Paying a Loan Payment
Account Debit Credit

Loan payable 1,000

Loan interest expense 1,200

Cash 2,200

Sometimes, the tricky thing about loan payments is breaking the payment
amount into its principal and loan components. Hopefully, the lender will
provide you with an amortization schedule that breaks down payments into
principal and interest.

If a lender doesn’t provide such an amortization schedule, you need to calcu-
late the interest expense yourself by using either a spreadsheet or a calcula-
tor. Then, after you have calculated the interest expense, you can deduce the
principal component by subtracting the interest from the payment amount.

Accruing liabilities

[ want to show you one other liability-related journal entry. Very commonly, a
business will owe money for some goods or services or taxes that needs to be
recorded in the accounting system. For example, if at the end of an accounting
period — say at the end of the year — you owe $1,200 of interest on some loan,
you really need to record that interest expense in your accounting system. You
also need to record the fact that while the loan balance may show as $10,000
in your accounting records, for example, you probably really owe $11,200
because you owe both the $10,000 of principal and $1,200 of accrued interest.
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To accrue a liability, you use a journal entry like the one shown in Table 3-16.
This journal entry shows the accrual of $1,200 of interest expense on a loan
payable.

Table 3-16 Journal Entry 16: Accruing a Liability
Account Debit Credit
Loan interest expense 1,200

Loan interest payable 1,200

The journal entry shows a $1,200 debit to loan interest expense and a $1,200
credit to loan interest payable. This journal entry records amounts that you
owe as of the end of the accounting period that don’t get recorded in some
other way.

You need to be careful about using journal entries like the one shown in
Journal Entry 16. Typically, you want to use such journal entries when it’s
very important to count all of your expenses and to accurately measure all
of your liabilities.

One common situation in which you would want to be especially careful
about making such accruals is if you sell your firm. Any prospective pur-
chaser would want to have not only a very good estimate of your true
expenses for the accounting period, but the purchaser would also want a
very accurate estimate of liabilities at the point in time that the business is
being evaluated.

Liability accruals like the one shown in Journal Entry 16 present the account-
ant or bookkeeper with a problem, however. To return to the example of the
accrued interest shown in Journal Entry 16, suppose that at a later point in
time, the business makes a $3,000 payment, which includes the interest
accrued in Journal Entry 16. What the accountant or bookkeeper needs to do
when he or she later records this loan payment is to remember or recognize
the earlier journal entry. You don’t want the accountant or bookkeeper to
double-count interest expense by again recording the same interest. This
makes sense, right?

Because accountants and bookkeepers can’t reliably remember these sorts
of accrual entries — remember that they may need to recall them months
later — they typically back out the effect of the accrual from the first day of
the new accounting period.

For example, if Journal Entry 16 were recorded at the end of year 1 to accu-
rately estimate interest expense and liability balances, an accountant or
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bookkeeper could, on the first day of year 2, enter a reversing journal entry.
This reversing journal entry would credit loan interest expense for $1,200 and
debit loan interest payable for $1,200. In other words, this reversing journal
entry reverses the earlier accrual. Because the accrual entry is still in year 1,
however, year 1’s estimates of interest expense and liability account balances
are still correct.

Table 3-17 shows how a reversing entry looks. Again, notice that it’s simply
the mirror image of Journal Entry 16. The debits and credits are flip-flopped.

Table 3-17 Journal Entry 17: Reversing an Accrual
Account Debit Credit
Loan interest expense 1,200

Loan interest payable 1,200

When the actual loan interest payment is made, the journal entry appears as
though no accrual or reversal ever existed. Table 3-18 shows this. For exam-
ple, suppose that at some time in year 2 the business pays $1,800 of interest
by making a cash payment. Journal Entry 18 shows how this transaction gets
recorded.

Table 3-18 Journal Entry 18: The “Real” Loan Interest Payment
Account Debit Credit

Loan interest expense 1,800

Cash 1,800

Let me just quickly summarize what happens with Journal Entries 16, 17,
and 18:

4 Journal Entry 16 enables you to show at the end of year 1 that the busi-
ness owes $1,200 of interest on a loan — even though that interest
hasn’t yet been paid. Journal Entry 16 also shows that even though the
money wasn'’t paid, loan interest expense of $1,200 was incurred.

4 Journal Entries 17 and 18 need to be combined to be understood.
Journal Entry 17, for example, reduces the loan interest payable to zero.
Remember that the loan interest payable would be a balance sheet liabil-
ity account. The combination of the $1,200 debit and credit zero this
account out. The $1,200 credit to loan interest expense in Journal Entry
17 needs to be combined with the $1,800 debit to loan interest expense
in Journal Entry 18. This seems funny because after all, aren’t you really
paying $1,800 of interest? That’s true, but remember, looking back at
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Journal Entry 16, you already recorded $1,200 of loan interest expense.
That interest expense has been recorded for year 1 in this example. If
you have $1,800 of loan interest in total, what’s left over for year 2 is the
remaining $600. The combination of the $1,200 credit to loan interest
expense and the $1,800 debit to loan interest expense produces this
$600 of loan interest expense. The only other component of these two
journal entries that needs to be mentioned is the $1,800 credit to cash.
This credit to cash just represents the actual cash payment that is made
to pay the loan interest amount.

You need to be careful when working with accrual entries, reversing entries,
and then the real entries that follow and correct everything in the end. These
tools can be enormously helpful when it’s important to accurately measure
expenses and liabilities. However, you must remember to complete the entire
sequence of transactions; you can’t stop halfway.

One last important point — in Journal Entries 16, 17, and 18, I talk about how
to accrue loan interest expense. This accrual technique can be used to rec-
ognize any liability, a fact that I want to emphasize here. You can use the
technique demonstrated in these journal entries to deal with liabilities for
things such as wages owed to employees, taxes owed to the government,
and so forth.

Some firms, particularly those with sophisticated accounting systems, can
even use this technique to record hard-to-quantify liabilities, such as a war-
ranty liability. (A warranty is a promise that you make to a customer; for
example, you promise that your product won’t break.) These promises
create liabilities and expenses. An accurate accounting system requires that
you record these expenses as they occur and recognize these liabilities as
they come into existence.

Closing Out Revenue and Expense Accounts

You're about to enter the twilight zone of accounting. In this section, I talk
about what happens to revenue and expense accounts at the end of the year
in traditional manual accounting systems. And then I explain why QuickBooks
doesn’t quite work that way, and what you need to do about it.

If you want to skip anything in this chapter, this is probably the material. On
the other hand, if you're like me and you have a compulsive personality and
deem it essential to read everything in this chapter (even stuff that’s not par-
ticularly exciting), read on.

Book I, Chapters 1 and 2 describe an imaginary hot dog stand business. This
is a one-day business that, in my imagination, you operate. (If you've been
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reading through this chapter and have no questions, you don’t even need to
worry about those chapters.) Table 3-19 shows the trial balance for this busi-
ness at the end of the day of operation.

Table 3-19 A Trial Balance at End of the Period
Account Debit Credit
Cash 5,000

Inventory 0

Accounts payable 0
Loan payable 0
S. Nelson, capital 1,000
Sales revenue 13,000
Cost of goods sold 3,000

Rent 1,000

Wages expense 4,000

Supplies 1,000 -
Totals 14,000 14,000

The traditional close

As you hopefully already know, revenue and expense accounts count rev-
enue and expenses for a particular period of time. For example, revenue and
expense accounts may count for the month, the quarter, or the year.

One of the things that accounting systems traditionally do is zero out the
revenue and expense accounts at the end of the year. This makes sense if
you think about it a bit. You want your counters reset at the beginning of the
year, so counting the new year’s revenues and the new year’s expenses is
easy. In the case of a trial balance like the one shown in Table 3-19, for exam-
ple, you would typically make the journal entry shown in Table 3-20.

Table 3-20 Journal Entry 19: Closing the Period
Account Debit Credit
Sales revenue 13,000

Cost of goods sold 3,000
Rent 1,000
Wages expense 4,000
Supplies 1,000

Owner’s equity 4,000
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If you look at Journal Entry 19, for example, you see that the first line in the
journal entry is a $13,000 debit for sales revenue. If you look back at the trial
balance shown in Table 3-19, you see that sales revenue has a $13,000 credit
balance. The combination of the account balance shown in Table 3-19 and
the closing entry shown in Journal Entry 19 effectively zero out the sales rev-
enue account.

The same sort of accounting magic occurs for each of the other expense
accounts shown in the trial balance. The cost of the goods sold balance is
equal to a $3,000 debit in Table 3-19, and is zeroed out in Journal Entry 19
with a $3,000 credit. And so it goes.

The QuickBooks close

The sort of accounting taught at local community colleges makes just the
sort of closing entry shown in Journal Entry 19. However, you actually don’t
need or even want to make such a closing entry within QuickBooks.

The closing entry shown in Journal Entry 19 gets made in a manual system
so that the revenue and expense accounts can be reset to zero. In compari-
son, QuickBooks, relying on the power of the computer, doesn’t need to
have these accounts reset to zero in order to correctly calculate the revenue
and expense for the new accounting period. QuickBooks, as you will learn
throughout this book, can calculate revenue or sales for any period and for
any interval of time by using its report generation tool to summarize rev-
enues and expenses that occur within a particular time interval.

This seemingly missed step doesn’t cause any idiosyncratic behavior on the
part of QuickBooks. QuickBooks lumps the revenue and expenses from all
the previous years into a retained earnings amount reported on the balance
sheet. Net income for the current year is also reported in the equity portion
of the balance sheet. In addition, if you have a corporation, QuickBooks typi-
cally includes a dividends paid account in the equity portion of the balance
sheet. I'm getting ahead of myself, however.

The main thing that I want you to know is that this seemingly critical text-
book journal entry for closing out revenue and expense accounts isn’t made
within QuickBooks. This is okay, because QuickBooks doesn’t need to make
the traditional closing entry.

You may want to ask your accountant about this. By convention, however,
any dividends paid by a corporation are typically zeroed out or combined
with retained earnings at the end of the year. If you want to combine divi-
dends paid for the current year with accumulative retained earnings, you do
this with a journal entry. The journal entry credits the dividends paid account
and debits retained earnings for the amount of dividends paid for the year. I
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hesitate to encourage you to make this journal entry willy-nilly, however. |
think it’s okay to skip making the entry. And before you make it, consult your
tax advisor.

One More Thing . . .

In this chapter, I tried to address any of the common, complicated journal
entries or accounting transactions that business owners encounter. I know
[ can’t answer every question here, but [ do want to provide as thorough a
set of instructions as possible. All this is leading up to a special request. If
you’ve read through this chapter and didn’t find a discussion of the sort of
journal entry or accounting transaction that you need to record, send me
an e-mail or write me a letter that tells me what help you hoped to find
here ... but didn't.

[ can’t promise you that I'll be able to supply an answer. But if you describe
a journal entry that [ should have included, I'll try to respond to your e-mail
with instructions on how to make the journal entry. I'll also include a
description of the journal entry in the next edition of this book.

If you want to reach me, you can write me a letter in care of the publisher
(the publisher’s address is in the front of this book). You can also send me
an e-mail message; you can find my e-mail address and other contact infor-
mation at www.stephenlnelson.com. (Please note that during tax season,
[ don’t respond to reader inquiries as quickly as I do at other times of the

year.)
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Chapter 1: Setting Up QuickBooks

In This Chapter

v Planning your new QuickBooks system

v~ Installing QuickBooks

v Dealing with the system pre-interview jitters
+* Running the EasyStep Interview

v~ Fixing the EasyStep Interview errors

In order to use QuickBooks, you need to do two things: install the
QuickBooks software and run the setup interview, which is called the
EasyStep Interview. This chapter discusses both of these tasks from a bird’s-
eye view. | also want to spend just a few paragraphs talking about some of
the planning that you should do before you set up QuickBooks, and some of
the errors created by the EasyStep Interview that you’ll have to fix.

Planning Your New QuickBooks System

I'm going to start with a couple of big picture discussions: what accounting
does and what accounting systems do. If you understand this big picture
stuff from the very start, you’ll find that the QuickBooks setup process
makes a whole lot more sense.

What accounting does

Let’s start with a discussion about what accounting does. People may argue
about the little details, but most would agree that accounting does the fol-
lowing four important things:

4+ Measures profits and losses

4+ Reports on a financial condition of a firm (its assets, liabilities, and
net worth)

4+ Provides detailed records of the assets, liabilities, and owner’s equity
accounts

4+ Supplies financial information to stakeholders, especially to management
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What accounting systems do

Now take a brief look at what accounting systems — or at least at what small
business accounting systems — typically do:

4+ Produce financial statements, including income statements, balance
sheets, and other accounting reports.

4+ Generate business forms, including checks, paychecks, invoices, cus-
tomer statements, and so forth.

4+ Keep detailed records of key accounts, including cash, accounts receiv-
able (amounts that customers owe a firm), accounts payable (amounts
that a firm owes its vendors), inventory items, fixed assets, and so on.

4 Perform specialized information management functions. For example, in
the publishing industry, book publishers often pay authors royalties. So
royalty accounting is a task that book publisher accounting systems
must typically do.

What QuickBooks does

Okay, after you understand what accounting does and what accounting sys-
tems typically do, you can see with some perspective what QuickBooks does:

4 Produces financial statements

4+ Generates many common business forms, including checks, paychecks,
customer invoices, customer statements, credit memos, and purchase
orders

4+ Keeps detailed records of a handful of key accounts: cash, accounts
receivable, accounts payable, inventory in simple settings, and that’s
about it

Allow me to make an important observation here: QuickBooks does three of
the four things that you would expect an accounting system to do. Compare
the list that I just provided with the previous list (“What accounting systems
do”) to see this for yourself. However, I'll save you the time finding the fourth
thing; QuickBooks doesn’t supply the specialized accounting stuff. For exam-
ple, QuickBooks doesn’t do royalty accounting, as discussed in the earlier
example.

And now for the bad news

So, QuickBooks does three of the four things that accounting systems do,
but it doesn’t do everything. QuickBooks is often an incomplete accounting
solution. You need to be careful, therefore, about setting your expectations.
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You also typically need to figure out workarounds for some of your special
accounting requirements.

QuickBooks gives users and businesses a lot of flexibility. So, returning to

the previous example, a book publisher can do much of what it needs to do
for royalty accounting in QuickBooks. This royalty accounting work simply
requires a certain amount of fiddling as the business is setting up QuickBooks.

However, QuickBooks does suffer from a couple of significant weaknesses:

4 QuickBooks Basic and Pro don’t supply a good way to handle the manu-
facture of inventory. However, QuickBooks Premier does support simple
manufacturing accounting. (QuickBooks helps you account for the
process of turning raw materials into finished goods.)

Book I
Chapter 1

4 QuickBooks doesn’t handle the situation of storing inventory in multiple
locations. It will just show, for example, that you have 3,000 widgets.
It doesn’t let you keep track of the fact that you have 1,000 widgets at
the warehouse, 500 widgets at store A, and 1,500 widgets at store B.
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In spite of the fact that QuickBooks may be an incomplete solution and the
fact that QuickBooks may not handle inventory the way you want or need,
QuickBooks is still a very good solution. What QuickBooks does, it does very
well. Furthermore, I don’t want to suggest that you shouldn’t ever use some
smaller software company’s accounting solution, but consider the fact that
QuickBooks will be around for a long, long time.

It’s far more likely that an accounting software product with 600 users, for
example, will be discontinued than a product like QuickBooks, which has
2,000,000 customers.

Installing QuickBooks

You install QuickBooks in the same way that you install any application pro-
gram. And how you install an application program depends on which version
of Microsoft Windows that you’re using. In general, however, recent versions
of Microsoft Windows require that you place the QuickBooks CD into your
CD-ROM or DVD drive. When you do this, Windows looks at the QuickBooks
CD and recognizes it as a CD that includes a new, to-be-installed software
program, and starts the process for installing the QuickBooks software.

You don’t need to do anything special to install QuickBooks. Simply follow the
on-screen instructions. You typically will be prompted to enter the installation
key or installation code. This code is available within the QuickBooks packag-
ing — usually on the back of the envelope that the CD or DVD comes in.
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The QuickBooks installation process may ask you to answer questions about
how you want QuickBooks installed. Almost always, you want to accept the
default suggestions. In other words, QuickBooks may ask you whether it can
create a new folder in which to install the QuickBooks program files. And in
this case, choose yes.

If your version of Microsoft Windows doesn’t recognize that you’ve stuffed
the QuickBooks CD into the machine’s CD or DVD drive, you have a couple of
choices:

4+ You can wait. Probably, if you wait, Windows will recognize that you’'ve
placed the QuickBooks CD into the CD or DVD drive and, after a short
wait (even though it may seem like an eternity), Windows will start the
process of installing the QuickBooks program.

4+ You can manually force the installation of the QuickBooks program.
Windows includes a tool that you can use to add or remove new programs
(unsurprisingly named the Add/Remove Programs tool). I don’t describe
how this Control Panel tool works here, but you can refer to a book such
as Windows XP For Dummies, by Andy Rathbone (Wiley Publishing, Inc.),
or Windows online Help to get this information. In a nutshell, you simply
open the Control Panel window, click the Add/Remove Programs tool and
follow the on-screen instructions for telling Windows to install a program
stored on the CD or DVD in the computer’s CD or DVD drive.

v?‘“\NG! QuickBooks works as a multi-user accounting system. This means that sev-

8 eral people can use QuickBooks. The QuickBooks data file — the repository
of all the QuickBooks information — typically resides on a centrally available
computer, or server. People who want to work with the QuickBooks data file
simply install the QuickBooks program on their computers and then use the
program to access centrally located QuickBooks data files. This multi-user
system isn’t complicated at all to run; in fact, I talk about it quite a bit in Book
VII, Chapter 2. Note that you need to own a separate copy of QuickBooks for
each computer on which you install QuickBooks. You can also buy multi-user
copies of QuickBooks that let you install the QuickBooks program on up to
five computers. | mention this because you don’t want to get involved in
software piracy — which is a felony — as part of inadvertently setting up
QuickBooks in the wrong way. The bottom line: You need a legal copy of
QuickBooks for every machine on which you install QuickBooks.

Dealing with the Pre-Interview Jitters

After you install QuickBooks, you run an interview to set up QuickBooks for
your firm’s accounting. In the next sections, I explain what you need to do
before you run the QuickBooks setup interview so that you work in an effi-
cient manner. I also give you an overview of what you’ll do as you go through
the interview.
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Preparing for the interview

In running the interview, you will need to provide quite a bit of information
to QuickBooks. As a practical matter, the EasyStep Interview requires that
you have the following:

4+ Accurate financial statements as of the conversion-to-QuickBooks date

4+ Detailed records of your accounts payable, accounts receivable, inven-
tory, and fixed assets

4+ A complete or nearly complete list of employees, customers, vendors,
and inventory items (if you buy and sell inventory)

You want to get all this stuff together before you start the EasyStep Interview
because you will be asked about this stuff as part of the interview. Don’t try
to scurry around, looking for a particular piece of data, while you are run-
ning the interview; collect this data up front. Then stack all the necessary
paperwork on your desk next to your computer.

Let me also note that you are going to need to make several accounting deci-
sions as you go through the EasyStep Interview. For example, you’ll need to
decide whether you want to use an accounts payable system. You'll need to
tell QuickBooks whether you want to send customers monthly statements.
You'll also be asked whether you want to prepare estimates for customers.
And you’ll be asked whether you want to use classes to further track your
income and spending.

In general, when you're asked one of the accounting questions, you can
simply accept the default answer. However, you are required by law to be
consistent in your accounting for tax purposes. If you want to change your
accounting — technically called a change of accounting method by the Internal
Revenue Service — you need to request permission to make the change from
the IRS. How to do this and the ramifications of doing this are beyond the
scope of this book, but be forewarned: The IRS insists that you be consistent
in your accounting. If you've been treating particular items of income or
expense in a certain way, the IRS says, “Hey, dude, you need to continue to
treat them that way unless you get permission from us to change.”

One final note: You should have your tax return from last year handy because
it supplies a bunch of information that you’ll need for running the EasyStep
Interview. For example, last year’s tax return supplies your taxpayer ID
number, your legal business name, and your method of accounting.

What happens during the interview

As you walk through the interview, you work with QuickBooks to set up a
chart of accounts, to identify your starting trial balance, and to load your

Book I
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key master files. The chart of accounts, just so you know, identifies those
income, expense, asset, liability, and owner’s equity accounts that appear on
your financial statement. The trial balance identifies your year-to-date income
and expense numbers and your asset, liability, and owner’s equity numbers
as of the conversion date. The master files store information that you repeat-
edly use about customers, vendors, employees, and inventory items. For
example, the customer master file stores the customer’s name and address,
phone number, and the contact person.

In addition, and as noted in the previous paragraphs, you make several
accounting decisions during the interview. For example, you decide whether
you want to use accounts payable.

Running the EasyStep Interview

A\

After you install the QuickBooks program, the installation program may start
QuickBooks automatically and then start the EasyStep Interview. You can
also start the EasyStep Interview by starting the QuickBooks program —
start QuickBooks the same way you start any program — and by choosing
the Files>"New Company command.

The big Welcome

The Welcome portion of the EasyStep Interview requires that you step
through roughly half a dozen screens of information. One of the first screens
tells you that if this EasyStep Interview is too difficult, you can pay to get
help from the QuickBooks certified advisor. (QuickBooks advisors, by the
way, are people who have paid $500 to Intuit to get a copy of QuickBooks
and be listed on the QuickBooks Web site as a QuickBooks advisor.) The
Welcome portion of the EasyStep Interview also gives you some basic infor-
mation about how to navigate through the interview; you also get some
other basic information about the process. Read the screens of information
and click the Next button.

No matter how you get to the EasyStep Interview, the first thing you see is
the Welcome tab of the EasyStep Interview window, as shown in Figure 1-1.

The EasyStep Interview walks you through a bunch of tabs or screens full of
information. To move to the next tab, you click the Next button. To move to
the previous tab, you click the Prev button. If you get discouraged and want
to give up, you can click the Leave button. But try not to get discouraged.
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EasyStep Interview
g Welcome Company Info Preferences Start Date General
= | Incame &
Expenses
4
s Income
—— Details
4
Figure 1-1: Opening
9 s Click Next Balances
The i to begin ‘
EasyStep g General What's Next
Interview 3 section...
window 4
showing the g
Welcome
tab.
Supplying company information
The Company Info tab collects several important pieces of information, includ-
ing your company name and the firm'’s legal name, your company address,
your federal tax ID number, the first month in the income tax year (typically
January), the first month in the fiscal year (again, typically January), the type
of income tax form that your firm uses to report to the IRS, and the industry or
type of company that you are operating (retail, service, and so forth), as
shown in Figure 1-2.
EasyStep Interview
é fWe\cDmE Company Info Preferences Start Date General
g Select your type of business ; -
nCome
=l Select your business type from the scrollable list, Expenses
Figure 1_2- A Chaase your company type carefully, You can not change your company type E)nect?aw:
" = | & later,
The i i Industry EOQEEES
Company 4 Retall General
Service Busi '
Info tab that |3 Ve o Hhats et
= ‘wholesale/Distribution
aSkS What =] ‘Writer [Photographer/Other Artisk
Other
type of 4 = =
b . 4 Tell Me Mare
us!ness 4 What if my industry isn't on the list? More
you're
unning 1 e

As part of the company info process, QuickBooks creates the company data file
that stores all of a firm’s financial information. QuickBooks suggests a default
name or a QuickBooks data file based on the company name (Figure 1-3).
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All you need to do is accept the suggested name and the suggested folder

location (unless you want to save the data file into the My Documents folder,

which isn’t a bad idea).

Fil for New Company [B]=]
Save i | [ QuickBoaoks Pra £ G T & Ex
by ([ Components
:a [DData
My Recent [LDINET
Documents [J)Pine Lake Porcelaind - Images
- |[)Pine Lake Porcelain - Images
B ([ QuickBooks Letkers
Deskiop |[Z)stephen_ - Images
() Trial
B acme Zarp
Pine Lake Porcelain
My D " Pine Lake Porcelainz
DRE=IELS Pine Lake Porcelaind
sample
, ‘.5 sample_product-based business
"J sample_service-based business
My Computer StEDhEI‘L
: <
Flgllre 1 '3: My NIE‘I:DIK File: name: Pine Lake Porcelair| i
The Save As Flaces Save as type DuickBooks Files [* 0B, " 0B&) v
dialog box.
Based on the information that you supply about your type of industry and
the tax form that you file with the IRS, QuickBooks suggests a starting set
of accounts. These accounts are the categories that you’ll use to track
your income, expenses, assets, and owner’s equity. Figure 1-4 shows the
Company Info tab that the EasyStep Interview displays for showing you
these accounts.
EasyStep Interview
é ‘/'Welcoma Company Info Preferences Start Date General
2 Your income and expense accounts
= Income &
) QuickBooks has chosen these accounts For retall Expenses
— businesses. Accounts
. =] Do youwant to use these accounts? g;:‘l: [ EﬂCtDIfTE
Flgure 1-4' = Merchandise e
The = () Mo, I'd lke to creats my own é‘;:ﬂ\:icganment Solas g’;:mﬂegs
Com an = | Shipping and Handling
p y = If vou accept the displayed accounts, c Dﬁgunts lee_n What's Mext
InfO ta b QuickBooks will set them up for you a;ﬁ:;:r:fancles
= | when you click Mext, Shortagges
asks you = | Furchases
Wh | c h = Purchase Discounts ha
expense = Tell Me More
p =l an I change these accounts?
accountyou
want. :
Coe Il




Figure 1-5:
The
Preferences
tab asks
whether you
want to use
accrual- or
cash-basis
reporting.
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Choosing your preferences
After you provide high-level company information through the EasyStep

Interview, QuickBooks walks you through a bunch of questions about the
QuickBooks preferences. Preferences, in effect, give you a way to turn on or off
various features about how QuickBooks accounting works, how QuickBooks
looks, and so forth, as shown in Figure 1-5. Here are the first questions that the
Preferences tab asks:

4+ Does your firm maintain inventory?
Do you want to track the inventory that you buy and sell?
Do you collect sales tax from your customers?
When do you sell items?

What invoice format do you want to use to bill customers?

IR

Do you want to use sales orders to track customer orders and
backorders?

<+

Do you want to use QuickBooks to help with your employee payroll?

<+

Do you want to prepare written or verbal estimates for your customers?

Do you ever prepare more than one invoice for one estimate (if you want
to do progress billing or partial billing)?

4+ Would you like to track the time that you or your employees spend on
jobs or projects for customers?

4+ Do you want to use classes to further segregate income and expense,
assets, liabilities, and owner’s equity data?

EasyStep Interview

é ‘/We\come fcampany Info Preferences Start Date General

Accrual- or cash-based reporting

Income &

Do you prefer to view reports on an accrual or cash basis? Expenses

© Fash-based reports . fEEe
() Accrual-based reports; Details
Far cash-based reports, income is reported when vou receive the payment on an invoice, and
an expense is reported when you pay a bil,
Far accrual-based reports, income is reported as soon as you write an invoice, and an expense
is reported as soon as you receive a bill.

J 1f you haven't already done so, consider using accrual-based reporting, since it may give
you a more accurate picture of your business than cash-based reporting.

Qpening
Balances

twhat's Next

Tell Me More

Should I choose accrual-based reporting?
. [
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4+ How do you want to handle bills and payments (enter the checks
directly, or enter the bills first and the payments later)?

4+ How often do you want to see your Reminder List?

4+ Do you prefer to view reports on an accrual or cash basis?

Setting your start date

Perhaps the key decision that you make in setting up any accounting system
is the day on which you’ll begin using your new system. This is called the
conversion date. Typically, you want to begin using an accounting system on
either the first day of the year or the first day of a new month. QuickBooks
uses the Start Date tab of the EasyStep Interview dialog box to explain how
important it is to choose an appropriate start date. You'll also be prompted
to identify the start date by using the dialog box shown in Figure 1-6.

EasyStep Interview
é + Wielcome W Comparty Mo |y Freferences Start Date

General

: Select a start date for your company's books
Income &
QuickBooks uses a start date as the point at which you begin entering your business Expenses
4
3 transactions. You must enter all transactions between your start date and today to ensure Income
complete accounting records for your business,
Details
=
] () T want to start entering detailed transactions as of : 01,/01,/2004 Opening
. Many QuickBooks users base theit accounting records on their fiscal year so they can Balances
F|gu|-e 1-6: = | see detailed transactions for the entire year,
= | . f N tiwhat's Mext
The Sta rt (3) I want to start entering detailed transactions as of : | 10012004
Date tab = Select & specific date to start entering your transactions. For example, you could
=] choose today, the first of the month, etc,
prompts you |4
4 Tell Me More
for your El ‘What start date should T choose?
company
L
start date.
Cow I
P The easiest time to start using a new accounting system is at the beginning

of the year. The reason? You get to enter a simpler trial balance. At the start
of the year, for example, you only need to enter asset, liability, and owner’s
equity account balances.

At any other time, you also need to enter year-to-date income and year-to-date
expense account balances. Typically, you only have this year-to-date income
and expense information available at the start of the month. For this reason,
the only other feasible start date that you can pick is the start of a month.

In this case, you need to get year-to-date income amounts through the end of
the previous month from your previous accounting system. For example, if
you’ve been using Peachtree, you'll need to get year-to-date income and
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Figure 1-7:
The Income
Accts tab
of the
EasyStep
Interview
dialog box.
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expense amounts from Peachtree. You'll enter all of this trial balance data
later in the EasyStep Interview.

After you provide the start date, you have finished with the first general set
of interview questions. In other words, you've supplied the basic company
information, you’ve identified most of your accounting preferences, and
you’ve identified the date at which you want to start using QuickBooks.

If you click the Leave button, QuickBooks leaves you in the QuickBooks pro-
gram, ready to get to work. However, the EasyStep Interview process isn’t
lost forever; to get back into the interview, just choose EasyStep Interview
from the File menu.

Adding income accounts

After you complete the general set of EasyStep Interview questions,
QuickBooks asks you to add any income accounts or expense accounts
that you’ll need for your business. Figure 1-7 shows the Income Accts tab.

EasyStep Interview
é Income Accts Expense Accts fGenera\
4 Here are your income accounts
= | Income &
a Income accounts Expenses
E| At the vight is & list of income accounts QuickBonoks has setup  [Cash Discrepancies e

For your type of business, Overages Details
= | | Shortages

If vou don't see some accounts you wank, you can add them Sales
| ;lr?;;r?’gaﬁu can add them after you finish the EasyStep CemeErE Ses g;:gg;s

. Discounts Given

4 Do you want to add an income account now? Merchandise
= | Service What's Next
g Shipping and Handling
4
|
4 Tell Me More
E] Can I rename or delete an income accounk?
L
-

To create a new income account, select the Yes radio button, click Next, and
then enter a name for the account into the Account Name box that appears.
If you're comfortable, specify on which line of your tax form this account
gets reported. For example, if you're entering an account to track gross sales
for a sole proprietor, you may enter the account name Gross Sales into the
Account Name box. Then you can select Income: Gross Receipts or Sales
from the Tax Line drop-down list box, as shown in Figure 1-8 (this would end
up on the Schedule C tax form).
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Figure 1-8:
Creating a
new income
account.
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You can add several accounts for tracking income. To do this, you indicate
that you want to add another income account when asked.

After you add the last income account, QuickBooks asks you to review the
expense accounts that it has set up on your starting chart of accounts. To
add an expense account, you follow a process very similar to that for adding
an income account. For example, you give the account an account name. If
possible, you identify the tax line on which the expense account gets
reported.

You may not need to add expense accounts. Typically, QuickBooks starts with
a suggested chart of accounts that provides a rich set of expense accounts.
You can easily add additional income and expense accounts to the chart of
accounts list later on. In Book I, Chapter 2, [ describe just how to do this.

Working through the Income Details introduction

After you describe the income and expense accounts that you need,
QuickBooks walks you through a portion of the EasyStep Interview called
the Income Details section. The Income Details section asks about how you
account for the income that your firm produces. For example, the first ques-
tion that QuickBooks asks is whether you receive full payment at the time
you provide a service or product, as shown in Figure 1-9. QuickBooks also
asks whether you want to issue regular monthly statements to customers or
simply use invoices to bill customers.



Figure 1-9:
The
EasyStep
Interview
question
about
receipt of
payment.
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Figure 1-10:
How you set
up a service
item.

Identifying your income items

You use the Items tab of the Income Details section to identify the specific
things that you sell. In this section, the first question that QuickBooks asks,
for example, is whether you want to set up a service item for any work or
service that you sell. If you indicate that you do want to set up a service item,
QuickBooks displays a dialog box similar to the one shown in Figure 1-10.

To set up a service item — or any other item — you need to give the item a
name, a description, and a price. You also need to identify which income
account should be used to track sales of the item and whether the service
item is ever performed by a subcontractor.

EasyStep Interview
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\\3

Figure 1-11:
The
Inventory
tab used to
describe an
inventory
item.

QuickBooks also has you set up other types of items. For example, if you sell
inventory, you set up inventory items. If you bill customers for other things,
such as freight or sales tax, you also set up items for these.

[ don’t talk about how to set up all the different types of items in this chap-
ter. In Book Ill, Chapter 3, I go into great detail about how you describe the
items that your firm sells. The thing that you need to know here is that you
should set up a QuickBooks item for anything that you want to see on an
invoice.

If you carry inventory, you will also set up inventory items as part of the
EasyStep Interview.

Settmq up your lm/entory balances

The Inventory tab’s questions collect information about the inventory items
that you buy, hold, and sell. The screen shown in Figure 1-11, for example,
lets you name an inventory item, describe the item, and set a sales price.

EasyStep Interview

é ‘/'Intrnductmn V’Items Inventory /Genera\
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Ttem Mame Expenses
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L
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After you identify an inventory item, QuickBooks asks you to specify which
income account should be used to track sales of the item. You also need to
provide any purchase information that you have. This purchase information
includes a description that may go on purchase orders and the estimated
cost for each item.

The final bit of inventory item information that you supply concerns your
current holdings of the item. You need to enter the number of units that

you are holding on your store floor or in the warehouse, the value or cost

of that item, and, optionally, the reorder point that you want to use to get
reminders from QuickBooks when it’s time to reorder. Figure 1-12 shows a ver-
sion of the Inventory tab that you use to record this important information.



Figure 1-12:

Another

Inventory

tab collects

on-hand

information.
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EasyStep Interview
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When you identify the quantity and cost of inventory items that you hold,
you indirectly set your inventory balances — the same inventory balances
that are used on your balance sheet.

If you have a number of inventory items, setting up the inventory item
descriptions will take you some time. You need to go through this process
where you describe the type of item, and give balance and quantity informa-
tion for each item that you hold. If you have 20 items to set up in your items
list, this process won’t take too long. However, if you have 11,000 items in
your inventory, you probably won’t want to do it.

A suggestion: Before you give up on using a perpetual inventory system
(which is what QuickBooks does with its inventory items), talk with your tax
advisor or with your accountant. Many retailers do successfully use periodic
inventory systems (which means you wouldn’t go to the hassle of using the
QuickBooks Inventory Items feature). But perpetual inventory systems,
which always keep track of how much inventory you have on hand, deliver
huge benefits. The biggest benefit is that you’ll always know what inventory
items are selling well — and what items aren’t selling well.

If you have thousands of inventory items, it may be in your best interest

to hire some temporary bookkeeping help to enter this information into
QuickBooks. Obviously, the best time to hire this temporary person to set up
your inventory items file is when you next do a physical inventory count.

Setting up opening balances for customers

The Opening Balances portion of the EasyStep Interview collects information
about customers who owe you money, vendors to whom you owe money,
and the account balances of all your other balance sheet accounts.
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Remember that your start date or conversion date is key here; enter account
balances as of the start date.

QuickBooks will ask, as part of setting up your customer opening balance,
whether you have any customers who owe you money on your start date. If
you indicate in the affirmative, QuickBooks will first ask whether you want to
track jobs or projects for your customers. If you do, QuickBooks steps through
the process for adding the customer, the job, and the amount owed on the job.
If you don’t need to track balances by jobs or projects, you simply identify the
customer and the amount that the customer owes. Figure 1-13 shows the ver-
sion of the Customers tab that you use to name a customer and specify the
amount that the customer owes. If you select the Has Multiple Jobs check box,
QuickBooks forces you to identify the customer job and then the balances
owed on various jobs.

EasyStep Interview
é V’Intruductiun Customers Vendors Accounts fGenera\
g Adding customer n
MCOME:
a Custarner Marme Expenses
. This is the that ill toidentify Ehi
= Joe's Coffes House cu;stésrnerelr?gnllikﬁgnlr:ué\v::;i:e?a‘ster:'alrrz; fllsst if ncome
vou'd like to sort vour customer list that way, Details
2 Bolance dus on start dats
— a0 Entet the amount that this Opening
customer owed you on Balances
Figure 1-13: |3 Lo/lf2000
The = What's Mext
|
Customers |4
tab of the 4
E St El Tel Mz More
I asy A ep El Is this the name that prints on invoices? What about addresses, ete.?
nterview
window. :
C o= Il
!
g@\nc.
When you identify the amounts that customers owe you, you indirectly set
your accounts receivable balances.
\\3 If you want information about tracking amounts that customers owe by job,

refer to Book IV, Chapter 5. It describes how you can set up a job costing
system.

Providing vendor opening balances

In a manner very similar to that used to provide opening balances for your
customers, you also provide opening balances owed to your vendors.
QuickBooks will ask you to name a vendor and identify the amount that you
owe the vendor. To do this, QuickBooks uses the Vendors tab, as shown in
Figure 1-14.
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When you identify the opening balances for your vendors, you indirectly set
up your accounts payable account balances.

Setting your other account balances

The Accounts tab of the EasyStep Interview window lets you set account
balances for any of the other balance sheet accounts that you use. As part
of this section of the EasyStep Interview, for example, QuickBooks asks
whether you have a company credit card account on which you charge pur-
chases, lines of credit, open loans and notes, and so forth. If you indicate
that the business has a liability, QuickBooks asks you for the account bal-
ance at the start date, as shown in Figure 1-15.

After QuickBooks asks about your liability accounts, it asks about your
asset accounts. For example, QuickBooks asks if you have a bank account
(of course you do), what money you’ve loaned, what furniture and equip-
ment you possess, any other property that you have, and so forth. As with
the liability accounts, if you indicate that you do own a particular asset,
QuickBooks asks for the account balance as of the start date.

Figure 1-16 shows the version of the Accounts tab that you use to add an
asset account. If you add a fixed asset, QuickBooks also asks whether
you need to track depreciation for the asset. If you indicate that you do,
QuickBooks asks you to enter both the original cost of the asset and any
accumulated depreciation for the asset.
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EasyStep Interview
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The final set of balance sheet account balances that you need to provide are
those for your equity accounts. Equity accounts report the money that you
originally invested in your business and any profits that you've retained in
your business. For sole proprietorships, the equity account stuff is pretty
easy. You can put everything into one big account called “Proprietor’s
Capital” or something like that. Partnerships need to keep track of the capi-
tal allocated or held by each partner. In corporations, unfortunately, you
need to keep very detailed records of the sources and types of corporate
capital that have been contributed by investors.
\\J

[ talk a little bit about how equity account accounting works in Book I,
Chapter 1. If you are a little rough on the accounting, refer there for some
introductory information about how owner’s equity accounting works.



Figure 1-17:
The
QuickBooks
Learning
Center
window.
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Owner’s equity accounting can be a little tricky — especially if you haven’t
taken a Principles of Accounting class at the local community college.
QuickBooks suggests a list of equity accounts that you’ll need based on the
business form that you identified earlier in the EasyStep Interview.

Completing the What's Next section of the interview

The What’s Next tab of the EasyStep Interview displays a list of tasks that
QuickBooks suggests you complete before you begin day-to-day accounting
with QuickBooks. For example, it suggests that you make a backup copy

of your new QuickBooks data file. QuickBooks also suggests that you enter his-
torical transactions and set up any other users with passwords. QuickBooks
also wants you to do some other kinds of nit-picky stuff, such as customizing
your forms and signing up for one of the expensive QuickBooks payroll serv-
ices. (For information about how to back up the QuickBooks data file, refer to
Book VII, Chapter 3.)

Looking at the QuickBooks Learning Center window

After you finish with the EasyStep Interview, QuickBooks displays the
QuickBooks Learning Center window, , as shown in Figure 1-17. This window
provides clickable hyperlinks that you can use to view tutorials that provide
a “big picture” overview of how you work with QuickBooks. There’s good
stuff here, so if you're new to QuickBooks, go ahead: poke around. After you
finish poking, click the Begin Using QuickBooks button and the QuickBooks
program window appears.

@ QuickBooks Learning Center
QUickBooks Welcome to QuickBooks
Ledrning lLenter QuickBooks Overview
Welcome to The tutarials in the QuickBooks Learning Center will help you get started right away.
QuickBooks fou'l get a "big picture” overview of important concepts in QuickBooks, as well as
step-by-step instructions For key Lasks,
Understanding Get oriented
the Basics + DuickBooks overview 300
Customers & Sales Learning Center tips

* Yiew the tutorials in the Understanding the Basics section
= Yiew other tutorials that are relevant to your business

= ‘fou don't need to wiew all the tutorisls at once

» Feel free ko kry out what yvou've learned

I Ireeentory + Come back by selecting QuickBooks Learning Center
from the Help menu

Wendors & Expenses

‘Wehat's New

L

v shaw this window at startup Begin Using QuickBooks
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Fixing the EasyStep Interview Ervors

Here’s an interesting bit of trivia: In spite of all the accounting, tax, and just
general financial genius residing at Intuit (the maker of QuickBooks and a
bunch of other financial accounting software), the EasyStep Interview almost
always leaves you with some errors that need fixing. In a nutshell, QuickBooks
simply forgets to ask about or enter the year-to-date income and expense data.
Furthermore, QuickBooks muddies the water by incorrectly counting the
accounts receivable balance as uncategorized income and the accounts
payable balance as uncategorized expense. You need to fix these errors.

In order to record your year-to-date income and expense amounts, you need
to record a journal entry. The journal entry needs to record the trial balance
amounts for all of your income and expense accounts. The plug, or difference
between your income and expense accounts, needs to be credited or debited
to a weird account called Opening Bal Equity, which is a suspense account
that QuickBooks uses to attempt to camouflage its bookkeeping madness.

To show you how this works, suppose that you have the trial balances
shown in Table 1-1. Note that this is the trial balance used in the discussion
in Book I, Chapter 2. The crazy thing about the EasyStep Interview is that
only those accounts that appear on the balance sheet end up being set up
as part of the EasyStep Interview. This means that the income and expense
accounts shown on the trial balance in Table 1-1 don’t get set up.

Table 1-1 A Trial Balance

Account Debit Credit
Cash 5,000

Inventory 0

Accounts payable 0
Loan payable 0
S. Nelson, capital 1,000
Sales revenue 13,000
Cost of goods sold 3,000

Rent 1,000

Wages expense 4,000

Supplies 1,000

Totals 14,000 14,000




Figure 1-18:
The General
Journal
Entries
window.
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Figure 1-18 shows how the General Journal Entries window looks when it
records the missing trial balance information from Table 1-1. Note that the
plug, or last line of the journal entry, is a debit to Opening Bal Equity. This is
the freaky, flaky suspense account that QuickBooks uses to throw stuff into
that it doesn’t know what to do with. After this journal entry is recorded, the
trial balance is correct as of the start date.

For more information about how to record a journal entry by using the
General Journal Entry window, you can refer to Book IV, Chapter 1. If you
want to try this on your own without any further instruction from me,
choose the Company~Make Journal Entry command. When QuickBooks dis-
plays the General Journal Entries window, as shown in Figure 1-18, use the
Account, Debit, and Credit columns to record your journal entry.
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QNG/ Does the idea of making a journal entry terrify the heck out of you? If so, you

& may find yourself in a bit of a pickle. You need to become comfortable work-
ing with double-entry bookkeeping in order to set up QuickBooks at a time
other than at the beginning of the year. This means, unfortunately, that if
you are setting up QuickBooks sometime during the middle of the year, you
need to enter a general journal entry in order to fix the weirdness that the
EasyStep Interview creates. If you don’t know how double-entry bookkeep-
ing works — if debits and credits aren’t your friends — you probably need to
get somebody’s help. I suggest that you call your CPA or some other friend
who truly understands accounting. Get him or her to come over and enter
the last part of the trial balance for you by using the General Journal Entry
window. Note that this shouldn’t be a big project — just in case you decide
to call your CPA. If your CPA will come over to your office, and if you have
the trial balance ready for her, it should only take a few minutes to enter the
general journal entry necessary. Perhaps you can buy her a nice lunch and
that will settle the score.



Chapter 2: Loading the
Master File Lists

In This Chapter

v~ Setting up the Chart of Accounts List
v~ Setting up the Item List

1~ Setting up the Payroll Item List

1~ Setting up classes

v~ Setting up a Customer List

v~ Setting up the Vendor List

1~ Setting up your employees

v~ Setting up the Profile Lists

Setting up QuickBooks, as a practical matter, requires that you take two
steps: Run the EasyStep Interview described in Book II, Chapter 1, and
load the master file lists. The master file lists store information that you will
use and reuse. For example, one of the master file lists describes each of
your customers. And this master file of customer information includes the
customer’s name and address, contact information, account numbers, and
so on.

In this chapter, [ walk you through the process of adding information to each
of the master files — or lists, as QuickBooks calls them — that you’ll need to
fill (or mostly fill) before you begin using QuickBooks on a day-to-day basis.

One important note: You don’t need to completely fill your master files
before you start doing anything. If you enter your most important cus-
tomers into the customer master file, your most important vendors into the
vendor master file, and so forth, that amount of information may be all you
need to get started. With the master file information you entered through
the EasyStep Interview (as described in Book II, Chapter 1) and the addition
of a few more entries into key master files, you may be able to add every-
thing else on the fly. QuickBooks enables you to add entries to the various
master files as you work with windows and dialog boxes that reference
master file information.
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Setting Up the Chart of Accounts List

Figure 2-1:
The Chart of
Accounts
window.

The Chart of Accounts List is a list of accounts that you use to categorize
your income, expense, assets, liabilities, and owner’s equity amounts. If you
want to see a particular line item of financial data on a report, you need an
account for that line item. If you want to budget by a particular line item,
you need an account for that budget amount. If you want to report some bit
of financial information on your tax returns, you need an account to collect
that specific data.

Fortunately, the steps for creating new accounts are quite straightforward.
To set up a new account within your Chart of Accounts List, follow these
steps:

1. Choose the Lists=>Chart of Accounts command.

When you choose the Lists=>Chart of Accounts command, QuickBooks
displays the Chart of Accounts window shown in Figure 2-1.

2. Click the Account button at the bottom of the window.

QuickBooks displays the Account menu. One of the Account menu
options is New, which is the command that you use to add a new
account.
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Figure 2-2:
The New
Account
window.
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3. Add a new account by choosing the New command from the Account

menu.

QuickBooks displays the New Account dialog box, as shown in Figure 2-2.

4. Use the Type drop-down list box to identify the type of account that

you are

adding.

QuickBooks supplies the following account types: Bank, Accounts
Receivable, Other Current Assets, Fixed Assets, Other Assets, Accounts
Payable, Credit Card, Other Current Liability, Long Term Liability, Equity,
Income, Cost of Goods Sold, Expense, Other Income, and Other Expense.
If you have a question about which account type that your new account
fits into, you should review Book I, Chapter 1, which describes how finan-
cial statements work. These account groups essentially tell QuickBooks
in which area of a financial statement account data gets reported.

5. Use the Name box to give your new account a unique name.

The name that you give the account will appear on your financial
statements.
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0.

10.

If the account you’re adding is a subaccount underneath another parent
account, identify the parent account by selecting the Subaccount Of
check box.

After you select the Subaccount Of check box, name the parent account
by using the Subaccount Of drop-down list box.

. (Optional) Provide a description for the new account.

You don’t need to provide a description. Without a description,
QuickBooks can still use the account name on financial statements. If
you want a more descriptive label placed on accounting reports, how-
ever, use the Description box for this purpose.

. Provide other account information.

The New Account window shown in Figure 2-2 includes a Bank Acct. No.
box that lets you record the bank account number for a particular bank
account. Other account types may have similar boxes for storing related
account information. For example, the credit card account type version
of the New Account window lets you store the card number. If you do
have another box or two in which to store account information, go
ahead and use that, if necessary, to collect the bits and pieces of data
that you want to save.

. Identify the tax line on which the account information will be reported

by selecting a tax form and tax line from the Tax Line drop-down list
box.

You may not need to assign a particular account to a tax line if that
account data isn’t reported on the business’s tax return. For example,
cash account balances aren’t reported on a sole proprietor’s tax return.
So a bank account for a sole proprietor doesn’t have any required tax
line data. Cash account balances are recorded on a tax return of a corpo-
ration, however. So if you were adding a bank account for a corporation,
you would use the Tax Line drop-down list box to identify the tax line on
which the bank account information gets reported.

(Optional but dangerous) Consider recording an opening balance for
the account.

Typically, you should not use either the Opening Balance box or the As
Of box. These two boxes let you identify an opening account balance for
the account at the time you set up the account; this is something you’d
rarely do. However, if you know something I don’t, you can use these
two fields to set the starting balance for the account as of some date.
Note that my accounting professors taught me two things that would
suggest that this approach to setting account balances is crazy:

e Debits are supposed to equal credits. (If you're setting the opening
balance for an account as part of setting up the new account, you're
only recording half of the accounting transaction.)
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Figure 2-3:
The
completed
New
Account
window.
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¢ Entering the opening balance as part of setting up a new account
means no audit trail exists for the transaction. (Rather than having
an invoice associated with a transaction or a check, or even a gen-
eral journal entry, you're just setting balances on the fly. But hey,
maybe you know something [ don't. . .).

After you describe the new account that you want to set up (as shown in
Figure 2-3), you can click the OK button to save the new account to the Chart
of Accounts List. You can also click the Next button to save the account
information and then redisplay the New Account window so that you can
add another account.

If you look closely at Figure 2-3, you will note some boxes and buttons and
even a hyperlink that [ haven’t talked about. QuickBooks does supply other
fields for collecting account information. And, occasionally, QuickBooks also
provides clickable hyperlinks and buttons that you can use to do special
tasks associated with the particular type of account. For example, in the
case of a bank account, QuickBooks supplies an Order Checks command
button that you can click to start the process of ordering check forms for the
new account.
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Setting Up the Item List

And that’s almost everything you need to know about adding accounts. The
one other thing [ should mention is that the Account menu — this is the
menu of commands that QuickBooks displays when you click the Account
button available on the Chart of Accounts window — provides several other
useful commands for working with accounts. The menu provides a Delete
command that you use to delete the selected account (as long as you
haven’t already used the account). The menu provides an Edit button that
you can use to make any changes to the selected account information (by
using a window that looks very much like the New Account window shown
in Figure 2-2). The Account menu also provides other commands that you
can use to work with the Chart of Accounts List. Fortunately, most use self-
descriptive command names: Print List, Make Inactive, and so on.

The Activities button, which appears at the bottom of the Chart of Accounts
window, displays a menu of commands that you can use to write checks,
make deposits, enter credit card charges, transfer funds, make journal
entries, reconcile a bank account, and use a register. The Reports button
displays a menu of commands that you can use to print out reports that use
or show account information.

Setting Up the Item List

If you choose the ListstoItem List command, QuickBooks displays the Item
List window, as shown in Figure 2-4. The Item List window lists all of the
items that you've set up as part of running the EasyStep Interview and items
that you've added manually since running the EasyStep Interview.

[ don’t talk about how you add items to the Item List window here because
Book III, Chapter 3 details that. That chapter describes how you add items to
the Item List. Note that the Item List is very important! The Item List lets you
keep track of what you buy, hold, and sell to your customers.

Working with the Price Level List

The Price Level List lets you create price adjustments that you can use

on the fly as you invoice customers, issue credit memos, and so forth.
Because the Price Level List directly relates to how you work with and bill
for inventory items, I also describe how you work with the Price Level List
in Book IIl, Chapter 3. Rather than repeat information here that will be of
interest to only a few people and isn’t actually essential for getting started
with QuickBooks, I refer you instead to Chapter III, Book 3.
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Using Sales Tax Codes

The Sales Tax Codes List keeps a list of codes, or abbreviations, that you can
use to describe items as taxable or nontaxable. If you choose this command,
QuickBooks displays a window listing the existing sales tax codes. (Usually,
you’ll see two existing codes: Tax and Non.) To add a new sales tax code,
click the Sales Tax Code button, choose New, and describe the new sales tax.

Setting Up a Payroll Item List

The Payroll Item List identifies items that appear on employee payroll
check stubs. If you're using an outside payroll service bureau to handle
your payroll — and this is not a bad idea — you don’t even need to worry
about the Payroll Item List. If you're using either the QuickBooks Deluxe or
QuickBooks Premier Payroll Service, again, you don’t need to worry about
the Payroll Item List. (In either case, the QuickBooks folks will set up the
payroll items that you need to use for recording payroll.) And in the case of
the QuickBooks Premier Payroll Service, you don’t actually even need to
track payroll inside QuickBooks because the QuickBooks people will do it
at their office location on their computers.
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If you do need to add payroll items, follow these steps:

1. Choose the Lists=oPayroll Item List command.

QuickBooks displays the Payroll Iltem List window.

2. To add a new Payroll Item, click the Payroll Item button and then

choose New from the Payroll Item menu.

QuickBooks displays the Add New Payroll Item dialog box. You can
choose to set up a new payroll item either by using the Easy Set Up
Method or the Custom Set Up Method. If you want QuickBooks to help
you and you’re setting up a common payroll item, click the Easy Set Up
button and then Next, and simply follow the on-screen instructions.

If you want to perform a custom setup of a payroll item, click the Custom
Set Up button and then Next. QuickBooks then walks you through a multi-
ple screen interview — like the EasyStep Interview discussed in Book II,
Chapter 1 — that asks you about the payroll item that you need to set up.
For example, the first dialog box that QuickBooks displays asks you to
identify the type of payroll item that you want to create. You answer this
question by selecting one of the radio buttons, and then clicking Next.

. Name the payroll item.

After you identify the type of payroll item, you need to name it.
QuickBooks provides another version of the Add New Payroll ltem
dialog box that includes a field you fill in to give the new item a name.

. To finish the payroll item setup, click the Next button to move through

the remaining payroll items setup questions.

You'll need to identify the name of the government agency to which the
liability is paid, the taxpayer identification number that uniquely identi-
fies you to the taxing agency, the liability account that you use to track
the items, the tax form line that you use to report the item, the rules that
QuickBooks should use for calculating the item (such as whether the
item is subject to taxes or not), and a couple of other miscellaneous
pieces of data. After you supply all this information and click the Finish
button (which appears on the last version of the Add New Payroll ltem
dialog box), QuickBooks adds the new payroll item to the Payroll ltem
List.

The Payroll Item menu supplies commands that are useful for working
with the Payroll Item List. In addition to the commands that you use to
add an item to the list, the menu supplies commands for deleting payroll
items, renaming payroll items, making payroll items active, and printing
the list of payroll items.



Setting Up Classes

QuickBooks lets you use classes to segregate or track financial data in ways
that aren’t possible by using other bits of accounting information, such as
the account number, the customer, the sales rep, the item, and so forth. A
firm can use classes, for example, to segregate business units for product
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Figure 2-5:
The Class
List window.

lines or geographical territories.

To set up classes, follow these steps:

1. Choose the Lists>Class List command.

Setting Up Classes

101

QuickBooks displays the Class List window, as shown in Figure 2-5.

If you don’t see the Class List command, Choose Edit=>Preferences, click
the Accounting icon and then the Company Preferences tab, and check

the Use Class Tracking box.

2. To create a new class, click the Class button and choose New from the
Class menu.

QuickBooks displays the New Class window, as shown in Figure 2-6.
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Figure 2-6:
The New
Class
window.
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3.

To name the new class, enter a name or abbreviation into the Class
Name box.

Note that you will need to enter the class name whenever you record a
transaction that falls into the class. For this reason, you don’t want to
create lengthy or easy-to-mistype class names. Keep things short,
simple, and easy.

If the class that you're setting up is actually a subclass of a parent class,
select the Subclass Of check box and then select the parent class from
the Subclass Of drop-down list box.

After you describe the new class, you can click OK to save the class.
Alternatively, you can click Cancel to not save the class. Or, you can
click the Next button to save the class and redisplay the New Class
window.

If you don’t want the class to be used any more, you can select the Class
Is Inactive check box.

The Class menu, which appears when you click the Class button, also
supplies commands for editing the selected classes information, for
deleting the selected class, for making the selected class inactive, for
printing the list of classes, and several other useful commands as well.
These commands are all pretty straightforward to use. Go ahead and
experiment with them to find out how they work.
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Figure 2-7:
The
Customer:
Job List
window.

Setting Up a Customer List ’03

Up a Customer List

A Customer List keeps track of all your customers and your customer infor-
mation. For example, the Customer List keeps track of billing addresses and
shipping addresses for customers.

Follow these steps to add a customer to the Customer List:

1. Choose the Lists=>Customer Job List command.

QuickBooks displays the Customer:Job List window, as shown in Fig-
ure 2-7.

The Customer:Job button, besides letting you create new customers,
provides a menu of commands for editing customer information, delet-
ing customers, printing a customer list, and so forth.

2. To add a new customer, click the Customer:Job button and then
choose the New command.

QuickBooks displays the New Customer window, as shown in Figure 2-8.
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Figure 2-8:
The New
Customer
window.

3. Use the Customer Name box to give the customer a short name.

You don’t need to enter the customer’s full name into the Customer
Name box. That information can go into the Company Name box shown
on the Address Info tab. You just want some abbreviated version of the
customer name that you can use to refer to the customer within the
QuickBooks accounting system.

Ignore the Opening Balance and As Of boxes.

You don’t want to set the customer’s opening balance by using the
Opening Balance and As Of boxes. That’s not the right way to set your
new customer accounts receivable balance. If you do this, you are essen-
tially setting up the debit part of an entry without the corresponding
credit part. Later, you'll have to go in and enter crazy, wacky journal
entries in order to fix your incomplete bookkeeping.

Use the boxes of the Address Info tab to supply the company name,

including contact information, billing and shipping addresses, contact
name, contact phone number, fax number, and so on.

(I'm not going to tell you that you should enter somebody’s first name
into the First Name box, or that the phone number of your customer
goes into the box labeled Phone. I figure you don’t need that kind

of help.)
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Figure 2-9:
The
Additional
Info tab.
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6. Supply a bit of additional information about the customer.

If you click the Additional Info tab, shown in Figure 2-9, QuickBooks dis-
plays several other boxes that you can use to collect and store customer
information. For example, you can use the Type drop-down list box to
categorize a customer as fitting into a particular “customer type.” (I talk
about how to set up a Customer Type List later in this chapter.) Use the
Terms drop-down list box to identify the customer’s default payment
terms. Use the Rep drop-down list box to identify the customer’s default
sales rep. Finally, use the Preferred Send Method to select the default
method for transmitting the customer’s invoices and credit memos. You
can also record a resale number, specify a default price level, and even
click the Define Fields button to specify additional fields that you want
to collect and report for the customer.

The Price Level List and how it works is discussed in Book III, Chapter 3.

7. Click the Payment Info tab to display the set of boxes shown in Figure
2-10. You can record the customer’s account number, his or her credit
limit, and the preferred payment method.
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8. (Optional) Click the Job Info tab to describe the customer job.

The Job Info tab lets you describe information associated with a particu-
lar job being performed for a customer. You use the Job Info tab if you
not only set up a customer but also set up a job for that customer. See
Book IV, Chapter 5 for more information on how job costing works.

Setting Up the Vendor List

Just as you use a Customer List to keep records on all of your customers,
you use a Vendor List to keep records on your vendors. As is the case with a
Customer List, the Vendor List lets you collect and record information, such
as the vendor’s address, the contact person, and so on.

To add a vendor to your Vendor List, follow these steps:

1. Choose the Lists>Vendor List command.

When you do, QuickBooks displays the Vendor List window, as shown in
Figure 2-11.



Figure 2-11:
The Vendor
List window.
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2. To add a new vendor, click the Vendor button and choose New.
QuickBooks displays the New Vendor window, as shown in Figure 2-12.
3. Give the vendor a name in the Vendor Name box.

As is the case with the Customer:Job List, you use this name to refer to
the vendor within QuickBooks. For this reason, an abbreviation is fine.
You just want something easy to enter and easy to remember.

4. Ignore the Opening Balance and As Of fields.

Don’t do anything with the Opening Balance and As Of boxes. People
who don’t know better use those boxes to enter the opening balance
owed a vendor and the date the amount is owed. But this only creates
problems later. At some point in the future, this poor soul’s accountant
will need to find and correct this error.

5. Supply the vendor address information.

The Address Info tab supplies a bunch of easy-to-understand boxes that
you use to collect vendor name and address information. You enter, pre-
dictably, the vendor’s full name into the Company Name box.
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Figure 2-12:
The New
Vendor
window.
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You can click the Address Details button to display another dialog box
called the Edit Address Information dialog box, which lets you enter the
address in typical street address, city, state, and ZIP code format.

. Supply any additional information necessary.

If you click the Additional Info tab (shown in Figure 2-13), QuickBooks
displays a handful of other boxes that you can use to collect and store
information, such as your account number with the vendor, the vendor
type, the payment terms that you use when paying the vendor, your
credit limit, and the vendor’s tax ID number. The tax ID number is actu-
ally important if you later need to send this vendor a 1099 form to report
payments to the vendor.

A good guideline if you're paying a vendor for the first time is to get his
or her tax ID number. If somebody won’t give you his or her tax ID
number — thereby making it impossible for you to report payments that
you make to him — it’s probably a sign of something a bit amiss.

If you click the Vendor button, you'll note that the menu that QuickBooks
displays provides a whole bunch of other commands. Let me just men-
tion here that you can edit vendor information, delete vendors, print a
list of vendors, print 1099s for your vendors, and do one or two other
things with the menu commands that appear on the Vendor menu.



Figure 2-13:
The
Additional
Info tab of
the New
Vendor
window.
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Setting Up a Fived Assets List

If you choose the Lists=>Fixed Asset Item List command, QuickBooks displays
the Fixed Asset Item List window. You can use this window to see a list of the
fixed assets — furniture, equipment, machinery, vehicles, and so forth —
that you’ve purchased. Or at least you can after you've click the Item button,
chosen New from the menu, and filled in the New Item window for each fixed
asset. Figure 2-14 shows the New Item window you use to describe each fixed
asset.

Let me make a couple of comments about the QuickBooks Fixed Asset Item
List. The Fixed Asset List doesn’t really integrate with the QuickBooks gen-
eral ledger. You record the purchase or disposal of fixed assets using regular
old QuickBooks transactions. For example, you might record the purchase of
a particular fixed asset simply by entering a check in the usual fashion. And
you might record the disposal of a fixed asset by entering a general ledger
journal entry.
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Figure 2-14:
You
describe
each fixed
asset using
the New
Iltem
window.
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The Fixed Assets Item List, then, just acts as a standalone list that lets you
keep track of the fixed assets you purchased. Because the list is so standalone-
ish, I'm not going to spend much time talking about it in the books of this ref-
erence. Let me also say that your CPA probably — no surely — maintains a list
of your fixed assets because she needs that list in order to correctly include
depreciation on your tax return and in your financial statements (if you get
CPA help to prepare those). For this reason, some people — including me —
see the fixed asset item list as a little bit redundant.

Setting Up Vour Employees

If you choose the ListscoEmployee List command, QuickBooks displays
the Employee List window. You can use this window to see a list of the
employees — active or inactive — that you’ve identified to QuickBooks.
You can also click the Employee button and choose New to add employees
to the list.

Because I discuss how to add employees to the Employee List in Book III,
Chapter 5,  won’t repeat that information here.
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Setting Up Another Names List

If you choose the Lists=>Other Names List command, QuickBooks displays
the Other Names List window. The Other Names List identifies those busi-
nesses or individuals that you pay but don’t fall into one of these other stan-
dard categories: customers, vendors, and employees. For example, you may
use the Other Names List to identify government agencies that you pay.

To add a name to the Other Names List, click the Other Names button,
which appears at the bottom of the Other Names window. When QuickBooks
displays the Other Names menu, click New. The New Name window that
QuickBooks displays after you choose the New command provides boxes for
a name, identifying the entity, recording an address, and so on. [ don’t show
this window here because it’s just a simplified version of the window that
you use to identify and describe a customer, vendor, or employee.

Setting Up the Profile Lists

If you choose the Listse>Customer & Vendor Profile List command,
QuickBooks displays a submenu of commands that you use to create

some of the mini-lists that QuickBooks uses to ease your bookkeeping and
accounting. The Profile Lists include lists of sales reps, customer types,
vendor types, job types, payment terms, customer messages, payment meth-
ods, shipping methods, and vehicles.

Most of the Profile Lists are pretty darn simple to use. For example, if you
choose the Sales Rep List command, QuickBooks displays the Sales Rep List
window. You then click the Sales Rep button and choose New. QuickBooks
displays the New Sales Rep window, as shown in Figure 2-15. I bet you can
figure out how to use this window.

In case you're still experiencing a certain amount of accounting anxiety, let
me just point out that you enter the name of the sales representative into the
Sales Rep Name box. Then, throwing caution to the wind, you enter the sales
rep’s initials into the Sales Rep Initials box. When you click OK, QuickBooks
adds the sales rep to your Sales Rep List.

The other Profile Lists work in the same, simple, scaled-down fashion. You
choose the Profile List in the submenu, click the Profile List button, and
choose New. When QuickBooks displays a window, you use one or two boxes
to describe the new Profile List.

Just to prove to you that this really is as easy as I've said here, take a look at
the New Customer Message window shown in Figure 2-16 (accessible from
the Customer Message List). This is the window that you use to create a new
customer message. You can place customer messages at the bottom of cus-
tomer invoices and credit memos.
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If you want to track vehicle mileage within QuickBooks — and note that you
usually must track business vehicle mileage in order to claim business vehi-
cle expenses as a tax deduction — you can maintain a list of business vehi-
cles using the Vehicle List. This list then lets you easily track your business
vehicles — something you do by using the Company=>Enter Vehicle Mileage

command.
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Chapter 3: Fine-Tuning
OuickBooks

In This Chapter

v Accessing the Preferences settings

+~ Changing the accounting, checking, and finance charge rules

1~ Setting the desktop view, general, and integrated applications options
v Controlling jobs and estimates

v~ Setting up payroll and employees

v~ Setting purchases and vendors preferences

1 Changing reminders and reports and graphs settings

v Dealing with sales, customers, and sales tax

v~ Setting 1099 tax reporting rules

v Controlling time tracking

ou can specify how QuickBooks works for you by setting preferences.

In fact, just so you know, much of what you do when you run the
QuickBooks EasyStep Interview (when you set up QuickBooks) is provide
information that QuickBooks uses to set your preferences. For example, if
you indicate that you need to charge customers sales tax, the EasyStep
Interview describes how sales tax should work for your business by using
the sales tax preferences.

Because these preferences have so much effect on how QuickBooks works
and on how a particular user works with QuickBooks, I devote this chapter
to describing how you change the preferences. None of this material is par-
ticularly complicated, but because QuickBooks provides you with a rich set
of preferences options, I cover quite a bit of material. Don’t worry: You don’t
have to read this chapter from beginning to end. Simply use it as a reference
when you have a question about how to change the way QuickBooks works
in a particular area.



116 Accessing the Preferences Settings

Accessing the Preferences Settings

You can set preferences in two ways within QuickBooks:

4+ During the EasyStep Interview: You actually set all of the preferences,

or at least all of the starting preferences for QuickBooks, when you run
the EasyStep Interview. Most of the time, the preferences that the
EasyStep Interview sets are correct. The EasyStep Interview is very
smart about the way it asks questions and translates your answers into
preferences settings. But, if your business changes, or if you make a mis-
take during the setup interview, or if someone else in your office ran the
EasyStep Interview for you, you may still need to check and fiddle-faddle
with these preferences.

4+ By manually changing the preferences: You can manually change the

preferences by choosing the Edit=>Preferences command. QuickBooks
displays the Preferences dialog box, as shown in Figure 3-1. QuickBooks
groups categories of preferences. For example, QuickBooks groups all of
the accounting preferences into an accounting preference set. QuickBooks
groups all of the checking account preferences into a checking preference
set. If you look closely at Figure 3-1, you see that along the left edge of the
Preferences dialog box, QuickBooks displays a list of icons. The first icon
is Accounting. The second icon is Checking. To see the preferences within
one of these groups, you click that preference’s icon.
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One other item to note about the Preferences dialog box is that it supplies,
in general, two tabs of preferences for each preference set. Preferences that
are specific to an individual user appear on the My Preferences tab, shown
in Figure 3-1. Preferences that are tied to the company data file appear on

the Company Preferences tab, shown in Figure 3-2.



Figure 3-2:
The
Company
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Preferences
dialog box.
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Not every My Preferences tab gives you options for changing the way that
QuickBooks works. Sometimes a particular set of preferences gives personal
options; sometimes it doesn’t.

For example, the My Preferences tab of the Accounting set of preferences
provides no personalized options. In other words, you can’t tell QuickBooks
that a firm’s accounting works differently for a particular person. This makes
sense, right? Accounting needs to work the same way for every user within a
firm. However, with other preferences settings, QuickBooks may allow differ-
ent options for different users. You'll see this as I discuss the various sets of
preferences in the remainder of this chapter.

And now, I'm just going to walk you through a discussion of each of these
preferences sets. [ talk both about the My Preferences option (if available)
and the Company Preferences option.

Setting the Accounting Preferences

QuickBooks doesn’t give individual users personalized preferences for the
way that accounting works within QuickBooks. This makes sense, if you
think about it. Accounting for a business needs to work the same way for
Jane as it does for Joe and for Susan. However, you do have the option to set
company preferences for accounting. This makes sense, again, if you think
about it. Different companies need to run their accounting system in differ-
ent ways. Figure 3-3 shows the Company Preferences tab for the Accounting
Preferences set.
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Figure 3-3:
The
Company
Preferences
tab of the
Accounting
Preferences
set.
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Using account numbers

By default, QuickBooks lets you use names to identify accounts on the Chart
of Accounts or in the accounts list. For example, the account that you use to
track wages expense may be known as “wages.” However, you can check the
Use Account Numbers box to tell QuickBooks that you want to use account
numbers rather than account names for identifying accounts. Larger busi-
nesses and businesses with very lengthy lists of accounts often use account
numbers. Controlling both the ordering of accounts on a financial statement
and inserting new accounts into your Chart of Accounts is easier if you're
using numbers.

The Show Lowest Subaccount Only check box lets you tell QuickBooks that
it should display the lowest subaccount rather than the higher parent
account on financial statements. QuickBooks allows you to create subac-
counts, which are accounts within accounts (discussed further in Book II,
Chapter 2). You can also create sub-sub accounts, which are accounts within
subaccounts. You use subaccounts to more finely track assets, liabilities,
equity amounts, revenues, and expenses.

General accounting options

The Company Preferences tab provides the following five general accounting
check boxes as well as closing date settings. (These check boxes are proba-
bly self-explanatory to anybody who has done a bit of accounting with
QuickBooks, but for new QuickBooks users, I provide a brief description of
what each one does.)

4 Use Account Numbers: The Use Account Numbers check box, if selected,
gives you the ability to enter in an account number for a transaction. The
associated check box, Show Lowest Subaccount Only, tells QuickBooks
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to display only the name and account number of a subaccount (if you're
using one) instead of the full heritage of the account. If you use a lot of
levels of subaccounts, this option can really clean up views, making it
easier to tell what account you're looking at.

Require Accounts: The Require Accounts check box, if selected, tells
QuickBooks that you must specify an account for a transaction. This
makes sense. If you aren’t using account numbers to track the amounts
that flow into and out of the business, you aren’t really doing account-
ing. It would never make sense, in my humble opinion, to deselect the
Require Accounts check box.

Use Class Tracking: The Use Class Tracking check box lets you tell
QuickBooks that you want to use not only accounts to track your financial
information but also classes. Classes let you split account level informa-
tion in another way. This sounds complicated, but it’s really quite simple.
The account list, for example, lets you track revenue and expenses by cat-
egories of revenue and expense. You may track expenses by using cate-
gories such as wages, rent, and supplies. Classes, therefore, provide you
with a way to track this information in another dimension. For example,
you can split wages expense into those wages spent for two different loca-
tions of your business. A restaurateur with two restaurants may want to
do this.

Use Audit Trail: The Use Audit Trail check box, if selected, tells
QuickBooks to maintain a list of who makes what changes to transac-
tions. If you have more than one person changing the information in
QuickBooks — in other words, you have multiple users working with the
QuickBooks data file — you want to select the Use Audit Trail check box.
If you select the Use Audit Trail check box, QuickBooks slows down a
bit. For this degradation in performance, however, you get a good record
of who is doing what in QuickBooks. Accountants, by the way, love audit
trails. Audit trails enable someone such as your CPA to come in after the
fact and figure out why an account balance is what it is.

Automatically Assign General Journal Entry Number: This check box
tells QuickBooks to assign numbers to the general journal entries that
you enter by using the Make Journal Entry command. You want to leave
this check box selected. General journal entries, by the way, are typi-
cally entered by your CPA or your professional on-staff accountant.

Closing Date settings: The Closing Date box lets you identify a date
before which your QuickBooks data file can’t be changed. In other
words, if you set the closing date to December 31, 2004, you're telling
QuickBooks that you don’t want any changes made to the QuickBooks
data file before this date. This means that someone can’t modify a trans-
action that is dated before your closing date without getting a scary
warning message. It also means that someone can’t enter a transaction
by using a date before this closing date. You can also click the Set
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Password button to display a dialog box that lets you create a password,
which is required if someone wants to add an old transaction or modify
an old transaction.

Setting the Checking Preferences

If you display the Preferences dialog box and click the Checking icon,
QuickBooks displays either the My Preferences tab, shown in Figure 3-4,
or the Company Preferences tab, shown in Figure 3-5.
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The My Preferences tab for Checking Preferences lets you tell QuickBooks
which account it should suggest as a default account when you open particu-
lar types of windows within QuickBooks. For example, if you look closely at
Figure 3-4, you see the Open the Write Checks check box. This is the first
check box on the tab. To the right of the Open the Write Checks check box,
you see the Form With Account box. If you check the Open the Write Checks
check box, you can select an account from the Form With Account box. This
will tell QuickBooks to use or suggest the specified account every time you
open the Write Checks window.

The My Preferences tab also includes check boxes that you can use to spec-
ify the default account for the Pay Bills window, the Pay Sales Tax window,
and the Make Deposits window. If you have multiple checking accounts set
up, setting the default accounts using the My Preferences tab is a good idea.
Setting these preferences makes it less likely that you’ll erroneously write
checks on or pay bills from the wrong account.

The Company Preferences tab, as shown in Figure 3-5, provides check boxes
that you can use to describe how checks work within QuickBooks:

4+ Print Account Names On Voucher: This check box lets you indicate to
QuickBooks that it should print account names on the voucher portion
of the check.

4+ Change Check Date When Check Is Printed: Select this check box to tell
QuickBooks to use the current system date as the printed check date.

4+ Start with Payee Field on Check: Select this check box to tell QuickBooks
to place the insertion point, or text cursor, on the Payee field when you
open the Write Checks window.

4+ Warn about Duplicate Check Numbers: Selecting this check box tells
QuickBooks to alert you to duplicate check numbers. (You want to leave
this check box selected, obviously, so that you don’t use duplicate or
erroneous check numbers.)

4+ Autofill Payee Account Number in Check Memo: Select this check box to
tell QuickBooks to automatically fill in the payee account number when
you write a check. QuickBooks retrieves the account number for a payee
from the Vendor List or from the Other Names List.

4 Select Default Accounts To Use: These check boxes let you specify
which account QuickBooks suggests when you open the Create
Paychecks window or open the Pay Payroll Liabilities window.
Essentially, then, these boxes let you tell QuickBooks which checking
account you will use to write payroll checks and to pay payroll liabili-
ties, such as federal income tax withholding amounts.
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Changing the Desktop View

Figure 3-6:
The My
Preferences
tab for the
Desktop
View
Preferences.

Figure 3-6 shows the My Preferences tab of the Desktop View Preferences set.
The My Preferences tab provides View radio buttons — One Window and
Multiple Windows — that let you indicate whether QuickBooks should use
one window or multiple windows for displaying all of its information. The
Multiple Windows option looks like older versions of Microsoft Windows.
With multiple windows, an application such as QuickBooks displays multiple,
floating document windows within the application program window. If you
have a question about how this works, your best bet is to simply try both
view settings.
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The Navigators check box tells QuickBooks to display the Company
Navigator window when you open a company file. (The Company Navigator
window, shown in Figure 3-7, provides a sort of home base for your work in
QuickBooks.) This is the default setting. You will probably want to keep it.

The Desktop radio buttons (refer to Figure 3-6) let you specify whether and
when QuickBooks should save the current appearance, or view, of the desk-
top. You can select the Save When Closing Company radio button to tell
QuickBooks that it should save the view of the desktop when you close

a company. When you reopen a company, QuickBooks then reuses this
desktop view. You can also select the Save Current Desktop radio button

to tell QuickBooks to save the current view and then reuse this view when
QuickBooks later opens. If you don’t want to make changes to the default
desktop view, select the Don’t Save the Desktop radio button or the Keep
Previously Saved Desktop radio button.
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The Color Scheme box lets you pick a color set for the QuickBooks

program. The default color scheme is the Checkbook: Stone color scheme.
QuickBooks provides several other color schemes, including Denim Blue,
Desert Isle, Granite Gray, and so on. (If you are wild about color, you can
experiment with these other options.) Note that these are My Preferences
options, which means that they are personal to you. You can experiment
with the settings for color without having anyone else see that you are really
into Sea Stone or Summer Linen (two other color options).

The Windows Settings buttons let you access the Windows Display Properties
and Windows Sounds Properties settings. Typically, you would make changes
to Windows Display Properties and Windows Sounds Properties by using

the Control Panel tools. However, you can also make changes from within
QuickBooks by using these two buttons. (In actuality, when you click these
buttons, QuickBooks just starts the Control Panel tools.)

If you have questions about how the Windows Display Properties or Sounds
Properties work, refer to the Windows Help file or to a good book, such as
Windows XP For Dummies, by Andy Rathbone (Wiley Publishing, Inc.).
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No Company Preferences are available for the Desktop view. Desktop views
are purely personal. For this reason, you won'’t find any options or boxes or
buttons on a Company Preferences tab.

Setting Finance Charge Calculation Rules

The Finance Charge Preferences settings let you specify how QuickBooks
should calculate finance charges on overdue invoices to customers. No My
Preferences options are available for finance charges — only Company
Preferences. Because I describe how the Company Preferences tab for the
Finance Charge Preferences works in Book III, Chapter 1, I won’t repeat that
information here.

Setting General Preferences

Figure 3-8 shows the My Preferences tab of the General Preferences set.
This tab provides check boxes that you can select to tell QuickBooks to do
the following:

\\J

<+

+

<+

<+

To move the selection cursor from one field on the window to the next
field when you press Enter

To beep when you record a transaction

To automatically place a decimal point two characters from the right
end of the number

To warn you when you are editing an existing transaction

To warn you when you are deleting an existing transaction or some item
on a list

To bring back all of the one-time Help messages that it shows

To automatically recall the last transaction for a particular name
(customer, vendor, employee, and so forth) when you enter a new
transaction for the same name

Show ToolTips for clipped text

If you have specific questions about the My Preferences check boxes that
are available for the General Preferences options, click the Help button that
appears along the right edge of the Preferences dialog box. QuickBooks pro-
vides brief but useful descriptions of how the Preferences options work and
what they do.
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Figure 3-9 shows the Company Preferences tab for the General Preferences
set. The Time Format radio buttons let you specify whether QuickBooks
should show the minutes in an hour as a decimal value or as minutes. The
Time Format radio button descriptions include examples of how these two
approaches vary, so look closely at the dialog box if you have questions. The
Company Preferences tab includes a check box that lets you specify that
QuickBooks should always show years using four digits. And the Company
Preferences tab includes a check box that you can select to tell QuickBooks
that it should not update the name information for a particular customer,
vendor, employee, or other name when you are saving a new transaction for
that customer, vendor, employee, or other name.
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Controlling Integrated Applications

Figure 3-10:
The
Company
Preferences
tab of the
Integrated
Applications
Preferences
dialog box.

The Integrated Applications Preferences aren’t personal, so no options are
available on the My Preferences tab. However, the Company Preferences tab
for the Integrated Applications Preferences set does control and track other
applications, or computer programs, that open the QuickBooks company
data files. Figure 3-10 shows the Company Preferences tab for the Integrated
Applications Preferences set.

The Don’t Allow Any Applications to Access This Company File check box, if
selected, tells QuickBooks that it should not allow other applications to open
this company data file. The Notify the User Before Running Any Application
Whose Certificate Has Expired check box, if selected, tells QuickBooks that it
should not allow any program whose security certificate is out of date to open
the QuickBooks company data file without first notifying the user (that’s you).

The list box on the Company Preferences tab of the Integrated Applications
Preferences set shows the name of the applications that have previously
requested to open the QuickBooks company data file. You can remove an
application from this list by clicking the application and then the Remove
button. You can change the rules or properties that the QuickBooks program
applies to access this other application by clicking the application in the list
and then clicking the Properties button.
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Controlling How Jobs and Estimates Work

Because no personal preferences are available for Jobs & Estimates prefer-
ences, the My Preferences tab for this Preferences set shows no options.
However, you have several Company Preferences available regarding jobs



Figure 3-11:
The
Company
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Jobs &
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Preferences
dialog box.
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and estimates, as shown in Figure 3-11. The Pending text box lets you describe
what term or word should be used for jobs that have been submitted but
haven’t been accepted or rejected. The Awarded box lets you provide a term
or description that you want to use within QuickBooks to identify those jobs
that customers or clients have accepted. The default description of an
awarded job is, cleverly, awarded. The In Progress, Closed, and Not Awarded
boxes similarly let you describe what term you want to use for jobs that fit
into these categories.
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The Do You Create Estimates? radio buttons let you indicate to QuickBooks
whether you want to create job estimates for customers. You select the radio
button — Yes or No — that answers the question. The Do You Do Progress
Invoicing? buttons let you indicate whether you do progress billing for jobs.
The Warn About Duplicate Estimate Numbers check box, if selected, tells
QuickBooks to warn you about using duplicate estimate numbers. The Don’t
Print Items That Have Zero Amount check box, if selected, tells QuickBooks
not to print estimates that have zero balances.

Book IV, Chapter 5 talks more about setting up jobs and estimates. You may
want to refer there if you have questions about how project costing and job
costing work within QuickBooks.

Controlling How Payroll Works

The Payroll & Employees Preferences set includes only Company Preferences.
The Company Preferences tab is shown in Figure 3-12. The QuickBooks Payroll
Features radio buttons let you tell QuickBooks how you want to handle pay-
roll: using an outside payroll service such as Intuit Complete Payroll (select
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Figure 3-12:
The
Company
Preferences
tab of the
Payroll &
Employees
Preferences
dialog box.

Complete Payroll Customers in this case), using QuickBooks payroll features
(select the Full Payroll radio button), or that you're not using payroll at all
(select the No Payroll radio button).

Preferences Ask a help question % How Do 17
N My Preferences Company Preferences
Deskhop uickBooks Payroll Features Display Employee Lisk by:
Wiew @ Eull payrall (&) First Name () Last Mame
EEe ] Hel
) Mo payrall
[ Mark new emplayess as sales reps
Finance ) Complete Payroll Customers —————— Default
Charge Employee Defaults, .
% Paystub and Youcher Printing Workers Compensation Also See:
General Printing Preferences Set Preferences General
:i [[] Hide pay rate on Select Employees o Pay window. Tai 1033
Integrated Recall guartiy field on pavchecks,
Applications [C] print Employee List one per page.
ji‘ [ bisplay employee social security numbers in headers on reports,
Jobs & [1 Copy last paycheck earnings when creating new one.

Estimnates Report all payroll kaxes by Customer:Job, Service Item, and Class.

Iﬁzél Assign one class per (&) Entire paycheck () Earnings item

Payrall &
Employees |+

The Display Employee List By radio buttons let you specify whether the
employee list should be sorted by employees’ first names or last names.

The Mark New Employees as Sales Reps check box, if selected, does what
you’d expect: It marks new employees that you add to the employee list as
sales reps.

If you click the Employee Defaults button, QuickBooks displays a dialog box
that you can use to set employee payroll default information, such as deduc-
tions for taxes or health insurance.

The Printing check boxes — there are a bunch of these, as you can see from
the figure — let you tell QuickBooks what employee information QuickBooks
should print on the payroll check: employee address, company address, sick
pay information, vacation pay information, and pay period information. You
can figure out how this works, right? If you want some bit of information to
appear, you select the check box that references that information.

At the bottom of the Company Preferences tab of the Payroll & Employees
Preferences set, QuickBooks supplies several other check boxes and radio
buttons:

4+ Hide Pay Rate on Select Employees to Pay window: QuickBooks hides
the pay rate on the Select Employees to Pay window. Duh.

4+ Recall Quantity Field on Paychecks: QuickBooks recalls or reuses pay-
check quantity information from the last pay period’s paychecks. (The
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QuickBooks Help File suggests that you use this option when you have a
“fixed quantity that occurs from paycheck to paycheck.” The Help File
uses the example of tiered sales commissions where the commission
amount is set for each tier.)

4+ Print Employee List One Per Page: QuickBooks prints each employee’s
payroll information on a separate page when printing the Employee
List, making it easier to file payroll information with each employee
individually.

4+ Report All Payroll Taxes by Customer:Job, Service Item, and Class:
QuickBooks segregates payroll tax expense by these other attributes:

Customer:Job, Service Item, and Class.

4 The Assign One Class Per radio buttons (Entire Paycheck and Earnings
Item): Enables you to break down wages expense into classes more finely.
For example, you can indicate that you want to use a different class for
each item that appears on an employee’s paycheck.

Controlling the Purchasing & Vendors Preferences

The Purchases & Vendors Preferences set doesn’t provide personal prefer-
ences on the My Preferences tab. The Purchasers & Vendors Preferences set
does, however, provide several Company Preferences, as shown in Figure 3-13.
The Purchase Orders and Inventory check boxes, for example, let you tell
QuickBooks whether you want to use purchase orders. If you do, select the
Inventory and Purchase Orders Are Active check box. The two other check
boxes, if selected, tell QuickBooks that you want to be warned if you attempt
to sell inventory that you don’t have in stock or if you attempt to use a dupli-
cate purchase order number.

Figure 3-13:
The
Company
Preferences
tab of the
Purchases
& Vendors
Preferences
set.
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Telling

Figure 3-14:
The
Company
Preferences
tab of the
Reminders
Preferences
set.

The Entering Bills boxes let you specify when bills are due and whether you
want QuickBooks to warn you about duplicate bill numbers from the same
vendor. The Paying Bills boxes let you tell QuickBooks that it should auto-
matically use purchase discounts and credit memos when you are paying
bills and also let you specify what account QuickBooks should use for track-
ing discounts that you take.

OuickBooks How Reminders Should Work

The My Preferences tab of the Reminders Preferences set consists of just
one check box: You can use it to tell QuickBooks that you want to see the
Reminders list when you open a company file. Because the My Preferences
tab includes only a single check box, [ don’t show it here as a figure.

The Company Preferences tab, as shown in Figure 3-14, provides a bunch of
radio buttons that you can use to specify how QuickBooks should remind you
of accounting and bookkeeping tasks that you need to complete: Checks to
Print, Paychecks to Print, Invoices/Credit Memos to Print, Overdue Invoices,
Sales Receipts to Print, Sales Orders to Print, Inventory to Reorder, Assembly
Items to Build, Bills to Pay, Memorized Transactions Due, Money to Deposit,
Purchase Orders to Print, and To Do Notes.

Preferences sk 5 help question ¥ How Do 17
*i ~ MMy Preferences Company Preferences
&
Show  Show  Don't
Inte_gratsd Surnmary  Lisk  Remind Me Remind Me e
@pplications
. Checks to Print ® (] () |5 |days before check date,
Jobs & Paychecks to Print ® (] () |5 | days before paycheck date,
Estimates %g‘ﬁ;?mmdlt Memos ® [ 4] (|5 |days before invoice date.
r“:él Overdue Invoices ® [ 4] O |5 daysafter due date. Also See:
Payral & Zales ReceiptstoPrint & O ®© General
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Purchases
& Vendors
Bills to Pay ® O (|10 days before due date.
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Mongey to Deposit ® (@] (5]
j‘.l Purchase Orders to Print () (@] (5]
Reports & To Do Notes ® ® o]
LSaphs v

For each of these accounting or bookkeeping tasks, you indicate whether you
want to see a reminder for the item in the Summary list that appears in the
QuickBooks Company Preferences Reminders list. You can also choose to
actually see the List of Tasks — such as the list of Checks to Print — or you
can indicate that you don’t want to be reminded of some particular category
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of accounting or bookkeeping. For some of the reminder notes, you need to
indicate how many work days in advance you want to be reminded. For exam-
ple, if you indicate that you want to be reminded to print checks, you must
indicate how many days before the check date that you want the reminder to
appear. You do this by entering a numeral in one of the Remind Me text boxes.

Specifying Reports & Graphs Preferences

Figure 3-15:
The My
Preferences
tab of the
Reports &
Graphs
Preferences
set.

The My Preferences tab of the Reports & Graphs Preferences set is shown

in Figure 3-15. This tab provides radio buttons that you can use to indicate
how QuickBooks should refresh reports when the information upon which
the report is based changes. The default refresh option is Prompt Me to
Refresh. If you set refreshing to Prompt Me to Refresh, when QuickBooks
needs to update a report for changes in the information, it prompts you via a
message box. You can also select the Refresh Automatically radio button to
have QuickBooks automatically refresh a report whenever the data changes.
You don’t want to refresh automatically, however, if you have a large data
set and many reports. Refreshing a report can be rather time-consuming.
Refreshing many reports based on a large data set takes a long time. You can
also select the Don’t Refresh radio button if you don’t want or don’t need to
be reminded about refreshing a report.
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i Reports and Graphs Graphs Only
Jobs & ‘When a report o a graph needs to [ braw graphs in 2D (Faster)
Estimates be refreshed: [Juse patterns
Iﬁl (®) Prampt me bo refresh Blso See:

) Refresh auromatically

E‘:;L?Lzs ) Don't refresh il
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The Graphs Only check boxes let you control the way QuickBooks graphs
report information. You can select the Draw Graphs in 2D check box to tell
QuickBooks to draw two-dimensional rather than three-dimensional graphs.
(QuickBooks draws two-dimensional graphs much quicker, so you may want
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Figure 3-16:
The
Company
Preferences
tab of the
Reports &
Graphs
Preferences
set.

to use two-dimensional graphs.) Note also that two-dimensional graphs are
visually more precise than three-dimensional graphs. You can also select the
Use Patterns check box to tell QuickBooks to draw a graph that uses cross-
hatching patterns rather than colors for the different pieces of a chart.

The Prompt Me to Modify Report Options Before Opening a Report check
box, if selected, tells QuickBooks to open the Modify Report window when-
ever you create a report. You can use the Modify Report window to control
what information is included in a report (such as what date range the report
is based on) and other reporting options as well. If the Prompt Me to Modify
Report Options Before Opening a Report check box isn’t selected,
QuickBooks creates a report by using the default reporting options.

For a complete discussion of the Modify Reports window, refer to the discus-
sion in Book IV, Chapter 2.

Figure 3-16 shows the Company Preferences tab for the Reports & Graphs
Preferences set. This Company Preferences tab provides several useful
options for default report generation rules. The Summary Reports Basis
radio buttons, for example, let you indicate whether the default accounting
method used to create a report should be accrual-basis accounting or cash-
basis accounting. The Aging Reports radio buttons let you specify how the
age of an invoice or bill should be calculated: from the due date or from the
transaction date. The Reports-Show Accounts By Option radio buttons let
you specify how account information appears on reports: account name
only, description only, or both name and description.

Preferences Ask a help question = How Do 1?7
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Figure 3-17:
The Header/
Footer of
the Report
Format
Preferences
dialog box.
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Two other Company Preference options are especially noteworthy. The
Classify Cash button displays a dialog box that lets you indicate whether
changes in a particular account balance should appear under the operating,
investing, or financing portion of the Statement of Cash Flows. If you're not
a professional accountant, you will want to get your CPA’s help in making
changes to this area of QuickBooks. The rules for presenting a Statement of
Cash Flows are quite involved.

The Format button displays the Report Format Preferences dialog box, which
lets you customize the report header and footer information. Figure 3-17
shows the Header/Footer tab for the Report Format Preferences dialog box.
The Show Header Information check boxes let you specify what information
should appear in the report header area. The Show Footer Information check
boxes let you make the same specifications for the report footer. The Page
Layout Alignment box lets you specify how information should be aligned on
the report page.

Report Format Preferences Ask & help question ¥ How Do 1?7

Header/Footer Fonts & Mumbers

Shaow Header Information Page Layout

Fine Lake Porcelain Alignment
Standard w

Report Title

Subtitle Time  Company
Date Title
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Time Prepared
Report Basis

Print header on pages after first page

show Footer Information

Page Mumber Page 1 v Extra Line Page

Extra Footer Line

Print Focter on first page

[ OF ] [ Cancel ] [ Help ]

Figure 3-18 shows the Fonts & Numbers tab of the Report Format Preferences
dialog box. This dialog box lets you specify what font and formatting you
want to use for bits of report information. For example, if you want to change
the font for the reports column labels, click the Column Labels entry in the
Change Font For list box. Then click the Change Font button. QuickBooks dis-
plays a Font Formatting dialog box that lets you specify the font, font style,
point size, and other special effects.

If you're confused about changing report formatting, refer to the discussion
in Book IV, Chapter 2. It talks about all this stuff.
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Figure 3-18:
The Fonts &
Numbers
tab of the
Report
Format
Preferences
dialog box.
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Setting Sales & Customers Preferences

You can’t set personalized preferences for dealing with sales and custom-
ers. You can, however, set company preferences for sales and customers.
Figure 3-19 shows the Company Preferences tab for the Sales & Customers
Preferences set. The Usual Shipping Method box lets you specify the default
shipping method. The Default Markup Percentage box lets you specify a
default retail markup percentage to use in your pricing (though you should
double-check that it’s showing up properly on estimates before you count on
it). The Usual FOB box lets you set the default FOB, or Free On Board, point.

Figure 3-19:
The
Company
Preferences
tab of the
Sales &
Customers
Preferences
set.

Also See:

o

@n‘
2
B3
Z

Miscellanens
Sales & [ Track reimbursed expenses as incoms

Customers

General

Default Markup Percentage | g, e,

Choose template for packing slip: Time: Tracking

n
o
@
b
"
o
S

~
Jobs and
Estimates

&

Receive Payments

@
8
]
2
a
g
E|
S

) ) Purchases and
Automatically apply Autamatically Yendors

Use Undeposited Funds as a
..!/ .
payments calculste payments

default deposit ko account

=

Service
Connection | s

Preferences #sk.a help question ¥ How Do 17
4@ ~ My Preferences Company Preferences
Remnders Sales F?rn'!s Price Levels
Usual Shipping || w Use price levels
|
Usual FOB Round all sales prices up to
=R [ the next whale dollar for
Reports & Warn about duplicate inveice numbers fixed % price levels

Finance Charges




Specifying How Sales Are Taxed ’35

The check boxes at the bottom of the Company Preferences tab of the Sales &
Customers Preferences set let you indicate that you want to track reimbursed
expenses as income, automatically apply payments, warn about duplicate
invoice numbers, and use price levels.

Price levels are discussed in more detail in Book IIl, Chapter 3.

Specifying How Sales Are Taxed

Figure 3-20:
The
Company
Preferences
tab of the
Sales Tax
Preferences
set.

Although no personal preferences are available for sales tax, company prefer-
ences do exist. Figure 3-20 shows the Company Preferences tab for the Sales
Tax Preferences set. The Do You Charge Sales Tax? radio buttons, which
appear near the top of the tab, control whether you can charge sales tax
within QuickBooks. You select the radio button — Yes or No — that answers
the question.
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The Owe Sales Tax radio buttons let you indicate when the taxing authority
says you owe sales tax: as of the invoice date (which means the taxing
authority requires accrual-basis accounting) or upon receipt of payment
(which means the taxing authority allows cash-basis accounting).

The Default Sales Tax Codes boxes let you define what code QuickBooks
should use to identify taxable and non-taxable sales. By default, QuickBooks
uses the clever “tax” code for taxable sales and the equally clever “non”
code for non-taxable sales. However, you can select the Add New entry from
the Taxable drop-down list box or the Non-Taxable drop-down list box and
use the dialog box that QuickBooks displays to create your own taxable and
non-taxable codes.

Book I
Chapter 3

s)oogyaINY
Buiun]-aul4



73 7 Setting the Send Forms Preferences

The Pay Sales Tax radio buttons (Monthly, Quarterly, and Annually) let you
tell QuickBooks how frequently you must remit sales tax amounts. You select
the radio button that corresponds to your sales tax payment frequency.

The Set Up Sales Tax Items boxes let you set up an item for the sales tax that
you will need to charge on invoices. You can also indicate the default, or
most common, sales tax item that you’ll want to include by entering this
sales tax item name into the Most Common Sales Tax box. To add the sales
tax item by using the Most Common Sales Tax box, select the Add New entry
from the drop-down list box and complete the dialog box that QuickBooks
displays. The New Item dialog box lets you name the sales tax item and iden-
tify the sales tax rate. The Mark Taxable Amounts with “T” When Printing
check box, if selected, tells QuickBooks to flag taxable amounts on an
invoice with the code “T.”

Book II, Chapter 2 describes how to set up sales tax items.

Setting the Send Forms Preferences

Figure 3-21:
The
Company
Preferences
tab of the
Send Forms
Preferences
set.

The Company Preferences tab for the Send Forms Preferences set is shown
in Figure 3-21. (Note that no personal preferences are available for these
Send Forms Preferences.) The Company Preferences tab lets you specify the
default message text, message subject, and salutation for e-mailed invoices,
estimates, and statements. To use the Company Preferences tab, you use the
Change Default For drop-down list box to specify which type of message text
that you want to change. Then you use the other boxes on the Company
Preferences tab to make whatever change you want to the default message.
To change the message subject, for example, you replace the contents of the
Subject text box.
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Fine-Tuning the Service Connection

Figure 3-22:
The
Company
Preferences
tab of the
Service
Connection
Preferences
set.

Although no personal preferences exist for the Service Connection
Preferences set, several company preferences options are available, as
shown in Figure 3-22. You can, for example, indicate whether QuickBooks
should automatically connect to QuickBooks Services without asking for a
password, or whether it should always ask for a password. To make this
decision, you simply select the appropriate radio button. You can also select
the Allow Background Downloading of Service Messages check box to tell
QuickBooks that background collection of messages is okay. (If you select
this check box, QuickBooks downloads new messages during idle times so
that it doesn’t slow down your other Internet activities.)
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Controlling Spell Checking

No company preferences exist for the Spelling Preferences, but the

My Preferences tab (shown in Figure 3-23) provides several options for con-
trolling how spell checking works for you within QuickBooks. You can select
the Always Check Spelling Before Printing, Saving, or Sending Supported
Forms check box, for example, if you want to have automatic spell checking
performed before you actually distribute a document to an outside party,
such as a customer or vendor. You can also use the Ignore Words With check
boxes to tell QuickBooks not to spell check words or phrases that aren’t
going to appear correctly spelled because they aren’t real words. For exam-
ple, you can select the Internet Addresses check box to tell QuickBooks that
it shouldn’t check Internet URL addresses. And you can select the All UPPER-
CASE Letters check box to tell QuickBooks that it shouldn’t attempt to spell
check words that are acronyms and abbreviations, such as OK and ASAP.
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Figure 3-23:
The
Company
Preferences
tab of the
Spelling
Preferences
set.

Preferences Ask a help question = How Do I?
@ a My Preferences Company Preferences
Sales & Cancel
Customers @lways check spelling before printing, saving, or sending supported forms:
Tgniore wirds with:
Sales Tax Default
[ Internet Addresses (e.g, "httpe ) vy quickbooks,com™
M Mumbers (e.g. "12345" and "QB2001") Also See:
[ capitalized first letter (g.g. “Inkwit"y
Send Forms General

[T &l UPPERCASE letters (e.0. "ASAP")
[ Mixed case (e.q. "QuickBooks")

=

Service
Connection

wn

E=}
ol
=

a

Tax: 1099

Controlling How 1099 Tax Reporting Works

Figure 3-24:
The
Company
Preferences
tab of the
Tax: 1099
Preferences
set.

No personal preferences exist for 1099 tax reporting. Company preferences,
however, exist as indicated by the Company Preferences tab, shown in
Figure 3-24. The Company Preferences tab lets you tell QuickBooks when you
are required to file 1099-MISC forms. The Company Preferences tab also lets
you identify the threshold amounts for the different types of miscellaneous
income that you can report. For example, the current threshold amounts for
rent that is paid is $600. Therefore, the threshold amount shown for Box 1:
Rents on the 1099 appears as $600. You can change this amount by editing
the value shown in the Threshold box. Note that different types of 1099 mis-
cellaneous income have different reporting thresholds. For example, if you
look down to Box 9: Direct Sales, you see that the reporting threshold is
$5,000. Confer with your tax advisor if you have questions about these
amounts or visit the IRS Web site at www.irs.gov.
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Setting Time Tracking Preferences

Figure 3-25:
The
Company
Preferences
tab of the
Time
Tracking
Preferences
set.

Figure 3-25 shows the Company Preferences tab for the Time Tracking
Preferences set. To turn on time tracking within QuickBooks, select Do You
Track Time? by selecting the Yes radio button. You can also use the First Day
of Work Week box to indicate which day should appear first on the Weekly
Time Sheet window. (This is what you will use to describe billable time for
the week.) Book IIl, Chapter 1 talks about billing for time in more detail. You
may want to refer there if you have questions about tracking time and billing
for that time.
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Chapter 1: Invoicing Customers

In This Chapter

v+ Choosing an invoice form

1 Customizing an invoice form
v Invoicing a customer

v~ Billing for time

+ Recording a sales receipt

+ Recording credit memos

+ Receiving customer payments

1~ Assessing finance charges

0 uickBooks provides several tools for invoicing your customers. This
wwe~ Cchapter describes these tools as well as a handful of related tools for
recording customer payments and for issuing credit memos.

If you've already been invoicing customers using some manual method —
perhaps you’ve been preparing invoices with a word processor — you’ll find
QuickBooks to be a godsend. Not only does QuickBooks make invoicing and
related tasks easier, but it also collects invoice information, recording this
information into the QuickBooks data file. Happily, this means that you get
the extra benefit of recording accounting transactions simply by using
QuickBooks for invoicing.

Choosing an Invoice Form

QuickBooks allows you to use an invoice form that matches the require-
ments of your business. For example, businesses that sell products need

an invoice that includes descriptions of the product items that are sold.
Businesses that sell services — such as a law firm or an architectural firm —
need an invoice that appropriately describes these services. Businesses that
sell both products and services need a blend of attributes.

Fortunately, QuickBooks lets you choose the invoice form that best matches
your business. To choose an invoice form, display the Create Invoices window
by choosing the Customers=>Create Invoices command. When QuickBooks
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displays the Create Invoices window, use the Form Template drop-down list
box, which appears in the top-right portion of the window, to choose the
invoice form that you want. This drop-down list box provides a choice for

a product invoice, a service invoice, or a professional invoice. Choose the
invoice form template that seems to best match your business. QuickBooks
redraws the Create Invoices window when you choose a new invoice form
template. This means that you can see what an invoice form template looks
like simply by choosing an option from the Form Template drop-down list box.

Customizing an Invoice Form
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Figure 1-1:
The
Customize
Template
dialog box.

Although you can choose a predefined invoice form template for your
invoices, QuickBooks gives you more flexibility than that. You can also cus-
tomize an existing form template to create an invoice that looks just the way
you want. To do this, you can start with one of the basic invoice form tem-
plates and then customize it so that it perfectly matches your requirements.

Customizing a predefined form template

To customize a predefined invoice form template, display the Create Invoices
window. You can do this by choosing the Customers=>Create Invoices com-
mand. Next, click the Customize button. QuickBooks displays the Customize
Template dialog box, shown in Figure 1-1.

The very first time you choose the Create Invoices command, QuickBooks
displays a message box asking if you'd like a tutorial about how to enter
sales in QuickBooks. I'm going to describe here what you need to know, but
if you have the time and feel a little stressed about QuickBooks, it’ll probably
help to view the tutorial. Hearing the same information more than one time
often increases retention.

Customize Template

Select an action:

Edit the selected
Edit template.

Create a new
template based on
the selected
template.

Go ko the template
Go to List list For advanced
options,

Select a template:

Ankuit Packing Sl

ct Invoice
dnkuit Professional Invoice
dnkuit Service Invoice

Cancel ] [




Figure 1-2:
The
Customize
Invoice
dialog box.
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To customize an existing invoice form template, first select the template that
you want to change from the Select a Template list box. For example, if you
want to customize the Intuit Professional Invoice form template, you select it
from the Select a Template list box. After you select the form template, click
the Edit button. QuickBooks displays the Customize Invoice dialog box,
shown in Figure 1-2. This window lets you make two simple changes to the
form template. The Company tab, shown in Figure 1-2, lets you indicate what
information should appear on the form template. You select the check box
that corresponds to the bit of information. If you want the company name to
appear on the invoice form — this means you aren’t using letterhead or
preprinted invoice forms — select the Print Company Name check box. You
can also use the Company tab to indicate whether to print the company
address or to add the company logo.

Customize Invoice
Template Name
Company Format
Company Information
Contact Information

Print Company Address

Logo

[ Use logo

a Template is

inactive

The Format tab of the Customize Invoice window lets you change the font
used for the pieces of information shown on the invoices. Figure 1-3 shows
the Format tab. To change the formatting of a bit of text, first select the text
from the Change Font For list box. After you do this, click the Change button.
QuickBooks displays the Example dialog box, shown in Figure 1-4. Use its
Font, Font Style, and Size boxes to specify what the selected bit of text
should look like. The Example dialog box includes a Sample box that shows
how your font changes look. When you complete your specification of the
font, click OK.
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Customize Invoice
Template Name
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P To see a list of all of QuickBooks’ form templates, choose the Listsw>Templates

command. You can also create new form templates and customize existing

form templates by clicking the Templates button on the Templates List
window and choosing the appropriate command.

Creating a new invoice form template

If you can’t create invoices that look exactly the way you want by modifying
one of the existing predefined form templates, you can also create your own
form template from scratch. You can do this because QuickBooks gives you
much more flexibility in designing an invoice form template when you start

from scratch. To create a new invoice form template, follow these steps:



Figure 1-5:
The Header
tab of the
Customize
Invoice
window.
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1. To indicate that you want to create a new invoice form template, dis-
play the Create Invoices window by choosing Customersc>Create

Invoices.

2. Click Customize.

QuickBooks displays the Customize Template dialog box (refer to Fig-

ure 1-1).

3. Select one of the existing form templates.

You will want to select an existing form template that looks closest to
the form template that you want to create.

4. After you select the form template you want to use in the Select a
Template list box, click the New button.

QuickBooks displays the Customize Invoice dialog box shown in Fig-
ure 1-5. This Customize Invoice dialog box resembles the windows
shown in Figures 1-2 and 1-3. However, this expanded version of the
Customize Invoice dialog box gives you many more options for design-
ing the invoice form template.

Customize Invoice

Template Name |

Header Fields

Columns Footet Conmpany. Format Printer
Cancel

Screen  Print

Default Title
Date
Invoice Humber

gl To

IEEEE

Ship To

IEEEE

e

Tie Diefault
Invoice
Date:
Invoice # Layout Designer

Bill To

Ship T

Template is
inackive

5. Choose which bits of header information appear by selecting or dese-
lecting the check boxes on the Header tab.

The Header tab of the Customize Invoice dialog box lets you specify
what information goes on the top portion of the Create Invoices window
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and in the top area of an actual printed invoice form. This information is
called the header and provides the invoice number, the invoice date, and
the billing and shipping information. You can also choose how informa-
tion is labeled by filling in or editing the contents of the text boxes. For
example, the Default Title check boxes let you specify whether the form
title should appear on the screen version of the invoice (this would be
inside the Create Invoices window) and on the printed version of the
invoice. The Default Title text box lets you specify what the form title
should be. In a similar fashion, the Date check boxes let you specify
whether the date should appear on the screen and print versions of the
invoice and what label should be used to describe the invoice date.
Figure 1-5, as you can see, uses the clever descriptive text Date for this
invoice date information.

If you don’t need a particular piece of information on an invoice, leave
the Screen and Print check boxes for that bit of data deselected. This
tells QuickBooks that it should not include that piece of header informa-
tion on the window or print version of the invoice form.

Describe the invoice fields, as shown in Figure 1-6.

The Fields tab allows you to specify what information appears in the
middle of the Create Invoices window and the invoice form. Fields infor-
mation is not header information; also, it is not information about the
specific item for which you are billing. Fields information includes bits
of data such as the purchase order number, the payment term, the due
date, and so forth.

The Fields tab works like the Header tab. If you want some bit of infor-
mation to appear on the Create Invoices window and on the actual
printed invoice, you need to select the Screen check box and Print check
box for that bit of information. For example, to indicate that payment
term information should appear on both the screen and printed versions
of the invoice, you select both the Terms Screen and the Print check
boxes. The Fields tab, like the Header tab, also includes Title text boxes
that let you specify how you want these bits of data described on the
Create Invoices window and on the actual printed invoice form. You can
change the descriptive text that QuickBooks uses by editing the content
of these text boxes. For example, to change the descriptive text used to
describe payment terms from Terms to Payment Terms, you simply edit
the contents of the Terms Title text box.



Figure 1-6:
The Fields
tab of the
Customize
Invoice
dialog box.

Customizing an Invoice Form '49

Customize Invoice
Header Fields Colurnns Footet Company Format Printer
Caniel

SEr.'x.a.x\an Prink  Title: Default

P.Q. No. P.0. Mumber

Terms Terms Layout Designer

Due Date: O [0 |buepate

REF Rep

Account Mumber O Account #

Ship Date Ship

Ship ¥ia Wia

FoB F.0.B. 0 Template is

Project/Job Project inactive

Cther E H

\\3

7.

Specify the columns of invoice information, as shown in Figure 1-7.

The columns portion of an invoice describes in detail the items for which
an invoice bills. For example, product invoice columns describe the spe-
cific products, including price and quantity; they also describe the items
being invoiced. A service invoice’s columns describe the specific serv-
ices being billed. As you may guess from looking closely at Figure 1-7, the
Columns tab of the Customize Invoice dialog box looks like the Header
and Fields tabs. You use the Screen and Print check boxes to indicate
whether a particular piece of column-level information should appear as
a column on the Create Invoices window or on the actual created invoice.
Similarly, you use the Title text boxes to provide the descriptive labels
that QuickBooks uses on the Create Invoices window and on the printed
invoice form. The only unusual option shown on the Columns tab is the
Order text boxes (see Figure 1-7). The Order boxes let you indicate in
what order (from left to right) the column should appear. If the item
number or code should appear in the first column on the left, for exam-
ple, you enter the value 1 into the Item Order box.

The Header, Fields, and Columns tabs let you make changes to your
invoice forms, but don’t get too tense about making perfect changes the
first time. You can easily see exactly how your changes look simply by
clicking OK and then carefully reviewing the new version of the Create
Invoices window. If you realize that you’ve made an error — perhaps
you’ve used the wrong bit of descriptive text or you’ve incorrectly
ordered the columns — you can customize your invoice again and
thereby fix your earlier mistakes.
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Figure 1-7:
The
Columns tab
of the
Customize
Invoice
dialog box.
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Some versions of QuickBooks include a tab for specifying how the
columns on a progress billing invoice look and work. This tab, called
the Prog Cols tab, looks and works very much like the Columns tab.

Describe the invoice footer, as shown in Figure 1-8.

The Footer tab of the Customize Invoice dialog box lets you specify what
information appears on the Create Invoices window beneath the columns
area and on the actual printed invoice beneath the columns area. As
Figure 1-8 indicates, the footer information includes a customer message,
the invoice total, payments and credit information, a balance due field,
and, optionally, a longer text box. You work with the Footer tab in the
same manner as you work with other tabs. If you want some bit of infor-
mation to appear, select the Screen check box and the Print check box. To
change the bit of text that QuickBooks uses, edit the contents of the Title
text box.

Specify the company information.

The Company tab of the Customize Invoice dialog box lets you specify
whether bits of information about your company appear on the invoice.
This is the same tab I show earlier in the chapter in Figure 1-2, so  won’t
show it again. When you customize one of the predefined invoice form
templates (described earlier in the chapter), you use check boxes to
select what bits of information should appear on the form and whether
a logo should appear on the form.
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Customize Invoice
Template Narne
Header Fields Colurnns Footer Company Format Printer
Screen Print  Tite
Message Custamer Message =
Subtatal [ |5ubtotal
Sales Tax O Sales Tax
Tatal Tatal
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Balance Due ] Balance Due
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Job Total Balance [} Job Total Balance
Template is
Fea o 2o
Figure 1-8:
The Footer
tab of the
Customize
Invoice
dialog box.

10. Specify text formatting.

The Format tab of the Customize Invoice window (refer to Figure 1-3)
lets you specify what font you want to use for invoice text. To specify
the font formatting for a particular piece of text, display the Format tab,
select the bit of text that you want to format from the Change Font For
list box and then click the Change button. When QuickBooks displays
the Example dialog box (refer to Figure 1-4), use its boxes to make your
choices. Click OK to close the Example box.

11. Enter the name that you want to use for your new invoice template
into the Template Name text box.

You probably want to use something short and sweet. This name needs
to easily fit into the Form Template drop-down list box, which is avail-
able on the Create Invoices window.

12. To save your newly designed invoice form template, click OK.
Alternatively, if you don’t like what you've created and just want to dis-
card your work, click the Cancel button.

A\

You can return all of the customize invoice settings to their default con-
dition by clicking the Default button. When you do this, however, you
remove any changes or customizations that you've made.
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Working with the Layout Designer tool

If you click the Layout Designer button, which is available in the Customize
Invoice dialog box, QuickBooks displays the Layout Designer window, as
shown in Figure 1-9. The Layout Designer window lets you move invoice
information around on the actual printed invoice. Your best bet for learning
to work with the Layout Designer tool is to experiment with it. My recom-
mendation is that you create an example invoice form template — something
you don'’t really care about — and then use this new invoice form template
for some goofing around.

Here are some of the things that you may want to try:

4+ Moving and resizing objects: You can move and resize objects on the
form pretty easily. To move some bit of the form, first select the bit by
clicking it. Then use the arrow keys or drag the mouse to move the
selected bit. You can resize the selected bit in a similar way. Resize the
selected object by dragging the black squares (called resizing handles)
that show that the selected object is selected. In moving and resizing
invoice form objects, you want to keep two additional points in mind:

¢ You can select the Show Envelope Window check box to have
QuickBooks draw envelope windows on the invoice form to show
you where these appear. You will want to have envelope windows
shown to make sure that your customized invoice still has its
address information showing through.

* You can click the Grid button to display the Grid and Snap Settings
dialog box. This dialog box provides two check boxes that let you indi-
cate whether QuickBooks should use a grid (those are the dots you
see) that lets you more accurately line up invoice objects on the form.
The Grid and Snap Settings dialog box also includes a Snap to Grid box
that lets you tell QuickBooks that it should make gridlines sticky —
sticky gridlines automatically attract invoice objects so that you can
more easily line up the objects against the gridlines. The Grid and
Snap Settings dialog box also includes a Grid Spacing box that you can
use to specify how wide or narrow QuickBooks should draw gridlines.

4+ Selecting objects: You can select multiple objects on the invoice by drag-
ging the mouse. To do so, click at a point above the upper leftmost object
that you want to select and drag the mouse to a point that is just below
the lower rightmost object that you want to select. As you drag the mouse
from one corner to the other, QuickBooks draws a rectangle. Any object
that’s inside this rectangle when you release the mouse gets selected.

4+ Resizing multiple objects: You can change the height, width, and size of
multiple selected objects by clicking the Make Same Width, Make Same
Height, and Make Same Size buttons. To use these Make Same buttons,
you first need to select the objects that you want to make the same.
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4+ Changing column widths: You can change the width of columns in the

column area of the invoice form by clicking the Column object. After you
do this and QuickBooks selects the columns area, drag the column
divider line left or right to resize the column. Note that if you make
column 1 narrower, QuickBooks makes column 2 wider to take up the
space. Also note that you can resize the entire column area in the
manner described in the preceding point.

Positioning text within fields: If you click an invoice object and then
click the Properties button, QuickBooks displays the Properties dialog
box. The Properties dialog box includes a Text tab that lets you specify
how text should appear within an invoice object area. The Properties
dialog box also includes a Border tab that lets you specify whether
QuickBooks should draw a border along the edges of the invoice object.

Changing fonts: You can change the font used for the selected object by
clicking the Properties button, clicking the Text tab of the Properties
dialog box, and then clicking the Font button that appears on this tab.
QuickBooks displays the Example dialog box (shown earlier in the chapter
in Figure 14). The Example dialog box lets you choose a font, font style, a
point size, and special effects, such as strikeout, underlining, and color.

Adjusting margins: If you click the Margins button, QuickBooks displays
the Margins dialog box, which includes a Top, Bottom, Left, and Right
text box that you use to specify the margin around the invoice. The
default, or initial, margin settings equal half an inch.
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S

Center a selected object on an invoice form by clicking the Center button to
activate the Layout Designer. You can click the Zoom In and Zoom Out but-
tons to see more or less detail. If you want to undo your most recent change,
click Undo. Or, click the Redo button to undo your last undo option.

After you use the Layout Designer to make whatever changes are appropri-
ate to your new invoice form template, click OK to save your changes.

Invoicing a Customer

To invoice a customer, use the Create Invoices window to identify the cus-
tomer and specify the amount that the customer owes. To display the Create
Invoices window, choose the Customers=Create Invoices command. When
you do, QuickBooks displays a Create Invoices window like the one shown in
Figure 1-10. Note, however, that the Create Invoices window that you see may
not look exactly like the one shown in Figure 1-10. As previously described,
you can use more than one type of invoice form. You can also choose to cus-
tomize an invoice form so that it perfectly matches your business require-
ments. In the following steps, I describe generally how to invoice a customer.
The specific steps that you take may be ever-so-slightly different if you're
working with a different invoice form template.
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In Figure 1-10, I closed the Open Window List to provide more room for the
Create Invoices window. You can close your Open Window List by clicking its
close box (the small box marked with an “X” that appears in the upper-right
corner of the list. To redisplay the Open Window List after you've closed it,
choose Viewr>Open Window List.

After you display the Create Invoices window, take the following steps to
invoice a customer:

1. I1dentify the customer and, if appropriate, the job.

To do this, select the customer or customer and job combination from
the Customer:Job drop-down list box. Don’t worry about this “job” busi-
ness if you aren’t familiar with it. I describe how jobs work in Book IV,
Chapter 5. You do, however, need to understand how customers work.
You need to identify the specific customer that you are invoicing. You do
this by selecting the customer from the Customer:Job list box. If the cus-
tomer is a new customer that you haven’t yet invoiced or described in
the Customer List, enter a brief name for the customer — like an abbre-
viation of the customer’s business name — into the Customer:Job list
box. QuickBooks then indicates that the customer doesn’t yet exist on
the Customer List and asks whether you want to add the customer; indi-
cate that you do. When prompted, supply the customer information that
QuickBooks requests.

For more information about adding customers in QuickBooks, refer to
Book II, Chapter 2.

You can also classify an invoice as fitting into a particular category by
using the Class drop-down list box. Don’t worry at this point about using
class tracking. Book IV, Chapter 4 describes how you can use classes to
get a better handle on your business’s finances.

2. Confirm or provide new invoice header information.

After you identify the customer, QuickBooks fills out the Date, Invoice,
Bill To, and, possibly, the Ship To fields. You probably don’t need to
change any of this information. You should review the information
shown in these boxes to make sure that it is correct. For example, you
wouldn’t typically invoice someone unless you have already shipped the
product or the service has already been provided. Therefore, you proba-
bly should confirm that the invoice date follows the product shipment
date or the provision of service date. You may also want to confirm, for
example, that the Ship To address is correct.

3. Provide or confirm the Invoice field information.

Invoices include field information that records items such as purchase
order numbers, payment terms, ship date, and shipping method. You
should make sure that whatever QuickBooks shows in these field boxes
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156 Invoicing a Customer

is correct. If a customer has provided you with a purchase order number,
for example, enter that purchase order number into the P.O. Number box.
Confirm that the payment terms shown in the Terms box are correct.
Confirm that the date shown in the Ship field is correct. Not all of these
fields need to be filled for every invoice, but you want to supply any infor-
mation that makes it easier for a customer to pay an invoice, tie an invoice
to his or her purchasing records, and figure out how and when an item is
being shipped.

4. Describe the items sold.

How the columns area of your invoice looks really depends on whether
you are selling products or services. Figure 1-11 shows the columns

area for a product. The columns area for a service looks simpler because
you don’t provide much information when describing service items. In
the columns area, you want to describe each item — each product or
service — for which an invoice bills. To do this, you use a single row for
each item. The first item that you want to bill for, then, goes into row 1

of the columns area. For each item, you enter the quantity ordered, the
code for the item, and a price. QuickBooks will retrieve an item descrip-
tion from your Item List and place this data into the description column.
QuickBooks will also calculate the amount billed for the item by multiply-
ing the quantity by the price. You can, however, edit both the Description
and the Amount fields. If you edit the Amount field, QuickBooks recalcu-
lates the Price Each field by dividing the amount by the quantity.

To enter additional items onto the invoice, enter additional rows. Each
item that you want to bill for — each item that should appear as a sepa-
rate charge on the invoice — needs to appear as a row in the columns
area. If you want to invoice a customer for some product, one line in the
columns area of the invoice needs to be used for that product. If you
want to charge a customer for freight, one line of the invoice area needs
to describe that freight charge. If you want to bill a customer for sales
tax, again, one line or row of the columns area needs to show that sales
tax charge.

Discounts represent a tricky line item to include on an invoice. For this
reason, | provide an example of how a discount item appears on an
invoice. Assume that you want to grant some customer a 25 percent dis-
count. In order to do this, you now know (or should be able to guess)
that you need to include a discount line item on your invoice. However,
although QuickBooks includes a discount item on its Item List, a dis-
count percentage can only be applied to the previous line item on the
invoice. For this reason, QuickBooks also supplies a subtotal line item.
You use a subtotal line item to total all of the previous items shown on
the invoice. By subtotaling all of the product items shown on the invoice
in Figure 1-11, for example, the business can then grant the customer a
25 percent discount on those products.
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5.

S

A Subtotal line enables QuickBooks to calculate a discount.

Use the Customer Message box at the bottom of the Create Invoices
window to supply a customer message that will appear at the bottom
of the invoice.

If you've created a custom invoice form template that includes other
footer information, these footer boxes will also appear at the bottom of
the Create Invoices window. You can use them to collect and transfer
additional footer information.

(Optional) Check your spelling.

If you click the Spelling button, which appears along the top edge of the
Create Invoices window, QuickBooks will check the spelling of the words
that you've used on the invoice. If QuickBooks finds no spelling errors,
QuickBooks displays a message telling you that the spelling check is
complete. If QuickBooks finds a spelling error — product code abbrevia-
tions often produce spelling errors in QuickBooks — QuickBooks dis-
plays the Check Spelling on Form dialog box, shown in Figure 1-12. (In
Figure 1-12, I've misspelled the word “Yellow” much to the dismay of my
editor.) You can use the Change To box to correct your spelling error —
if it actually is a spelling error. You can select one of the suggested
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Figure 1-12:
The Check
Spelling on
Form dialog
box.

replacements from the Suggestions list box by clicking the suggestion
and then clicking the Replace button. You can replace all occurrences
of the misspelling by clicking the Replace All button. If the word that
QuickBooks says is misspelled is actually correctly spelled, you can
click the Ignore button to tell QuickBooks to ignore this word or the
Ignore All button to tell QuickBooks to ignore all occurrences of this
word on the invoice form.

Check Spelling on Form

Mot in dictionary:

Suggestions: | ‘lellow had Replace All
yellows
“rellawing
Yeuuwwsh ~ lgnore &1
Click &dd to append "ellow' to dictionary.

W=l Coffes Mugs
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If you use terms that are always popping up as misspelled words, at least
in QuickBooks, you can click the Add button that appears on the Check
Spelling on Form dialog box. Clicking the Add button tells QuickBooks to
add the word to its spelling dictionary. After you've added a word to the
QuickBooks spelling dictionary, QuickBooks doesn’t see the word as mis-
spelled. Also note that you can click the Options button to display the
Spelling Options dialog box. The Spelling Options dialog box includes
check boxes that you can use to turn on or turn off certain types of spell
checking logic. For example, the Spelling Options dialog box includes a
check box that you can select to tell QuickBooks to always check the
spelling of forms before printing, saving, or sending the form. The Spelling
Options dialog box also includes check boxes to tell QuickBooks it
should ignore certain sorts of words, such as those that use numbers,
those that are all uppercase, and those that are mixed case.

7. Click either the Save & Close button or the Save & New button to save

your invoice.

Click the Save & Close button if you want to save the invoice and close
the Create Invoices window. You use the Save & New button if you want
to save the invoice and then enter another invoice into the blank version
of the Create Invoices window.

Click the Ship button to display the QuickBooks Shipping Manager
window, which lets you automate some of the steps in shipping pack-
ages using Federal Express or UPS. If you use Federal Express or UPS,
therefore, you may want to experiment with this tool.
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One internal control problem within QuickBooks that I hear CPAs com-
plain about over and over is that QuickBooks allows someone to print a
form without saving it. This seems innocuous enough, but this little idio-
syncrasy can cause serious problems for a business owner. Here is why
this “printing without saving” option becomes dangerous: A dishonest
employee can create an invoice form, print the invoice form, send the
invoice form to a customer, and then not save the invoice form. At this
point, a customer has what appears to be a valid invoice from your firm
and probably will pay that invoice. If the nefarious employee can inter-
cept the check that pays that invoice, he can then deposit that check into
a personal checking account, and you are none the wiser. In order to pre-
vent or at least minimize this opportunity for employee theft, you want to
separate the ability to create an invoice form from the ability to print an
invoice form. Book VII, Chapter 2 describes how you do this as part of
setting up user passwords for segregation of duty. In this scenario, by the
way, the people who create invoices (such as sales people or accounting
clerks) don’t actually print invoices. Somebody else — perhaps even you,
the owner — will print the invoices and then arrange to have them dis-
tributed. Also note that you can use QuickBooks’ e-mail invoices and
batch printing to greatly simplify the work of sending out invoices. So
you aren’t actually creating that much extra work for yourself.

To page through invoices that you've already created, click the Previous
and Next buttons. Or, click the Find button and use the Find Invoices
dialog box to describe the invoice that you want to locate.

Billing for Time

Most of the time, line items that appear on an invoice will be items that you
have described in the item list and then quantify directly on the invoice.
However, in some service businesses, you may actually sell many units of
the same item. For example, a lawyer may sell hours or partial hours of legal
advice. This may be all that she sells. A CPA may sell hours of consulting or
accounting or tax preparation work.

In these circumstances, you don’t want to have an invoice go out to the cus-
tomer with one line on it that says, for example, “legal services, 100 hours,
$20,000.” You instead want an invoice that details each of the tasks that the
lawyer performed: the estate planning for 1.5 hours, review of a contract for
4 hours, preparation of a new real estate lease for 2 hours, and so forth. To
provide this level of detail — detail that is really beneath the item — you
need to use the QuickBooks Time Tracking feature.

QuickBooks supplies two methods for tracking the time spent that will be
billed on an invoice as an item. You can use the weekly time sheet or you can
time or record individual activities. I briefly describe how both time tracking
methods work — neither is difficult. Professional service providers — such
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Figure 1-13:
The Weekly
Timesheet
window.

as accountants, attorneys, consultants, architects, and so on — will want to
consider using one of these features to make sure that they accurately keep
good records of the time spent working for a client or customer.

Using a weekly timesheet

To use the weekly timesheet method, choose the Customers=>Time Tracking=
Use Weekly Timesheet command. QuickBooks displays the Weekly Timesheet
window, shown in Figure 1-13. To use the Weekly Timesheet window, first use
the Name box to identify the employee or vendor or other person performing
the service. You should be able to select this person’s name from the Name
box. If you can’t select a person’s name from the Name box, enter the person’s
name into the box, and then, when prompted, tell QuickBooks which list
(employee, vendor, or other names) should be added. After you have added
the name of the person performing the work, use the columns of the Weekly
Timesheet window to describe the customer or job for whom the work has
been performed, the service code, a brief description or note, the class (if you
are tracking classes), and then the hours spent per day. You can enter as many
lines onto the Weekly Timesheet window as you want. Each line separately
appears on an invoice. The notes information appears in the description area
of the invoice. For this reason, you want to use appropriate and descriptive
notes.

[ Pine Lake Porcelain - QuickBouks Pro 2005 BE|
File Edit View Lists Company Customers Vendors Employees Banking Reports Window Help
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Timing single activities

If you want to record service activities as they occur, choose the Customers=>
Time Tracking=>Time/Enter Single Activity command. QuickBooks displays the
Time/Enter Single Activity window, as shown in Figure 1-14.

To time or record a single activity, record the activity date into the Date box.
Use the Name box to identify the person performing the service. In the
Customer:Job box, identify the customer or the job for which the service is
being performed. Select the appropriate service item from the Service Item
drop-down list box. If you're tracking classes, predictably, you can also use
the Class drop-down list box to classify the activity. The Notes box should be
used to record a brief appropriate description of the service. This descrip-
tion appears on the invoice, so be thoughtful about what you write. After
describing or providing this general information about the service, you have
two ways to record the time spent on the service:

4 Manually record time: You can manually record the time spent on an
activity by using the Duration box to enter the time. If you spent 10 min-
utes, for example, enter 0:10 into the Duration box. If you spent 3 hours
and 40 minutes, enter 3:40 into the Duration box.

4 Have QuickBooks record the time: You can also have QuickBooks record
the time that you spent on the activity. Just click the Start button in the
Duration box when you start the activity, and click the Stop button when
you stop the activity. If you want to pause the timer while you take a
phone call, for example, click the Pause button.

After you describe the activity you're performing in the Time/Enter Single
Activity window, click the Save & New or Save & Close button to save the
activity information.

Verify that the Billable check box is selected. The Billable check box appears
in the upper-right corner of the Time/Enter Single Activity window. By select-
ing the Billable box, you tell QuickBooks that it should keep this record of a
billable activity for later inclusion on an invoice.

You can use the Previous and Next buttons that appear at the top of the
Time/Enter Single Activity window to page back and forth through your
records of activity timing. Note, too, that the Spelling button is also available
on the Time/Enter Single Activity window. You can, therefore, click the
Spelling button to spell check the notes description that you enter — which
is a good idea because this information will later appear on an invoice.
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Figure 1-14:
The Time/
Enter Single
Activity
window.

Billing for Time
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Including billable time on an invoice

To add billable time and cost to an invoice, create the invoice in the usual
way, as | describe previously. The only difference when you are adding bill-
able time is that you need to click the Time/Costs button (in the upper right
of Figure 1-16). When you do this, QuickBooks displays the Choose Billable
Time and Costs dialog box shown in Figure 1-15. The Time tab of the Choose
Billable Time and Costs dialog box shows each of the times that you’'ve
recorded for a customer. To add these times to the invoice, click the Use
column for the time. Or, if you want to select all of the times, click the Select
All button. Then click OK. QuickBooks then adds each of these billable times
as lines to the invoice. Figure 1-16 shows how billable time information
appears on the Create Invoices window.

As Figure 1-15 suggests, you can click the Items, Expenses, or Mileage tabs
to see lists of the items, out-of-pocket expenses, or business miles incurred
on behalf of a customer. You would add charges to an invoice for these sorts
of things in the same was as you add charges for time. I talk about how to
record business miles and out-of-pocket expenses you want to later charge
to customers in Chapter 2 of this book. By the way, the very last line of the
invoice shown in Figure 1-16 bills the client for the out-of-pocket expenses
incurred for a luncheon.
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Printing Invoices
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You can print invoices and then mail the printed invoices in a couple of dif-
ferent ways:

4+ You can print individual invoices by clicking the Print button at the top
of the Create Invoices window.

4+ You can also print a batch of invoices by clicking the arrow button
next to the Print button, choosing Print Batch from the menu that
QuickBooks displays, and then using the Select Invoices to Print dialog
box (which QuickBooks displays) to select the To Be Printed Invoices
for printing. After you select the invoices that you want to print by click-
ing them, you click OK.

The menu that QuickBooks displays when you click the Print arrow button
includes a Preview command. You can choose the Preview command to see
a preview version of the printed invoice.

E-mailing Invoices

a\\s

You can e-mail an invoice from QuickBooks. To do this, click the E-mail button
that appears at the top of the Create Invoice screen. When QuickBooks dis-
plays the Send Invoice dialog box, as shown in Figure 1-17, provide the e-mail
address and, optionally, a new e-mail message. Then click the Send Now
button to send the invoice. Alternatively, you can click the Send Later button
to batch your e-mail invoices for later delivery. To send all of your invoices in
a batch later, you click the arrow button next to the E-mail button at the top
of the Create Invoices window and choose the Send Batch command from the
menu that QuickBooks displays.

You can also use the Send Invoice dialog box to send the invoice to
QuickBooks and then have the QuickBooks folks mail a paper copy to the
customer or client. To do this, mark the Mail through QuickBooks button.
QuickBooks then tells you about this extra service and, if you decide to go
for it, steps you through the sign-up process.
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Send Invoice
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Figure 1-17:

The Send

Invoice [¥our Tnweice: wil be attached to the message s 5 POF Fils]

dialog box. [Z sendtiow | [sediater | [ cancel | [ heb

Recording a Sales Receipt

To bill a customer, you create an invoice as I describe earlier in this chapter.
To record the fact that you sold the customer some item — presumably this Book Ill

is because the customer simultaneously purchases and pays for the item or L0
service — you don’t invoice the customer. Rather, you create a sales receipt. =
A sales receipt looks very, very similar to an invoice. However, it doesn’t S,
include shipping information (because that’s irrelevant) and it lets you 2
record the amount that the customer pays. ‘:

=
To record a sales receipt when it is appropriate, choose the Customers> §"
Enter Sales Receipts command and then follow these steps: e

@

1. In the Enter Sales Receipts window, shown in Figure 1-18, use the
Customer:Job box to describe the customer or, optionally, the cus-
tomer and job.

Use the Class drop-down list box to identify the class if you are perform-
ing class tracking.

\P
) If you have questions about how the Customer:Job box works or how

the Class box works, refer to the discussion on this topic earlier in the
chapter.
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Figure 1-18:
The Enter
Sales
Receipts
window.

You can customize a sales receipt in the same basic way that you cus-
tomize an invoice form. Go back to the section on this topic located at
the beginning of this chapter.

2. Provide the sales receipt header info.

A sales receipt, like an invoice, includes some header information.
Specifically, the sales receipt includes a sales receipt date and a sales
number. The sales receipt also includes a Sold To box, which shows the
customer name and address. You should confirm that this information is
correct — and it should be if you are recording timely sales receipts and
have an up-to-date Customer List.

3. Use the items column to describe the items that you are selling.

The items column on a sales receipt works the exact same way as the
items column on an invoice. Therefore, rather than repeat myself, go
back to the earlier discussion of how this column works.

4. If you want, enter a customer message in the footer area of the Enter
Sales Receipts window.

If you have added other footer information to the Enter Sales Receipts
window — this would be because you have customized the sales receipt
form template — you can include that information, too.
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5. Describe where the sales proceeds go.

At the bottom-left corner of the Enter Sales Receipts window are two radio
buttons: Group with Other Undeposited Funds and Deposit To. Use these
radio buttons to indicate what you do with the money that you receive
from this sale. If you are going to immediately deposit the amount into a
bank account, select the Deposit To radio button and then select the
account into which you will deposit the check from the Deposit To box.

If you are going to batch this receipt with a bunch of other receipts —
maybe you are going to deposit the day’s receipts together in one lump
sum — select the Group with Other Undeposited Funds radio button.

If you don’t see the Group with Other Undeposited Funds and Deposit To
boxes, you may have indicated (perhaps even inadvertently) during the
setup that you just want QuickBooks to assume funds are deposited into
an undeposited funds account. This will probably work just fine. If you
do want to specify an account where sales proceeds go when you record
the sales receipt, choose the Edit=>Preferences command, click the Sales
and Customers icon, click the Company Preferences tab, and then unmark
s the Use Undeposited Funds as a default deposit to account.

A\

Book Ill, Chapter 4 talks about making deposits of undeposited funds.
6. Click the Save & Close or Save & New button to save the sales receipt.

These buttons work the same way for the Enter Sales Receipts window
as they do for the Create Invoices window.

7. (Optional) To print a copy of the receipt, click the Print button.

The Previous, Next, Find, Spelling, History, and Time/Cost buttons on
the Enter Sales Receipts window work identically to the same buttons on
the Create Invoices window.

Both the Create Invoices window (described earlier in the chapter) and
the Enter Sales Receipts window (just described) include a To Be Printed
check box in the footer area. If you select this check box, QuickBooks
adds the invoice or sales receipt to its list of unprinted invoices or sales
receipts. You can print invoices and sales receipts that appear on either
side of these lists by choosing the File>Print Forms command and then
either the Invoices or Sales Receipt command. There’s also a To Be E-mailed
checkbox that you can mark if you want to later e-mail a receipt. (See the
earlier discussion, “E-mailing Invoices.”

<\P

Recording Credit Memos

Credit memos show when a customer no longer owes you money or when
you now owe a customer money. Credit memos may occur because your cus-
tomer returns items that you previously sold to him or her. Credit memos
may also occur because you issue a customer a refund for some other good
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Figure 1-19:
The Create
Credit
Memos/
Refunds
window.

reason — perhaps the product wasn’t of the quality that you usually sell, or
a service wasn’t provided in the manner in which it should have been.

To record a credit memo, first display the Create Credit Memos/Refunds

window by choosing Customers=>Create Credit Memos/Refunds command.
Then, follow these steps:

1. 1dentify the customer or the customer and the job in the Customer:Job
box.

Use the Class box for class tracking if you've decided to do that (see
Figure 1-19). If you have questions about how either of these boxes
worKks, refer to the earlier discussion about these two boxes. These
boxes work the same way for credit memos as they do for invoices.

The Create Credit Memos/Refunds window supplies several buttons that
work the same way here as they do on the Create Invoices window:
Previous, Next, Print, Find, Spelling, and History. For information about

how to use these buttons if you have questions, refer to the earlier chap-
ter section on this topic.
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P As is the case with invoices, you can create custom credit memo forms.
To do this, you click the Customize button. Customizing a credit memo
works the same way as customizing an invoice form. Refer to the earlier
chapter section on this topic if you have questions about how to cus-
tomize a credit memo.

2. Provide the credit memo date, credit memo number, and confirm cus-
tomer information.

Credit memos, like invoices and sales receipts, include a header. This
header includes the transaction date and number and the customer
information. You should confirm that the credit memo header informa-
tion is correct on the Create Credit Memos/Refunds window. If it isn’t,
edit the default information that QuickBooks first uses to fill the Create
Credit Memos/Refunds window.

3. In the columns area of the Create Credit Memos/Refunds window,
describe the reason for the credit memo.

If the customer returned items, for example, use the columns to
describe these items and the original price that you are refunding.

. Click either Save & Close or Save & New to save the credit memo.

™

5. Click the Print button to print the credit memo.

Note, too, that you can also print credit memos in a batch. Obviously, Book Il
after you print credit memos, you need to distribute them.
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«® At the time you save your credit memo, QuickBooks allows you to indi-
cate what you want to do with the credit memo: retain it for later applica-
tion to a customer invoice, immediately apply it to a customer invoice,
or issue a refund check. You apply credit memos to invoices as described
in the next section of the chapter. You would write a refund check in the
same way as you write other checks. Chapter 4 of Book Ill describes writ-
ing checks.

s1awojsng Buioionu)

Receiving Customer Payments

When a customer pays an invoice that you have previously sent, you choose
the Customer=>Receive Payments command to record the payment. To use
this command to record a payment, choose the command and then follow
these steps:

1. After QuickBooks displays the Receive Payments window, as shown
in Figure 1-20, use the Received From box to identify the customer

paying you.
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Figure 1-20:
The Receive
Payments
window.
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2. Record the payment information in the Date, Amount, Reference # box,
Pmt. Method box, and Card No. and Exp. Date boxes (if appropriate).

3. Identify the invoice or invoices paid.

QuickBooks lists the open invoices for the customer in the columns area
of the Receive Payments window. You can identify which invoices a cus-
tomer payment pays by clicking the invoices that you see listed.

4. Apply any credit memos to open invoices as you apply the payment.

Click the Discounts & Credits button. QuickBooks displays the Discounts
and Credits dialog box, as shown in Figure 1-21. To apply a credit to the
selected invoices, click the Credits tab and then select credit that you
want to apply.

5. Apply any discounts to the open invoices and click Done.

Discounts work like credits. In fact, you use the same dialog box
(see Figure 1-21).
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applicable ta this specific invoice are displayed above. ear

Previously spplied Credits
o Date Credit Mo, Credit Amk, Amk, To Use  Credit Balance |

Figure 1-21: S
The

Discount v
and Credits Tatals 0,00 0,00 000 |
dlalog bOX. [ Done ] [ Cancel ] [ Help ]

6. Select the Group with Other Undeposited Funds or the Deposit To
radio button to indicate whether you are going to immediately deposit
the payment or batch the payment with a bunch of other payments
that you later deposit.

If you have a question about how these buttons work, refer to the earlier
discussion of these buttons in the section “Recording a Sales Receipt.”

7. Click the Save & Close or Save & New button to save the customer

QP payment information.
Click the Get Online Pmts button to receive online payment information
for a customer. The Get Online Pmts button appears only if you are using
either online billing or deluxe online billing. The earlier discussion
° describes how online billing and deluxe online billing work.
A

To see a list of the payments that have been applied to an invoice, click
the History button.

Assessing Finance Charges

You can tell QuickBooks to assess finance charges on overdue customer
invoices. To do this, you first need to set up the finance charge calculation
rules. After you've done this, you can easily assess finance charges on over-
due amounts by choosing the QuickBooks command.
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Setting up finance charge rules

To set up the finance charge rules, choose the Edit=>Preferences command.
When QuickBooks displays the Preferences dialog box, click the Finance
Charge icon and then the Company Preferences tab. The Preferences dialog
box at this point should look like the one shown in Figure 1-22. To tell
QuickBooks how it should calculate the finance charges, enter the annual
interest rate that you’ll use for calculating charges into the Annual Interest
Rate (%) box. Enter the minimum finance charge amount that you will assess
into the Minimum Finance Charge box. If you want to create a grace period,
enter the number of grace period days into the Grace Period (Days) box. Use
the Finance Charge Account drop-down list box to specify the QuickBooks
income account to which finance charge revenue should be credited. Select
the Assess Finance Charges on Overdue Finance Charges check box if you
want to charge finance charges on finance charges. Finally, use the Calculate
Charges From radio buttons — Due Date and Invoice/Billed Date — to spec-
ify the date from which finance charges should be calculated. After you've
provided this information, you can click OK to save your finance charge cal-
culation rules.

Preferences sk a help question ¥ How Do I?
- ~ My Preferences Company Preferences
e
Accounting Annual Inkerest Rate (%) 12,09
é Minimum Finance Charge  |25.0p
Checking Grace Period (days) 0
—
F. 1 22. kel Finance Charge Account | fnterest Income v Also See:
igure " Desktap General
Th e Wiew
[] assess finance charges on overdue finance charges Sales and
Company Customers
P f Eﬂance Calculate charges from
arge
references e (&) due date (O invaicesbilled dake
tab for the @
t General [ Mark finance charge invoices "“To be printed”
Inance
&
Charge i
Integrated
Preferences. | ea=ed
W

QuickBooks assumes that you don’t want to print finance charge invoices.
For this reason, the Mark Finance Charge Invoices to Be Printed check box is
not selected. Finance charges typically appear only on customer statements.



Figure 1-23:
The Assess
Finance
Charges
window.
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Calculating finance charges

After you set up the finance charge rules, you can easily assess finance
charges on overdue invoices. To do this, choose Customers=>Assess Finance
Charges. QuickBooks displays the Assess Finance Charges window, as shown
in Figure 1-23. This window lists all of the overdue invoices that customers
owe you and, based on your finance charge calculation rules, calculates a
finance charge. To assess the finance charge to a particular customer, click
the Assess field for the customer. (By default, QuickBooks assumes that you
want to assess finance charges whenever a customer’s account is past due.)
If you don’t want to assess finance charges to a particular customer, remove
the check mark from the Assess field by clicking it. After you’ve identified
which customers should be assessed finance charges, click the Assess
Charges button. QuickBooks, essentially, creates new invoices for each of
these customers. These new invoices charge the customer a finance charge.

[E] Pine Lake Porcelain - QuickBooks Pro 2005 BB
File Edit View Lists Company Customers Yendors Employ Banking Reports Wind Help
= = o
B B B @ B £ & B % 4 7 g g
Invoice  Cust Item Reports WVend  Check Bill Reg Accnt  Rmnd Find  Support Backup Feedback
« Assess Finance Charges Ask & help question ' How Do I?
Click the assess column for each customer For whom you wish ta create a finance charge invoice,
Assessment Date  Template
10/04/2005| Finance Charge w
Assess Lask FiZ Customer Overdue Bal, Finance Charge |
v Jne's Coffes House 900,00 108.89 |#
" Mac's Place 138,00 25.00
< Rainy Day Collectibles 2,026.80 243,22
ha
[ Mark all ] [ Unmark all ] [ Mark Invaices “To be prinked"
Customers with *s have payments or credit memas which have not been
applied ko any invaice. The overdue balance does not include these
credits.
[ Setfings... ] [ Collection History ] [ Assess Charges ] [ Cancel
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Customer Odds and Ends

In this chapter, I discuss most of the important commands on the Customers
menu. However, the Customers menu supplies several other commands that
are noteworthy — perhaps even useful — and deserve discussion some-
where in this book. For this reason, [ want to briefly describe the other com-
mands available on the Customers menu:

4+ Customer Navigator: Displays the Customer Navigator window, which
shows a flow chart that explains how the accounting process works for
customers. (This includes things such as issuing invoices, issuing credit
memos, and accepting payments.) The Customer Navigator window also
includes clickable hyperlinks that you can use to do things such as print
invoices or add a customer.

4+ Customer Center: Displays the Customer Center window, which includes
information about your customer list, including the amounts that your
customers owe.

4+ Customer Detail Center: Displays detailed information about a particu-
lar customer, the billing address, contact information, open invoices,
and so forth.

4+ Go To Customer Manager: Displays a Web page that describes other
Intuit products, including the QuickBooks Client Manager and the
QuickBooks Customer Manager.

4+ Enter Statement Charges: Displays the Accounts Receivable Register.
You shouldn’t need to use this command. You can, however, use this
command to add amounts to the accounts receivable for a particular
customer. The amounts would then appear on the customer’s next
statement.

4+ Create Statements: Displays a window that you can use to create a set of
monthly statements for customers. Such statements show the amounts
that a customer owes, invoices created for the month, credit memos
issued for the month, and payments made during the month.

4+ Credit Card Processing Activities: Displays a submenu of commands
that you can use to deal with credit card payments and credit card
billing. QuickBooks, by the way, supports credit card merchant accounts
and makes it easy to accept credit cards from customers. This is some-
thing you want to do. You should visit the QuickBooks Web site and find
out the details.

4+ Customer Letters with Envelopes: Displays a submenu of commands
that let you prepare customer or client letters for things like thank yous,
collection issues, and so forth.
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Customer: Job List: Displays the Customer:Job list, which is a list of cus-
tomers, and, if you are using jobs, the jobs associated with particular
customers.

Item List: Displays the Item List, which shows the items that may be
included on the invoice or credit memo.

Change Item Prices: Lets you change the prices of a bunch of different
items at one time, such as by increasing every price by 5 percent.

Billing Solutions: Displays a submenu of commands that explain and,
optionally, let you sign up for QuickBooks’ online billing.

Check Credit: Displays a submenu of commands that lets you either
learn more about QuickBooks credit checking services or lets you check
the credit of one of your customers.
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Chapter 2: Paying Uendors

In This Chapter

+* Working with purchase orders
+ Recording the receipt of items
v Entering bills

1 Paying bills

v~ Using the other Vendor menu commands

ou can make the process of tracking vendor information as simple or as

sophisticated as you like. In this chapter, | assume that you’re going for
sophisticated. However, you can make vendor management simpler by not
using purchase orders and by not using an accounts payable system.

«® You decide whether to use purchase orders and whether to track accounts
payable (amounts that you owe vendors) as part of setting up QuickBooks.
You can also later change your decision about using purchase orders and
about using account payables. To do this, you choose the Edit=>Preferences
command. For more information, refer to Book II, Chapter 3.

Creating a Purchase Order

A purchase order serves a simple purpose: It tells some vendor that you want
to purchase some item. In fact, a purchase order is a contract to purchase.

Many small businesses don’t use purchase orders. But when they grow to a
certain size, many businesses decide to use them because purchase orders
become permanent records of items that you've ordered. What’s more,
using purchase orders often formalizes the purchasing process in a com-
pany. For example, you may decide that nobody in your firm can purchase
anything that costs more than $100 unless they get a purchase order. If only
you can issue purchase orders, you've effectively controlled purchasing
activities through this procedure.
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A real purchase order

To use QuickBooks to create purchase orders, follow these steps:
1. Tell QuickBooks that you want to create a purchase order by choosing
Vendors=>Create Purchase Orders.
QuickBooks displays the window shown in Figure 2-1.

P If the Vendors menu doesn’t supply a Create Purchase Orders command,
QuickBooks doesn’t know that you want to create purchase orders.
You'll need to follow the instructions described in Book I, Chapter 3 for
turning on the purchase order feature.

2. Use the Vendors menu drop-down list box to identify the vendor from
whom you want to purchase the item.

The Vendor drop-down list box lists each of the vendors in your Vendor
List.

3. (Optional) Classify the purchase using the Class drop-down list box.

For more information about how you can use classes, read Book IV,
Chapter 4.

Choose the vendor here.

@ Pine Lake Porcelain|- QuickBooks Pro 2005 == E
File Edit View Lists Company Customers Vendors Employees Banking Reports Window Help

BH OB OB L E 4 & 2 B F% 4 7 g g

s v -

Invoice  Cust Item  Reports  Yend  Check Bill Reg Accnt Rmnd Find  Support Backup Feedback

& Create Purchase Orders sk a help question [Ask [l How Do 17 [REE-]
W previous [P Hext  &print ~ CdE-mal -~ | €L Find [5f Seeling B History

Wendor Class Ship T Template
Great Gobs of Porcelain b v -

Custorn Purchase Q... | v

Date

) P2, Mo,
Lojo1j2005

Pine Lake Porcelain
123 Main Street
Pine Lake, Wa 98053

Purchase Ord

Great Gobs of Parcelain
512 Wetmore
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Item

Cuskomet Armounk
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The Create =
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Orders
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window. Memn

[ Save & Close ] [ Sawe & New ] [ Clear ]




\\J

Creating a Purchase Order 179

4. (Optional) Provide a different Ship To address in the Ship To drop-

down list box.

The Ship To drop-down list box displays a list of all your customers,

vendors, and employees. You select the ship to address by selecting
one of these other names. After you select an entry from the Ship To
list, QuickBooks fills in the Ship To address box with the appropriate
information.

The Create Purchase Orders window supplies some standard and, hope-
fully, familiar buttons and boxes: Previous, Next, Print, Find, Spelling,
History, and Template. Because I spend quite a bit of time talking about
these buttons and boxes in Book Ill, Chapter 1, I don’t provide a redun-
dant discussion of these buttons and boxes here. If you have questions
about what the Previous and Next buttons do, refer to Book IIl, Chapter 1.

. Confirm the purchase order date.

Initially, QuickBooks puts the current system date into the Date box. You
should, however, confirm that the date that QuickBooks enters as the
purchase order date is correct. This is the contract date. Often, the date
sets contractual terms — such as the number of days that the item
needs to be shipped within.

. Confirm the purchase order number.

The purchase order number, or P.O. number, uniquely identifies the pur-
chase order document. QuickBooks sequentially numbers purchase
orders for you and places the next number into the P.O. No. box. The
guess that QuickBooks makes about the right purchase order number is
usually correct, but if it isn’t correct, enter the replacement number.

. Confirm the vendor and ship to information.

The Vendor block and the Ship To block identify the vendor from whom
you are purchasing the item and the ship to address to which you want
the vendor to send the shipment. This information should be correct if
your vendor list is up-to-date and you have correctly used the Ship To
drop-down list box to identify, if necessary, an alternative Ship To address.
Nevertheless, confirm that the information shown in these two address
blocks is correct. If the information isn’t correct, of course, fix it. You can
edit address block information by selecting the incorrect information and
then retyping whatever should be shown.

. Describe each item that you want to order.

You use the columns of the Create Purchase Orders window to describe
in detail each item that you want to order as part of the purchase. Each
item goes on its own row. To describe an item that you want to purchase
from the vendor, you provide the following bits of information:

¢ Item: The Item column lets you record the unique item number for
the item that you want to buy. Remember that items need to be
entered, or described, in the Item List. Book II, Chapter 2 discusses

Book I
Chapter 2
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10.

briefly how you go about setting up the Item List. The next chapter,
Book IIl, Chapter 3, talks in more detail about the Item List. The main
thing you need to know about the Item List is that anything that you
want to show on the invoice — or, for that matter, on a purchase
order — needs to be described in the item file.

¢ Description: The Description column shows the description for the
item that you select. You can also edit the Description field so that it
makes sense to customers or vendors.

e Qty: The Qty column lets you identify the quantity of the item that
you want. You enter the number of items that you want in this field,
obviously.

e Rate: The Rate column lets you enter the price per unit or rate per
unit for the item. Note that QuickBooks uses different labels for this
column depending on the type of business that you’ve set up.

e Customer: The Customer column lets you identify the customer for
whom the item is being purchased.

e Amount: The Amount column shows the total expended for the item.
QuickBooks will calculate the amount for you by multiplying the
quantity by the rate (or price). You can also edit the column amount.
In this case, QuickBooks adjusts the rate (or price) so that quantity
times rate always equals the amount.

You need to enter a description of each item that should be included on
the purchase order. This means, for example, that if you want to order
six items from a vendor, your purchase order should include six lines of
information.

. Print the purchase order.

You will want to print the purchase order. The purpose of recording a
purchase order into QuickBooks is to create a formal record of a pur-
chase. You almost always will want to transmit this purchase order to
the vendor. The purchase order tells the vendor exactly what you want
to purchase and the price that you are willing to pay. To print the pur-
chase order, you can click the Print button. You can also print purchase
orders later in a batch; to do so, save all the purchase orders that you
want to create, and then choose the File=>Print Forms=>Purchase Orders
command.

Save the purchase order.

To save your purchase order, click either the Save & Close button or the
Save & New button. If you click the Save & New button, QuickBooks
saves that purchase order and redisplays an empty version of the Create
Purchase Orders window so you can record another purchase order.
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Purchase order tips and tricks

Even though the last section detailed about all you need to know to create a
purchase order, [ do need to make a couple of important quick observations:

4+ Be aware that you can print without saving. As I note several times
throughout this book, QuickBooks allows you to print forms such as
purchase orders without actually saving the purchase order. This some-
times creates an internal control risk. For example, someone can invoice
a customer or print a check without actually recording the invoice or
check in the QuickBooks system. Perhaps the risk isn’t quite as great
with a purchase order, but still, you definitely don’t want to be printing
purchase orders, distributing them to vendors, and not saving them. Be
aware that you must remember to save your purchase order after you
print it.

4+ Not every purchase deserves a purchase order. If you're not used to

working with purchase orders, it is easy to go overboard when you first
start using this handy tool. Nevertheless, keep in mind that not all pur-
chases warrant purchase orders. Typically, businesses use purchase
orders as a way to control and document purchases. In fact, many pur-
chases don’t really need a purchase order. Amounts that you've agreed
to purchase that are documented through standard contracts, such as
bills from the telephone company, the gas company, and your landlord,

don’t need purchase orders, obviously. In addition, modest purchases c?.?'t(;r"z

for things such as office supplies often don’t need purchase orders, P

either. You definitely do need a way to control those expenditures, but

purchase orders are probably not the way to go. Other budgetary con- i

trols such as “approval from the supervisor” or a simple budget often =

work just as well. <
)
o
(=]
)

Recording the Receipt of Items

When you receive items from a vendor, you can record the receipt. You
would typically do this when you want to record the receipt of an item even
before you receive a bill for the item. For example, in any business with
inventory, you want to know exactly how much inventory you have in your
warehouse or on your store floor. You don’t want to wait to adjust your
inventory records for these purchases until you receive the invoice from the
vendor. In this scenario, you need to record when you receive items.

To record item receipts, follow these steps:

1. Choose the Vendors—Receive Items command.

QuickBooks displays the Create Item Receipts window, as shown in
Figure 2-2.
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Figure 2-2:
The Create
ltem
Receipts
window.
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2. Select the vendor from whom you’re receiving items from the Vendor
drop-down list box.

3. Select any P.O.s that you’re receiving items on.

If open purchase orders exist for the vendor, QuickBooks displays a
Message box. The Message box asks whether you want to receive items
against one of the open purchase orders. If the items that you receive
are items that you set up on a purchase order, click Yes. When Quick
Books displays the Open Purchase Orders dialog box — the dialog box
just lists open purchase orders — select the purchase order that
ordered the items you are now receiving and then click OK. QuickBooks
then fills out the Items tab of the Create Iltem Receipts window by using
the information from the purchase order. This automatic data entry of
purchase order information should save you time if the items that you're
receiving match those items on the purchase order.

4. Confirm the receipt date.

Use the Date field to confirm the date of receipt. As with the Date field in
other places in QuickBooks, enter the date in mm/dd/yyyy format. Or,
you can click the Calendar button that appears to the right of the Date
field and choose the date from the pop-up calendar that QuickBooks
displays.
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5. Use the Total box to identify the total value of the order received, if
available.

QuickBooks will calculate this total for you by adding up the individual
item costs, so you can wait until later.

6. (Optional) Use a reference number.

You can use the Ref. No. field to provide a reference number. For exam-
ple, you may want to reference the vendor’s order number.

7. (Optional) Provide a memo description.
8. Describe the items received.

Use the Items tab to identify the items that you've received. The Items
tab of the Create Item Receipts window resembles and works like the
Items tab of the Create Purchase Order window, as described (briefly)
earlier in the chapter and (in some detail) in the preceding chapter. For
this reason, [ don’t discuss how you enter, for example, item codes in the
[tem column. If you have questions about how the Items tab works, refer
to one of the other appropriate chapter sections in this book. For exam-
ple, you may want to refer to the discussion in Book I, Chapter 1.

9. Describe any related expenses.

The Expenses tab of the Create Item Receipts window works like the
Expenses tab of the Write Checks window. If you have questions about
how the Expenses tab works, refer to the discussion of writing checks in
Book III, Chapter 4.

10. Click either the Save & Close or Save & New button to save the receipt
item.

If you click the Save & Close button, QuickBooks saves your item receipt
information and closes the Create Item Receipts window. If you click the
Save & New button, QuickBooks saves the item receipt information and
redisplays a fresh, clean, cleared version of the Create Item Receipts
window. You can then use the window to describe the receipts of some
other set of items.

That’s about all you need to know to work with the Create Item Receipts
window. Nevertheless, let me just quickly describe the half-dozen command
buttons located at the bottom of the Create Item Receipts window that I
haven’t referenced in the earlier step discussions:

4+ Select PO: This command button displays the Open Purchase Orders
dialog box. The Open Purchase Orders dialog box lists the purchase
orders open for the selected vendor. By selecting a listed purchase
order, you tell QuickBooks to fill out the Iltem tab with the information
from that purchase order or purchase orders.

Book I
Chapter 2
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Figure 2-3:
The Select
Time Period
dialog box.

4+ Clear Qtys: This button clears the received quantities shown on the
Items tab if you've specified a purchase order. You can use this button
to, in effect, start over (when you click this button it changes into the
Receive All button, which accepts all items on the purchase order).

+

Show P.O.: This button shows the selected purchase order.

4+ Clear Splits: This button erases any expense or item information that
you've entered on the Expenses tab or Items tab. In effect, the Clear
Splits button lets you start over in recording the receipt of some item or
items.

4 Recalculate: This button recalculates the total amount by using the infor-
mation that you’'ve entered onto the Expenses tab and the Items tab.

4+ Clear: This button clears all of the information that you've entered on
the Create Item Receipts window, including the Expenses tab informa-
tion, the Items tab information, and the vendor information shown at the
top of the window.

4+ Time: This button opens the Select Time Period dialog box, shown in
Figure 2-3, which you use to specify the date range of the work for which
you're paying.

Select Time Period

He\p

Select time period For which you want to pay,

Simultaneously Recording the Receipt and the Bill

You can record a bill for items that you receive at the same time that you
record the receipt of the items. You can do this simply by selecting the Bill
Received check box that appears near the top of the Create Item Receipts
window (as shown in Figure 2-2).

If you know that you’re going to record a bill at the same time you record the
receipt of items, you can also choose the Vendors=Receive Items and Enter
Bill command. In other words, rather than choosing the Receive Items com-
mand from the Vendors menu, you choose the Receive Items and Enter Bill
command. When you do this, QuickBooks displays the Enter Bills window,
shown in Figure 2-4. Essentially, the Enter Bills window is just another ver-
sion of the Create Item Receipts window except that the Bill Received check
box is already selected. To simultaneously record items that you’ve received
and enter a bill, you follow the same steps as you do to record the receipt of
the items.



Figure 2-4:
The Enter
Bills
window.
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One item worth noting about simultaneously recording bills and the receipt
of items, however, is this: When you enter a bill, you probably need to be
very precise about the charges of the vendor. For example, in all probability,
you won't just pay for the ordered items. You may also pay certain shipping
and handling fees. These amounts won’t necessarily get recorded on the
Items tab. They will probably be recorded on the Expenses tab.

Entering a Bill

\\J

If you told QuickBooks during the setup process that you want to track
unpaid bills, also known as accounts payable, you can enter bills as you
receive them. By doing this, QuickBooks keeps track of the unpaid bills
that you need to pay.

Good, accurate recordkeeping of unpaid bills, or accounts payable, is essen-
tial if you want to do good accrual-basis accounting. As I discuss in Book I,
Chapter 1, accrual-basis accounting produces more accurate financial
statements.

Book I
Chapter 2
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If you haven’t previously recorded item receipt

To enter a bill, you follow one of two sequences of steps. If you are entering a
bill and the bill is for items of which you haven’t previously recorded the
receipt, you follow these steps:

1. Choose the Vendors—Enter Bills command.

QuickBooks displays the Enter Bills window, shown in Figure 2-5. You'll
use this window to describe the bills that you later need to pay.

2. Use the Vendor drop-down list box to identify the vendor.

3. Use the Date, Bill Due, and Amount Due fields to describe the invoice
date, the invoice due date, and the invoice amount.

Optionally, use the Terms drop-down list box to identify the payment
terms and the Ref. No. box to identify the vendor’s reference number.
Next, if you want to, go ahead and provide a memo description for the
bill by using the Memo box.

4. 1dentify the expenses billed.

Use the Expenses tab of the Enter Bills window to identify the expenses
that the bill represents. To identify expenses, you need to supply the
account number that should be debited, the amount, and, optionally, the
memo, customer:job, and class information. If you have questions about
how the Expenses tab works, refer to the discussion in Book Ill, Chapter 4
about writing a check. The Expenses tab of the Write Checks window
works the same way as the Expenses tab of the Enter Bills window.

5. Identify the items billed in the Items tab.

Use the Items tab of the Enter Bills window to describe any items for
which the vendor bills you. For example, use the Item column to identify
the thing that you purchased. Then use the Qty, Cost, and Amount
columns to identify what the item cost. You can also use the Customer:
Job column if you are tracking bills by customers. If you have questions
about how to work with the Items tab, know that the Items tab of the
Enter Bills window works in the same manner as the Items tab of other
QuickBooks windows. You can, for example, refer to the discussion of
the Create Invoices window in Book III, Chapter 1.

The buttons at the bottom of the Enter Bills window — Select PO, Receive
All, Show PO, Clear Splits, Recalculate, and Clear — work the same way as
the similarly titled command buttons located at the bottom of the Create
Item Receipts window discussed earlier in the chapter in the section
“Recording the Receipt of Items.”



Figure 2-5:
The Enter
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window.
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Figure 2-6:
The Select
Item
Receipt
dialog box.

If you have previously recorded item receipt

To enter a bill when you’ve already recorded the receipt of the item for
which the bill invoices you, follow these steps:

1. Choose the Vendors->Enter Bill for Received Items command.

QuickBooks displays the Select Item Receipt window, shown in Figure 2-6.

Select Item Receipt Ask & help question ¥ How Do I?
Yendor | Great Gobs of Porce v
Chaose the Item Receipt which corresponds to your bil
Date Ref Mo, Memo
10/0+2005 Received items (bill .. ol

Book I
Chapter 2
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Figure 2-7:
The Enter
Bills
window.
Yet again.

2. To identify the item receipt for which you are now recording a bill,
select the vendor from the Vendor drop-down list box.

Then, when QuickBooks displays a list of item receipts for the vendor,
click the item receipt that corresponds to your bill. Next, click OK.
QuickBooks displays the Enter Bills window for the item. QuickBooks
fills out much of the Enter Bills window by using the information from
the item receipt, as shown in Figure 2-7.

You may be able to skip Steps 3, 4, and 5 if your item receipt information
correctly and completely fills the Enter Bills window.

3. Use the Date, Bill Due, and Amount Due fields to describe the invoice
date, the invoice due date, and the invoice amount.

Optionally, use the Terms drop-down list box to identify the payment
terms and the Ref. No. box to identify the vendor’s reference number.
Next, if you want to, go ahead and provide a memo description for the
bill by using the Memo box.

@ Pine Lake Porcelain - QuickBooks Pro 2005 2E]%]
File Edit View Lists Company Customers Vendors Employees Banking Reports Window Help

B & B Ik B 4 @« = B &% 4 2 g g

Invoice  Cusk Ikem Reports  Wend  Check Eill Reg Accnt Rmind Find  Support  Backup Feedback
= Enter Bills #isk a help question v How Do I?

W previous [P Mext | B Find Ty History

Bill Received
Wendor Great Gobs of Porcelain w Date 10/04)2005

Bil Due 10f14/2005
Amount Due 210,00

Terms hd Ref. Mo,
Mema
Expenses 40,00 | Items $210.00

Tkem Description ik iCosk Amount Customer: Job E Class PO o, |
‘Vellow Mug Sunset vellow porcelain mug 150 0,65 97.50 1 \ ~
Blue Mug Swedish blue porcelain mugs 150 0,75 112,50 1

ha

[ selectpo | [ clear Gtys | [ Showpo |

Save & Close ] I Save & MNew ] [ Revert ]
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4. Use the Expenses tab of the Enter Bills window to identify the expenses
that the bill represents.

To identify expenses, you need to supply the account number that should
be debited, the amount, and, optionally, the memo, customer:job, and
class information. If you have questions about how the Expenses tab
works, refer to the discussion in Book Ill, Chapter 4 about writing a check.
The Expenses tab of the Write Checks window works the same way as the
Expenses tab of the Enter Bills window.

5. Use the Items tab of the Enter Bills window to describe any items for
which the vendor bills you.

For example, use the Item column to identify the thing that you pur-
chased. Then use the Qty, Cost, and Amount columns to identify what the
item cost. You can also use the Customer:Job columns if you are tracking
bills by customers. If you have questions about how to work with the
Items tab, know that the Items tab of the Enter Bills window works in the
same manner as the Items tab of other QuickBooks windows. You can, for
example, refer to the discussion of the Create Invoices window in Book III,
Chapter 1.

Recording a credit memo

You record credit memos from vendors by using the Enter Bills window, too. Book Il
The only difference in recording a credit memo is that you mark the Credit Chapter 2
button.

Paying Bills

If you use QuickBooks to keep track of the bills that you owe, you don’t use
the Write Checks window (described in Book IIl, Chapter 4) to record the bills
that you want to pay. Rather, you tell QuickBooks to display a list of these
unpaid bills that you’ve already recorded — and then you pick and choose
which bills QuickBooks should pay and which bank account QuickBooks
should use to write the check.

siopuap fuiked

Follow these steps to pay bills in this manner:

1. Choose the Vendors->Pay Bills command.

QuickBooks displays the Pay Bills window, shown in Figure 2-8. You
use the Pay Bills window to describe the payment that you want to
make.



190 Paying Bills

@ Pine Lake Porcelain - QuickBooks Pro 2005 PR
File Edit View Lists Company Customers Vendors Employees Banking Reports Window Help
B B B W B A & 2B % 4 9 9 &
Invoice  Cust Item  Reports  Vend  Check Bill Reg Accnt Rmnd Find  Support Backup Feedback
Select Bills ta be Paid
haw bills @i)ue onar hanra)i 10}14{2005
() show all bills SartBils By | Due Date -
o Date Due “wendor Reef, Mo, Disc, Date Arnt, Due Disc, Used cCredits Used Ak, To Pa |
10/13/2004 |Dusty Memaries 700.00 0.00 0.00 0.00 |
10f14/2004 |Acme Food Distributors LLC 150.00 0.00 0.00 0.00
10f14/2005 |Great Gobs of Parcelain 210,00 0,00 0,00 0,00
1014/2005 |Greak Gobs of Porcelain 250,00 0,00 0,00 0,00
b
Totals 1,310.00 0.00 0.00 0.00
Discount & Credit Information For Highlighted Bil
Wendor Terms Murnber of Credits 0
Bill Reef. Ma. Sugg. Discount 0.00 Total Credits Available 0.00
Figlll’e 2'8: Payment Account Payment Method Payment Date
The Pay Smar\l Business Checking ¥ Check - %) To be printed \0j04j2005
B|”S Ending Balance 0.00 () assign check na.
WindOW. [ Pay & Close ] [ Pay & New ] [ Clear ]
2. Describe which bills you want to pay.
Use the Show Bills radio buttons at the top of the Pay Bills window to
identify what you want to see. Select the Due On or Before radio button
to only show bills that are due on or before the specified date. To spec-
ify the date, enter the date into the Due On or Before date box. To see a
list of all the bills that you have to pay, select the Show All Bills radio
button.
W

You can use the Sort Bills By drop-down list box to select the order that
QuickBooks uses for listing your bills. For example, you can sort bills by
due date, discount date, vendor, and amount due.

Select the bills that you want to pay.

To select bills that you want to pay, click the check column. The check
column is the leftmost column in the list of unpaid bills — it’s headed by
a check mark. When you click the check column, QuickBooks marks the
bill with a check mark. The check mark tells QuickBooks that you want to
pay that bill. To deselect a bill, click the check column again. QuickBooks
removes the check mark.
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4. (Optional) Review a specific bill.

You can review detailed information about a specific bill by first clicking
the bill to highlight it in the list and then by clicking the Go To Bill button.
When you do this, QuickBooks displays the Enter Bills window with the
bill information. To close the Enter Bills window, click the Close button.

5. Set the discount and credit.

If you click the Set Discount button, QuickBooks displays the Discount tab
of the Discount and Credits window, as shown in Figure 2-9. You can use
the Discount tab to enter a discount amount for the bill. If you enter a dis-
count amount for the bill, you need to also enter the discount account.
This is the account that gets credited for the reduction — the discount —
in the amount that you need to pay.

#a Discount and Credits
ill
\u'Bendnr tareat Gobs of Porcelain
Ref, Mo, Amount Due 250,00
Date 10/04/2005 Discount Used 25.00
Original Amt. 250,00 Credits Used 0.00
Amt, To Pay 225.00
Discount Credits
Figure 2'9: Discount Dake
The Terms Book IlI
Discount tab Suggested Discount 0.00 chapter 2
Of the Amaount of Discount 25.00
D |SC ou nt Discount Account “ither Income e ;U
and Cred|ts Discount Class v E'
dialOQ bOX. [ Done ] [ Cancel ] [ Help ‘:
D
=
o
(=]
)
If you click the Set Credits button, QuickBooks displays the Credits tab
of the Discount and Credits dialog box, shown in Figure 2-10. The Credit
tab lists any credit memos from this vendor. To apply a credit memo to
the amount due a vendor, click the Set Credits button. QuickBooks
marks applied credits by placing a check mark in the marked column.
When you complete your work with the Discounts and Credits dialog
box, click the Done button to close the dialog box and return to the Pay
< Bills window.

Click the Clear button in the Discount and Credits dialog box to clear the
applied credits shown on the Credits tab.
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== Discount and Credits

Eil
Vendor
Ref. Mo,
Date

Original Amt.

Great Gobs of Porcelain

10/04/2005
210,00

Amount Due
Discount Used
Credits Used
Amk, To Pay

Discount

Credits

210,00

0.00
75.00
135.00

-f Date Ref. Mo, Credit Ak, Ant, To Use  Credit Balance

Figure 2-10; | |*/|DIEIEE
The Credits
tab of the | -
D|scount Totals 75.00 75.00 0.00 ‘
and Credits
dlalOQ bOX' [ Done ] [ Cancel I [ Help I

6. Use the Payment Account drop-down list box to select the bank

account to be used for making payments.

The ending balance for the bank account shows the Payment Account
drop-down list box.

. Use the Payment Method drop-down list box to select the payment

method.

If you want to pay your bills by check, for example, select Check.
Assuming that you will print the checks in QuickBooks, select the To

Be Printed radio button (otherwise, select the Assign Check No. radio
button to have QuickBooks assign the next consecutive check number).
You can also pay bills by other methods, such as by credit card and by
online payment (if you are set up for online payment or online banking).

. Use the Payment Date drop-down list box to record the payment date

that you want.

The payment date entry interacts with the payment method entry. The
payment date that you set, for example, will affect when an online pay-
ment gets made. The payment date also corresponds to the check date
that will be shown on printed checks.

. After you select the bills that you want to pay and describe how you

want to pay them, you can click either the Pay & Close button or the
Pay & New button to pay the selected bills.

If you click the Pay & Close button, QuickBooks records the payment
transactions in the bank account to pay the selected bills. QuickBooks
also closes the Pay Bills window. If you click the Pay & New button,
QuickBooks does the same thing — but leaves the Pay Bills window
open so that you can record another series of bill payments.
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10. Complete your task.

You still need to print any unprinted checks necessary to pay bills if you
are using checks to pay the bills. You also need to transmit any online
payment instructions necessary to pay the bills if that’s how you’ve
chosen to pay the bills. If you are going to hand-write checks, you obvi-
ously need to hand-write the checks and then mail them out. In other
words, all QuickBooks does at this point is record in the QuickBooks data
file the payment transactions. It hasn’t yet affected the transactions. You
need to print the checks, send the online payment instructions, or hand-
write the checks!

Reviewing the Other Uendor Menu Commands

In the preceding paragraphs of this chapter, I talk about the most important
commands on the Vendor menu. Nevertheless, before [ wrap up this little
dog and pony show, I will quickly review for you the other commands and
what they do.

The Uendor Navigator

The first two commands on the Vendors menu, Vendor Navigator and Vendor

Detail Center, display windows of vendor-related information. For example, the Book Il
Vendor Navigator window appears when you choose the Vendors=>Vendor Chapter 2
Navigator command. Figure 2-11 shows this window.

The Vendor Navigator window includes a useful flowchart that describes
how the various Vendors menu commands work together to record purchase
orders, the receipt of items, and the payment of bills. The Vendor Navigator
window also provides clickable hyperlinks that you can use to do things
such as print checks, add a vendor to the Vendor List, and review the Vendor
Detail Center.
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If you're just getting started with QuickBooks and you find the whole process
a little confusing, and perhaps more than a bit cumbersome, you may want to
try working with the Vendor Navigator window. Sometimes, the little vendors
flowchart (this appears in the upper-left quarter of the window) amounts to a
pretty handy tool. Also, those clickable hyperlinks for doing common tasks
can be kind of handy. In any event, the choice is yours.

The UVendor Detail Center

The Vendor Detail Center window, shown in Figure 2-12, displays detailed
vendor information for the selected vendor. All you do is select the vendor
for which you want to see detailed information from the Vendor Detail drop-
down list box. The Vendor Detail Center shows a bunch of information for a
vendor. This information all comes from the Vendor List, by the way.
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Figure 2-11:
The Vendor
Navigator
window.
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Detail
Center
window.
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If you are going to keep records of your vendors, including information such
as their telephone numbers, about the best place to store that information in
my humble opinion, is in the Vendor List. You have to maintain the Vendor
List in order for QuickBooks to work. So why not also go to a little bit extra
effort and keep all your vendor information there? If you adopt this approach,
the Vendor Detail Center window is the window that you will use to quickly
look up things such as the vendor’s phone or fax number.

The Sales Tax Menu commands

The Sales Tax command displays a submenu of commands that pay sales tax
amounts you've collected to the appropriate tax agency; adjust the sales

tax liability due; and produce reports on the sales tax liability you owe, the
sales tax revenue you’ve generated, and the sales tax codes you’ve set up.

To pay the sales taxes you owe, you simply choose the Vendors=Sales Tax=
Pay Sales Tax command. When QuickBooks displays the Pay Sales Tax dialog
box (which lists the amounts you owe various sales tax collection agencies),
you select the agencies you want to pay or click the Pay All Tax button. Quick-
Books then records checks into the bank account register (see Chapter 4 of
Book IIl for details about how to work with the bank register) and you print
the checks in the usual way.

To adjust the amount that QuickBooks thinks you owe a sales tax collection
agency, you can choose the VendorswSales Tax=>Adjust Sales Tax Due com-
mand. When QuickBooks displays the Sales Tax Adjustment dialog box, select
a sales tax agency from the Sales Tax Vendor box, an appropriate expense or
income account from the Adjustment Account box, select as appropriate the
Increase Sales Tax By or Decrease Sales Tax By buttons, and then enter the
adjustment amount into the Amount box.

To print one of the sales tax reports, simply select the command that corre-
sponds with the report. For example, to print the Sales Tax Liability report,
choose the Vendors=Sales Taxm>Sales Tax Liability command.

Print 1099s

The Print 1099s command displays the Printing 1099-MISC and 1096 Forms
dialog box, shown in Figure 2-13, which lets you print 1099-MISC forms for a
selected calendar year. You can select the year for which you need to print
1099 forms by selecting a date range description from the drop-down list
box. Initially, for example, the drop-down list box shows Last Calendar Year.
Alternatively, you can use the From and To boxes to specify the starting and
ending point for the year. After you identify the year for which you want to
print 1099 forms, click OK. QuickBooks then creates 1099 forms for any ven-
dors who need them, provided that your 1099 preferences are set up cor-
rectly and the vendor is marked as a 1099 recipient in the Vendor List.

Book I
Chapter 2
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Figure 2-13:
The Printing
1099-MISC
and 1096
Forms
dialog box.

Printing 1099-MISC and 1096 Forms

Please specify a date range:

Cuskam

B s @

You typically send 1099 forms to vendors to whom you pay more than $600
in a year. You can control the actual threshold amount — it varies from year
to year because of inflation and type of payment — by choosing the Edit>
Preferences command, clicking the Tax 1099 icon, and then clicking the
Company Preferences tab. For more information about how to set tax 1099
preferences, refer to Book II, Chapter 3.

Uendor List

The Vendors=>Vendor List command displays the Vendor List window,
shown in Figure 2-14. The Vendor List window shows a complete list of all
the vendors that you have set up. The Vendor List window also provides but-
tons that you can use to make changes to the Vendor List. Book II, Chapter 2
describes how to set up and work with the Vendor List, also known as the
Vendor Master File.

Item List

The Vendors=>Item command displays the Item List window. You can read
more about the Item List window in Book III, Chapter 3.

Purchase Orders List

The Vendors=>Purchase Orders List command displays a list of the open pur-
chase orders. You can use this command to see which purchase orders are
open and yet unfilled. Figure 2-15 shows the Purchase Orders List window.

Online Vendor Services

The Vendor Services command displays a submenu with other commands —
typically the Purchase Checks and Forms command and Pay Bills Online
command. (You may not see both commands on your menu.) The Purchase
Checks and Forms command displays the Checks & Supplies window, which
describes how you can order check forms and other forms from Intuit. The
Pay Bills Online command displays the Pay Bills window, which describes
how to pay bills online.
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Chapter 3: Tracking Inventory
and Items

In This Chapter

v Looking at your Item list

v~ Using the Item List window

v Adding items to the Item list

v~ Editing items

v+ Adjusting physical counts and inventory values
v+ Adjusting prices and price levels

v+ Inventory in a manufacturing firm

f you've worked with QuickBooks, you won'’t be surprised to hear that

the Item list is a key piece of your QuickBooks accounting system. The
Item list identifies each of the things that you sell. The Item list also identi-
fies other things that appear on your invoices and — if you use them — on
your purchase orders.

In this chapter, I talk about how you work with the QuickBooks Item list: more
specifically, how you look at and use the information on the Item list. [ explain
how to add information to the list and how to edit information already on the
list. What’s more, [ talk about three accounting tasks that are related to your
Item list: adjusting physical inventory accounts for inventory shrinkage or
spoilage; adjusting price levels of your inventory items; and if you manufac-
ture inventory, how the new version of QuickBooks handles manufactured
goods.

Looking at Your [tem List

QuickBooks provides a bunch of different ways to see the information that
you’ve stored in your Item list. You may already know some of this stuff if
you’ve worked with QuickBooks a bit. Some of it may be new to you. In any
case, the next sections review the half-dozen ways that you can see the
items on your Item list.
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s

Figure 3-1:
The Item
drop-down
list box on
the Create
Invoices
window.

Using the Item column

The Item column that appears in many of the windows in QuickBooks lets
you see a drop-down list of items. Figure 3-1, for example, shows the Item
drop-down list box in the Create Invoices window (which is actually defying
gravity and “dropping” up). You use the Item column and the individual rows
of the Item column to identify the items that appear on an invoice.

One important point to consider as you look at the Iltem column and Item
drop-down list box in Figure 3-1 is space. Note that the Item drop-down list
box is pretty narrow. Note also that the Iltem drop-down list box in Figure 3-1
provides two pieces of information: the item code (the left column) and the
item description. The item description — if the description is lengthy — is
cut off. You’ll want to remember this seemingly trivial but important point as
you work with your Item file. You want descriptive item codes and if possi-
ble, brief descriptions.

I'm using pretty self-explanatory item codes in this reference, as you can see
from Figure 3-1. In real life, your codes may be far more cryptic.
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Figure 3-2:
The Iltem
List window.
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Using the Item List window

If you choose the Liststoltem List command, QuickBooks displays the Item
List window, as shown in Figure 3-2. The Item List window identifies the item
code or name, the description, the type of item (I talk more about this in the
next section of the chapter), the account that gets credited when you sell
some of the items, and inventory stocking and pricing information (if you
supply that).

The Item list provides a good way to quickly see what items you can put on
invoices and purchase orders. The Item list also provides a quick and con-
venient way to see the stocking levels and prices.

If you want more information about an item shown in the Item List window,
you can double-click the item. When you double-click the item, QuickBooks
displays the Edit Item window, as shown in Figure 3-3. Essentially, the Edit
Item window displays all of the information available about a particular
item. You can use the Edit Item window to change bits of item information.
Later in this chapter in the section, “Editing Items,” | describe how to do
this.
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Figure 3-3:
The Edit
Iltem
window.
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Using the inventory reports

I need to mention one other thing because it’s so darn useful. As you would
expect, QuickBooks supplies several interesting, useful inventory reports. If
you choose the Reports=>Inventory command, for example, QuickBooks dis-
plays a submenu of inventory reports. The submenu provides a report that
gives inventory evaluations, inventory stock levels, and a work sheet that
you can use to go out and physically count the inventory on store shelves or
in the warehouse.

Book IV, Chapter 2 describes how you produce reports in QuickBooks and
how you customize those reports. If you want to find out more about reports
and report customization, refer there.

Adding ltems to the Item List

You can add a bunch of different types of items to the Item list. Remember
that, as noted in the early paragraphs of this chapter, the Item list stores
descriptions of anything that you stick on an invoice or purchase order.

If you think about this for a minute, you realize that you have different types
of items. For example, if you are a retailer, the inventory that you sell may
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appear on an invoice. If you provide discounts to different sorts of customers,
discounts may appear on an invoice as a line item. If you are in a state that
taxes sales, sales tax appears as a line item on an invoice.

Different items look and work differently. For this reason, you describe different
items in a different manner. You describe an inventory item that may appear on
an invoice differently from a sales tax that you are required to charge.

Given this disparity, I first describe the general process for adding an item to
the Item list. After you know the big picture stuff, I talk individually about
each of the items that appear on the Item list. Sound okay? I'll get started.

Basic steps for adding an item

To add an item to your Item list, follow these steps:

1. Choose the Lists>Item List command.

QuickBooks displays the Item List window (an example of which appears
in Figure 3-2).

2. To display the Item menu, click the Item button, which appears in the
lower-left corner of the Item List window.

QuickBooks displays the Item menu.
3. Choose the New command.

This tells QuickBooks to display the New Item window, as shown in
Figure 3-4.

4. Use the boxes of the New Item window to describe the item that you
want to add.

Your first step is to identify the type of item that you want to add. Based
on the type of item, QuickBooks supplies other boxes that you use to
describe the item. (I go into more detail about this in the following para-
graphs, so don’t get freaked out — yet.)

5. Save the item.

After you use the boxes in the New Item window to describe the item
that you want to add, click OK. QuickBooks adds the item that you just
described to the Item list.

The step-by-step approach described in the preceding paragraphs is the
conventional way to add an item, but you can also add items on the fly.
For example, if you are in the Create Invoices window or in the Create
Purchase Orders window, you can open the Item drop-down list box and
select Add New Entry from the list. When you do this, QuickBooks dis-
plays the New Item window, as shown in Figure 3-4. You then use the
New Item window to add the item in the same manner discussed here.
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Figure 3-4:
The New
Iltem
window.
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Adding a service item

You use service items to purchase or bill for items that represent service.
For example, I am a CPA in Redmond, Washington. One of the things that [ do
is prepare tax returns for individuals and businesses. When I bill a client for
preparing his or her tax return, the line item that appears on the invoice

for Tax Return Preparation is a service item.

In your business, you probably have service items, too. For example, a health
care provider, such as a dentist or doctor, provides treatment or performs
procedures. These activities represent services.

Even retailers and contractors — businesses that you typically think of as
selling tangible physical goods — often sell services. For example, a retailer
may gift-wrap a purchase, which is a service. A contractor may provide serv-
ices such as painting or cleanup.

To add a service item, display the New Item window (refer to Figure 3-4). When
QuickBooks displays the New Item window, select Service from the Type drop-
down list box. Then use the ltem Name/Number box to give the service a brief
code or name. If the service is a subitem, select the Subitem Of check box and

identify the parent item.
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Select the This Service Is Performed by a Subcontractor, Owner, or Partner
check box if the service is provided by, as the window suggests, a subcon-
tractor, owner, or partner. You indicate which services are performed by
subcontractors, owners, and partners because these parties are subject to
different tax accounting rules.

Finally, use the Description box to describe the service. Your description
appears on invoices and purchase orders, so you want to be thoughtful here.
Use the Rate box to describe the price or rate per unit of service. Use the
Tax Code box to indicate whether the service is taxable. Finally, use the
Account box to identify which Income account should be credited when the
item is sold to some customer, client, or patient.

Adding an inventory item

Inventory items are those items that appear on invoices and purchase orders
and represent physical goods that you buy, hold, and sell. For example, if
you are a retailer, all that stuff that is sitting out on the shelves of your store
represents inventory. If you are a manufacturer, the raw materials that you
buy and then use to assemble your products represent inventory.

To set up an inventory part, display the New Item window. When QuickBooks
displays the window, select Inventory Part from the Type drop-down list box.
QuickBooks then displays the Inventory Part version of the New Item window,
as shown in Figure 3-5.

Use the Item Name/Number box to provide a descriptive but brief code or
name for the item. If the item is a subitem of some other parent item, select
the Subitem Of check box and then identify the parent item by using the
Subitem Of text box.

The Purchase Information and Sales Information boxes let you describe the
information that will appear on purchase orders and invoices. The Description
on Purchase Transactions box in the Purchase Information area, for example,
lets you provide the text that QuickBooks writes on purchase orders. You can
also guess at the purchase cost by using the Cost text box. Specify the Cost of
Goods Sold account that should be debited when this item is sold by using the
COGS Account drop-down list box and identify the preferred vendor for pur-
chases of this item by using the Preferred Vendor box.

The Sales Information boxes provide the information that QuickBooks needs
to correctly include the item on an invoice. The Description On Sales Tran-
sactions box provides a space that you can use to supply the description that
QuickBooks should use for this item on your invoice. The Sales Price box lets
you provide your price for the item. If you're subject to sales tax, you will see
(and should use!) the Tax Code drop-down list box to specify whether the item
is taxable or non-taxable for sales tax purposes. Finally, the Income Account
drop-down list box lets you specify which income account should be credited
when this item is sold.
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P If you’re confused about seeing two Account drop-down list boxes on
the Inventory Part version of the New Item window, keep in mind that
when you sell an item, you need to track the income by crediting an
income account and the cost of goods sold by debiting the cost of goods
sold account.
Use the Inventory Information boxes to describe how QuickBooks should
handle inventory tracking for the item. For example, use the Asset Account
drop-down list box to specify which account QuickBooks should use to track
the dollar investment in this item. Typically, you use the Inventory Asset
account. However, you can conceivably use some other asset account. Use
the Reorder Point box to identify the inventory stocking level at which you
want QuickBooks to alert you to the need to reorder the item. If you have
inventory on hand for this item — and it’s very suspicious that you would —
enter the quantity that you have on hand and the value that you have on
hand by using the On Hand box and the Total Value boxes. You need to also
specify the date as of which your quantity and value information is correct
by using the As Of box.

QNG/ You really shouldn’t be entering inventory balances for an inventory item

& when you set it up on the Item list. You should be entering or changing

inventory quantities and values when you purchase the inventory
(recorded with the Create Purchase Orders window or the Write Checks
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window) and when you sell the inventory (typically recorded with the
Create Invoices window or the Sales Receipts window). If you enter a quan-
tity other than zero or a total value other than zero when using the New
[tem window, you also need to make a journal entry to record the other half
of the transaction. If this “other half” business sounds complicated, just
trust me: You should not be entering quantity or value information in this
window. If you do understand this “other half” business that I'm referring
to, you should know better than to enter quantity or value information in
the New Item window!

You can click the Spelling button to check the spelling of words and phrases
that you've entered in the New Item window. You can also click the Next
button to save the information that you’'ve entered for an item and redisplay
the New Item window so you can add another item.

Adding a non-inventory part

To add a non-inventory part — which is a tangible good that you sell

but for which you don’t track inventory — display the New Item window
and select Non-Inventory Part in the Type drop-down list box. When
QuickBooks displays the Non-Inventory Part version of the New Item
window, as shown in Figure 3-6, give the non-inventory part a name or code
by using the Item Name/Number box. If the new item is a subitem, select
the Subitem Of check box. Then identify the parent item by using the
Subitem Of text box. Use the Description box to provide the description
that should go on invoices that bill for this non-inventory part. Obviously,
you enter the price into the Price box. Use the Tax Code box to identify
whether the item is subject to sales tax. Finally, use the Account drop-
down list box to identify the income account that should be credited for
sales of this non-inventory part.

Note the check box labeled This Item Is Purchased for and Sold to a Specific
Customer:Job. If you select that check box, QuickBooks displays a slightly
different version of the Non-Inventory Part window, as shown in Figure 3-7.
This version of the Non-Inventory Part New Item window includes Purchase
Information and Sales Information areas that work the same way as the
Purchase Information and Sales Information areas supplied by the regular
Inventory Part version of the New Item window. (Refer to Figure 3-5 and the
discussion of Figure 3-5 earlier in the chapter.)
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Figure 3-6:
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Figure 3-8:
The Other
Charge
version of
the New
Item
window.
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Adding an other charge item

An other charge item is an item that you use to purchase or bill for things
such as miscellaneous labor or services, materials that you aren’t tracking
as inventory, and special charges, such as for delivery or setup or rush jobs.

To set up an other charge item, display the New Item window and select
Other Charge from the Type drop-down list box. When you do, QuickBooks
displays the Other Charge version of the New Item window, as shown in
Figure 3-8. To finish setting up your other charge item, give the charge a
name or code or abbreviation by using the Item Name/Number box. If the
other charge item is a subitem, select the Subitem Of check box and then
identify the parent item by using the Subitem Of text box. Obviously, you use
the Description box to provide a description of the charge (remember that
this description will appear on your invoices). Then use the Amount or %
box to identify how the charge gets calculated or billed. Use the Tax Code
drop-down list box to identify the charge as subject to sales tax — or not
subject to sales tax. Use the Account drop-down list box to identify the
income account that should be credited when you bill for this other charge.
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Figure 3-9:
The
Subtotal
version

of the
New Item
window.

If you select the This Is a Reimbursable Charge check box, QuickBooks adds
a second set of boxes to the New Item window. One set of boxes is labeled
Purchase Information and provides information that goes on purchase
orders or is used to record purchases and purchase orders. The other set of
boxes is labeled Sales Information and goes on invoices and sales receipts to
record the actual sale or billing for the other charge.

If you want to enter an other charge that should be calculated as a percent-
age, you must enter the % symbol in the Amount or % box. For example, if
you want to include an other charge item on invoices that equals 25 percent
of the previous item on the invoice, enter 25% into the Amount or % box.

Adding a subtotal item

If your purchase order, sales receipt, or invoice will include a subtotal line
item, you need to create a subtotal item in your Item list. To do this, display
the New Item window and select Subtotal from the drop-down list box. Next,
give the subtotal item a name or abbreviation and use the Description box to
describe the subtotal. Figure 3-9 shows the Subtotal version of the New Item
window.
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If you're using other charge items that are calculated as a percentage or dis-
count items that are calculated as a percentage, you almost certainly need a
subtotal item. An other charge that is calculated as a percentage would typi-
cally be calculated as a percentage of a subtotal item. Similarly, a discount
item that’s calculated as a percentage would be calculated as a percentage of
a subtotal item.

Adding a group item

A group item lets you more easily invoice customers when, from the customer’s
perspective, he or she is buying a single item, but from your perspective, you
are actually selling several items. This definition sounds curious at first, but let
me give you a quick example. Suppose that you are a florist and do a booming
business on Valentine’s Day. Your best-selling items may be red roses and
pretty crystal vases. But you probably don’t sell individual roses and individual
vases. What you actually sell is a dozen roses and a single vase. Although you
want to individually track purchases of dozens of red roses and individual crys-
tal vases on your purchase orders, on your invoices to customers, you want to
bill for “a dozen red roses and a crystal vase.”

At the end of the chapter, [ describe another item type, inventory assembly,
that works similarly to the group item type. The inventory assembly item
type is for manufacturers.

If that example doesn’t make sense, imagine a more complex floral arrange-
ment including the dozen red roses, a crystal vase, baby’s breath, flower pre-
servative, tissue paper wrapping, ribbon, a box, and so forth. In this case, do
you really want an invoice that shows perhaps twenty different items? Or do
you want an invoice that shows a single item: a dozen red roses and a crystal
vase? This is why you create group items. A group item lets you create a
single item that you use on invoices. However, this group item actually com-
bines a bunch of individual items that you are probably using on your pur-
chase orders.

To create a group item, display the New Item window and select Group from
the Type drop-down list box. When QuickBooks displays the group version of
the New Item window, use the Group Name/Number box to give the group item
a name or code, as shown in Figure 3-10. Use the Description box to give the
group item an appropriate description. Use the Item, Description, and Qty
columns at the bottom of the Group version of the New Item window to iden-
tify the individual items and item quantities that combine to make a group.

Adding a discount item

A discount item subtracts either a fixed amount or a percentage from a subtotal.
To set up a discount item, display the New Item window. Next, select the
Discount entry from the Type drop-down list box. When you do, QuickBooks
displays the Discount version of the New Item window, as shown in Figure 3-11.
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To set up your discount item, enter a name or abbreviation for the discount
into the Item Name/Number box. If the discount item is a subitem, select the
Subitem Of check box and then identify the parent item by using the Subitem
Of text box. Typically, you will want to describe the discount by using the
Description box. Enter the amount of the discount into the Amount or % box
as either a dollar amount or as a percentage. If you do enter the discount as a
percentage, be sure to include the percentage symbol. Use the Account drop-
down list box to specify which account gets debited for the discount. Finally,
use the Tax Code drop-down list box to indicate whether the discount is
applied before sales tax. (In other words, indicate whether the discount is
subject to sales tax.)

If you're going to set up a discount item that calculates the discount as a per-
centage, you probably also need to have a subtotal item. Then, on your
invoices, follow the subtotal item with the discount item. In this manner, you
can easily calculate the discount percentage by looking at the subtotal
amount.

Adding a payment item

If you sometimes accept payments when you invoice a customer, you can
create a payment item and then add the payment item to the bottom of the
invoice. By doing this, the invoice and the payment amount and the net
amount due all show on the same document. That’s pretty cool.

To set up a payment item, display the New Item window and select Payment
from the drop-down list box. Use the ltem Name/Number box to give the pay-
ment item a code or name such as “payment.” Use the Description box to pro-
vide a nice description for the payment. (No kidding, you may want to include
the phrase “thank you” as part of the payment description. For example, how
about something such as “Payment . . . thank you!”) Use the Payment Method
drop-down list box to identify the method of payment: American Express,
cash, Discover, Master Card, or Visa — if that’s appropriate. Finally, use the
radio buttons — Group with Other Undeposited Funds and Deposit To — to
identify what happens to the money received as part of the payment. If you
indicate that the money is deposited, you should select the correct bank
account from the Deposit To drop-down list box. Figure 3-12 shows an exam-
ple of a Payment version of the New Item window.
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Figure 3-12:
The
Payment
version of
the New
Iltem
window.
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Adding a sales tax item

If you sell items that are subject to sales tax, you need to include line items
on your invoices that charge for and track these sales taxes. To do this, you
need to create sales tax items. To create a sales tax item, display the New
Item window and select Sales Tax Item from the Type drop-down list box.
When you do, QuickBooks displays the Sales Tax version of the New [tem
window, shown in Figure 3-13. Use the Tax Name box to identify or provide
an abbreviation for the sales tax. Use the Description box to give the sales
tax a description. Finally, use the Tax Rate (%) box to identify the sales tax
rate and the Tax Agency box to identify the tax agency that you will pay. For
example, Figure 3-13 shows how to set up the Washington state sales tax.
This sales tax is 8.8 percent. The tax agency to which sales tax receipts are
remitted is the Department of Revenue.

Setting up a sales tax group

In many jurisdictions, although businesses may charge a single sales tax on

sales, the sales tax actually gets distributed to several different tax agencies.
For example, a firm may be required to charge a 9 percent sales tax. But per-
haps 1 percent goes to the local city government. Perhaps another 2 percent
goes to the county government. And maybe the remaining 6 percent goes to
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the state government. In this case, you can set up a sales tax group, which
appears as a single line item invoice. However, the sales tax group actually is
made up of individual tax items.

To add a sales tax group, display the New Item window and select Sales Tax
Group from the Type drop-down list box, as shown in Figure 3-14. Enter a
name or an abbreviation for the sales tax into the Group Name/Number box.
Provide an appropriate description by using the Description box. Then, use
the Tax Item column to identify the individual tax items that comprise the
sales tax group. Note that you already need to have set up the tax items that
you want to add to the sales tax group.

Adding custom fields to items

If you've worked with the New Item window much or if you've paid particu-
larly close attention to the figures shown in the last few pages of this chap-
ter, you may have noticed the Custom Fields command button that appears
on many (although not all) of the New Item windows. (See Figure 3-12.)

The Custom Fields button enables you to add your own custom fields to the
Item list. To add a custom field, click the Custom Fields button. When you
do, QuickBooks displays a Message box and then a small dialog box labeled
Custom Fields for {item}, where {item} actually names the item.
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When QuickBooks displays the Custom Fields for {item} dialog box, click the
Define Fields button. QuickBooks then displays the Define Custom Fields for
Items dialog box, as shown in Figure 3-15. To add a custom field for the item,
select the Use check box and then use the Label box to give a name to the
field. For example, if you want to add a custom field for Insured Value, you
can select the Use check box and then enter the label Insured Value.

Define Custom Fields for tems
Figure 3-15; | Us= lebe
The Define Insured Yalug|
Custom i
Fields for O
Items dialog I
box. 0

When you click OK, QuickBooks redisplays the Custom Fields for {item}
dialog box, as shown in Figure 3-16. The Custom Fields for {item} dialog box
now shows the new custom field — in this example, Insured Value.
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Fi 3-16 Custom Fields for Gift Set
igure 3-16:

_n? C t Insured Yalue |
he Custom
Fields for

- :
{item} dialog

box.

Note that custom fields are available for all items. Also note that you see
custom fields for items by displaying the item’s information in the New Item
window or the Edit tem window and then by clicking the Custom Fields
button.

Editing Items

You can change item information. To do so, display the Item List window and
then double-click the item. When you do this, QuickBooks displays the Edit
Item window. The Edit Item window resembles the New Item window. The dif-
ference is that the Edit Item window is already filled in with the item informa-
tion. To change some bit of item information, edit the contents of the field with
the information that needs to be updated. Click OK to save your changes.

Adjusting Physical Counts and Inventory Values

Inventory shrinkage, spoilage, and, unfortunately, theft all combine to reduce
the inventory that you physically have. In order to record these inventory
reductions, you'll periodically need to physically count your inventory and
then update your QuickBooks records with the results of your physical counts.

I don’t spend any time in this book talking about approaches to providing
physical counts; you probably have better ideas than I do about how to do
that. You presumably know what works best in your business. However, I can
tell you that in order to record your physical count information in Quick-
Books, you need to use a special tool. Specifically, you need to use the Adjust
Quantity/Value on Hand command. This command is available to you in two
different places. If you display the Item list, click the Activities button (which
appears at the bottom of the Item List window) and choose the Adjust
Quantity/Value on Hand command. You can also choose the Vendors=>
Inventory Activities=>Adjust Quantity/Value on Hand command. Choosing
either command displays the Adjust Quantity/Value on Hand window, shown
in Figure 3-17.
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Figure 3-17:
The Adjust
Quantity/
Value on
Hand
window.

[E] Pine Lake Porcelain - QuickBooks Pro 2005 O
File Edit View Lists Company Customers Vendors Employees Banking Reports Window Help
== = e
B B B W B A & 2B % 4 9 9 &
Invoice  Cust Item  Reports  Vend  Check Bill Reg Accnt Rmnd Find  Support Backup Feedback
£8 < Adjust Quantity/Value on Hand Type & help question ' How Do I?
MNavigators W previous [ Mext
ﬁ Company
Adjustment Date 12131/2005 |E

Z Customers 2
E Vendors Ref. Mo, 1 Customer: Job v
‘ﬁ Employees Adjuskment Account w Class £v3
Banking Ttem Description Current gt Mew Qb by Difference |
% Business Services Blue Mug Sky Blue Coffee Mugs -25 5,000 5,025 |
Eﬂ Reports Red Mu 0 6,000 6,000
@ Help & Support 4000
DOpen Windows

™

[ walue Adjustment Memo
Total Yalue of Adjustment §,268.75
Save & Close ] [ Save & New ] [ Cancel

To use the Adjust Quantity/Value on Hand window, follow these steps:

1. Use the Adjustment Date box to record the date of your physical count.

In other words, you want to adjust your quantities as of the day you
took or completed the physical inventory count.

. Use the Adjustment Account drop-down list box to identify the

expense account that you want to use to track your inventory shrink-
age expense.

. (Optional) Identify the customer:job and class.

If it’s appropriate, and in many cases it won’t be, use the Customer:Job
box to identify the customer:job associated with this inventory shrink-
age. In a similar fashion, if appropriate, use the Class box to identify the
class that you want to use for tracking this inventory shrinkage.

. Supply the correct inventory quantities.

The Item, Description, and Current Qty columns of the Adjust Quantities/
Value on Hand window identify the inventory items that you are holding
and the current quantity counts. Use the New Qty column to provide the
correct physical count quantity of the item. After you’ve entered the new
quantity, QuickBooks calculates the quantity difference and shows this
value in the Qty Difference column.



\\J

Figure 3-18:
The
expanded
version of
the Adjust
Quantity/
Value on
Hand
window.
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You can actually enter a value into either the New Qty column or the Qty
Difference column. QuickBooks calculates the other quantity by using
the current quantity information that you supply. For example, if you
enter the new quantity, QuickBooks calculates the quantity difference by
subtracting the new quantity from the current quantity. If you enter the
quantity difference, QuickBooks calculates the new quantity by adjust-
ing the current quantity for the quantity difference.

5. Adjust the value.

If you select the Value Adjustment check box, QuickBooks displays an
expanded version of the Adjust Quantity/Value on Hand window, as shown
in Figure 3-18. This window lets you enter both the correct physical count
quantity and the updated value for the inventory item. You enter the phys-
ical count quantity, obviously, in the New Qty column. You enter the new
updated value in the New Value column. You will probably use this version
of the Adjust Quantity/Value on Hand window only if you’re using a lower-
of-cost or market inventory valuation method. For example, both financial
accounting standards and tax accounting rules allow you to mark down
your inventory to the lower of its original cost or its fair market value. If
you were doing this — and how you do this is beyond the scope of this
book — you would enter the new inventory value into the New Value

column.
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Essentially, using the lower-of-cost or market inventory evaluation
method just means you do what it says. You keep your inventory valued
at either its original cost or, if its value is less than its original cost, at its
new value. Obviously, assessing the value of your inventory is a little
tricky. But if you have questions, you can ask your CPA for help. One
thing to keep in mind, however, is that you can’t go changing your
accounting methods willy-nilly without permission from the Internal
Revenue Service. And changing your inventory valuation method from
cost, say, to lower-of-cost or market is a change in accounting method.

6. Provide a memo description.

If you want to further describe the quantity or value adjustment, use the
Memo box for this purpose. For example, you may want to reference

the physical count worksheets, the people performing the physical
count, or the documentation that explains the valuation adjustment.

7. Save the adjustment.

After you have used the Adjust Quantity/Value on Hand window to
describe the quantity changes or value changes in your inventory, click
either the Save & Close button or the Save & New button to save the
adjustment transaction. As you probably know at this point in your life,
Save & Close saves the transaction and closes the window. Save & New
saves the transaction but leaves the window open in case you want to
make additional changes.

Adjusting Prices and Price Levels

QuickBooks provides a couple of handy commands and tools that you can
use to change the prices that you charge customers for your products and
services. In the following sections, I describe both of these handy aids.

Using the Change Item Prices command

The Change Item Prices command, which appears on the Customers menu,
displays the Change Item Prices window, as shown in Figure 3-19. This window
lets you change prices of a bunch of different items at one time by an amount
or percentage. To use the Change Item Prices command, first mark the items
whose prices you want to change. Do this by clicking the Check Mark column.
Next use the By (Amount or %) box to specify the dollar amount or the per-
centage amount by which you want to change the price. For example, if you
want to change the price of selected items by $2.00, enter $2 into the box. If
you want to change the price of selected items by 5 percent, enter 5% into the
box. Use the Based On drop-down list box to indicate the base that you want
to use for adding the amount of percentage to. After you identify the items
that you want to reprice and the way that you want to reprice them, click the
Markup button. QuickBooks recalculates the prices and displays this informa-
tion in the New Price column. If you want to change the prices for the items
selected, click OK.



Figure 3-19:
The Change
Item Prices
window.
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If you don’t like the prices listed in the New Price column, you can just keep
tinkering with the value in the By (Amount or %) box, clicking the Markup
button to refresh the numbers in the New Price column, and clicking OK only
when you’re satisfied.

Using price levels

Price levels are kind of weird; they let you individually adjust the price of an
item up or down. For example, if you have agreed to discount items by 10
percent for a certain customer, you can easily do this by using a price level
to knock the price down by 10 percent whenever you're invoicing that
customer.

To use price levels, you first have to set up the price levels by using the
Price Level list command on the Lists menu. After you set up your price
levels, you adjust prices by using prices when you create an invoice. |
describe how both tasks work.

Creating a price level

To create a price level, choose the Lists>Price Level List command. When
you do, QuickBooks displays the Price Level List window. To create a price
level, click the Price Level button and then choose the New command on the
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Figure 3-20:
The New
Price Level
window.

Price Level menu. QuickBooks displays the New Price Level window, shown
in Figure 3-20. Name the price level change by using the Price Level box.
Then use the Increase Sales Price By and Reduce Sales Price By radio but-
tons to indicate that this price level increases or decreases the sales price.
Finally, use the Percentage % box to indicate the percentage change. Figure
3-20, for example, shows a price level change that decreases the sales price
by 10 percent.

Using a price level

To use a price level, you create an invoice in the usual way. However, click
the Price Each column for the item that you want to reprice by using the
price level. When you do, QuickBooks turns the Price Each column into a
drop-down list box. If you click the arrow button that opens the drop-down
list box, QuickBooks displays both the base rate price and any price levels.
If you choose a price level, QuickBooks adjusts the price for the price level
change. For example, in Figure 3-21, selecting the 10 percent price level
change bumps the price from $3.00 to $2.70. In other words, the “ten %
down” price level change decreases the default price by 10 percent, from
$3.00 to $2.70.
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Figure 3-21:
The Create
Invoices
window.
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Inventory in a Manufacturing Firm

Tracking inventory in a manufacturing firm is more difficult than in other
types of businesses. When you boil everything down to its essence, the
problem stems from a couple tricky accounting requirements:

4+ In a manufacturing environment, the manufacturer combines raw
materials items into finished goods items. This means — and this is the
challenging part — that the manufacturing process reduces the inven-
tory count and value for some items (the raw materials or the compo-
nents) while at the same time increases the count and value of the other,
finished goods items.

4+ In a manufacturing environment, the rules say that you don’t just
count the value of items in the finished goods item inventory values.
You also need to count the cost of labor and factory overhead used in
manufacturing the items.

QuickBooks solves the first problem related to manufacturing inventory; how-
ever, QuickBooks doesn’t solve or address the second problem. Fortunately,
as long as you’re a small manufacturer, you probably don’t need to worry too
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much about the second problem. You should ask your CPA about this. But
don’t worry — Congress and the Internal Revenue Service have provided a
bunch of loopholes for making the accounting easier for the small guys.

Manufactured inventory the simple way

If you're using QuickBooks Pro or some earlier versions of QuickBooks
Premier, you don’t have the ability to account for the manufacture of inven-
tory in QuickBooks. The best that you can do is to use group items to com-
bine into individual items on a customer’s invoice. This approach sounds
sloppy, but it isn’t quite as bad as you may think at first blush. You can
choose to show only the group item on a customer invoice. This means —
getting back to the example of the florist selling red roses and vases — that
the florist can “manufacture” a crystal vase of a dozen red roses and then
show the manufactured item as a group item on the customer’s invoice.

The one thing that is problematic about the “just use a group item” approach
is that it doesn’t give you a way to track the finished goods’ inventory values.

Inventory accounting in OuickBooks Premier

To account for the manufacture of inventory in QuickBooks Premier, you add
inventory assembly items to the Item list for those items that you manufac-
ture. You also record the manufacture of items as you, well, manufacture
them.

For example, suppose that Pine Lake Porcelain mostly just buys and resells
coffee mugs and other porcelain doodads. But also suppose that once a year,
Pine Lake Porcelain assembles a collection of red coffee mugs into a boxed
St. Valentine’s Day gift set. In this case, QuickBooks can record the assembly
of a boxed gift set that combines, for example, four red coffee mugs, a card-
board box, and some tissue wrapping paper.

Adding inventory assembly items
To describe manufactured items, follow these steps:

1. Choose Lists=>Item List.

QuickBooks displays the Item List window.

2. Click the Item button in the Item List window and select New from the
drop-down list.

QuickBooks displays the New Item window.

3. Select the Inventory Assembly item from the Type drop-down list box.
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Specify the account to use for tracking this item’s cost when you sell it.

QuickBooks suggests the Cost of Goods Sold account. If you've created
other accounts for your COGS, however, select the other appropriate
account.

Describe the manufactured item.

Type in a description of the item that you want to appear on documents,
such as invoices and so on, that your customers see. (QuickBooks sug-
gests the same description that you used in the Description on Purchase
Transactions text box as a default.)

Enter the amount that you charge for the item into the Sales Price box.

Indicate whether the manufactured item is subject to sales tax using
the Tax Code box.

Use the Income Account box to specify the account that you want
QuickBooks to use for tracking the income from the sale of the item.

Identify the components that go into the finished item.

Use the Components Needed list box to identify the individual compo-
nent items and the quantities needed to make the inventory assembly.
Each component item goes on a separate line in the list box. Not to be
too redundant, but do note that you both identify the component item
and the number of component items needed.

Identify the Asset Account.

Specify the other current asset account that you want QuickBooks to
use for tracking this inventory item’s value.

Select a Build Point.

Use the Build Point box to specify the lowest inventory quantity of this
item that can remain before you manufacture more. When the inventory
level drops to this quantity, QuickBooks adds a Reminder to the
Reminders list, notifying you that you need to make more of the item.

Ignore the On Hand and the Total Value boxes.

See that On Hand box? Leave it set to zero. To enter a number now is to
record an uncategorized transaction, and you don’t want to do that. Go
ahead and leave the Total Value field set to zero, too. You can also leave
the As Of box empty, or you can enter the current date here. It doesn’t
matter.

Recording manufacture or assembly of items

To build some assembly, choose the Vendors=Inventory Activities>Build
Assemblies command. QuickBooks displays the Build Assemblies window.
All you do is select the thing that you want to build from the Assembly Item
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drop-down list box and then the quantity that you (or some hapless co-worker)
have built in the 